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I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.
Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.
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I Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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I Printing Online Manual

To print the Online Manual, use the print function of your Web browser.

I For Windows:

To set to print background colors and images, follow the steps below.

> Note

* If you are using Windows 8.1, print in the desktop version.
» Background colors and background images cannot be printed in Microsoft Edge. To print background
colors and background images, use Internet Explorer 11, Mozilla Firefox, or Google Chrome.

In Internet Explorer 11

1. Select “ (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

In Mozilla Firefox

1. Select — (Menu) > Print... > Page Setup....
2. Select the Print Background (colors & images) checkbox in Format & Options.

In Google Chrome

1. Select (Customize and control Google Chrome) > Print....
2. Click More settings, and then select the Background graphics checkbox in Options.

I For macOS:

To print background colors and images, follow the steps below to display the Print dialog options, then
select the Print backgrounds checkbox.

1. Click Print... from the File menu.
2. Click Show Details.
3. Select Safari from the pop-up menu.

Safari &l

Print backgrounds
Print headers and footers
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I Trademarks and Licenses

» Trademarks

» Licenses

23



I Trademarks

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Microsoft Edge and Microsoft Excel are either trademarks or registered trademarks of Microsoft
Corporation in the U.S. and/or other countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad
Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

» 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

» Adobe, Acrobat, Flash, Photoshop, lllustrator, Adobe RGB and Adobe RGB (1998) are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

» Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

* Google, Google Home, and Android are trademarks of Google LLC.

* LINE Clova is a registered trademark of LINE Corporation.

» App Store is a trademark of Apple Inc., registered in the U.S. and other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

* QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other
countries.

» The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.

* HP-GL and HP-GL/2 are either registered trademarks or trademarks of HP Inc. in the United States
and/or other countries.

+ All other company names and products mentioned in this guide may be registered trademarks or
trademarks of their respective companies.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.
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I Licenses

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.
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"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work

and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or

Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,

the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except

as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;
and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,

or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
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such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

--—-- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
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OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: SciencelLogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, Sciencelogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of SciencelLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
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OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS 1S", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it

will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

2006-Jan-27
Copyright 1996-2002, 2006 by
David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(‘as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

0 You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')
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We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType

Project (www.freetype.org). All rights reserved.

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package’, "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
"FreeType Project’, be they named as alpha, beta or final release.

“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program’ or “executable’.

This program is referred to as “a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS I1S' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
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(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: "FreeType Project', "FreeType Engine', "FreeType library’',
or "FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
There are two mailing lists related to FreeType:
o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

---end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties
of merchantability, noninfringement of third party rights and fithess for a particular purpose. Neither the
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developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License
Copyright (c) 2013-2017
Frank Denis <j at pureftpd dot org>
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Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE

OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither name of Intel Corporation nor the names of its contributors

may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua
Copyright © 1994-2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated

documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the

rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to

permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH

THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab
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Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation

the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript
Copyright (c) 2018 ifritdP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright (c) 2002-2019, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of
BSD license:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
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1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2019, Broadcom Corporation. All Rights Reserved.

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES

WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
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* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting PIXUS Cloud Link, PIXMA Cloud Link, or MAXIFY Cloud
Link.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2012 University of Cambridge

All rights reserved.

PCRE JUST-IN-TIME COMPILATION SUPPORT

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain:  freemail.hu
Copyright(c) 2010-2012 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain: freemail.hu
Copyright(c) 2009-2012 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

43



Contributed by: Google Inc.
Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE

----------------- Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS I1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This software is based in part on the work of the Independent JPEG Group.
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I Overview

» Printer Parts

Front

Back / Side

Top View

Inside
Operation Panel
Desktop Basket

Printer Stand

» Using the Printer

Turning the Printer On and Off
Loading Rolls in the Printer

Loading Sheets in the Printer

Using the Desktop Basket

Using the Basket on the Printer Stand
Stopping Printing

Loading Originals on Document Platen

Loading Originals Correctly for each Function
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I Printer Parts

»>

»>

Front

Back / Side

Top View

Inside
Operation Panel
Desktop Basket

Printer Stand
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A: Scanning Unit / Cover (TC-20M), Access Cover (TC-20)
Open when performing printer maintenance or when removing jammed paper.
= Inside
= Scanning Unit (TC-20M)

B: Cut Sheet Feed Cover
Open when loading sheets in the top feed.
= Top View

C: Roll Paper Feed Cover

Open when loading rolls. Operate with the cut sheet feed cover open.
= Top View (with roll loaded)

D: Access Cover
Open when performing printer maintenance or when removing jammed paper.
= |nside

E: Ink Tank Cover
Open to refill ink tanks.
= |nside of Ink Tank Cover, Inside of Maintenance Cover

F: Maintenance Cover
Open when replacing the maintenance cartridge.
= |nside of Ink Tank Cover, Inside of Maintenance Cover

G: Output Guide
Supports output paper.

H: Operation Panel
Use to change the settings of the printer or to operate it.
= Operation Panel
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| scanning unit (Tc-20m)

A: Document Cover
Open to load an original on the document platen.

B: Document Platen
Load an original here.
= | oading Originals on Document Platen

C: USB Flash Drive Port
Insert USB flash drives here.
= Printing Photographs Saved on USB Flash Drive
= Printing Documents (PDF) Saved on USB Flash Drive
= Saving Scanned Data on USB Flash Drive

I Inside of Ink Tank Cover, Inside of Maintenance Cover

A: Ink Tank Inner Cover
Open to refill ink tanks.

B: Tank Caps
Open to refill ink tanks.
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C: Ink Tanks
Containers for ink inside the printer. Refill when the ink runs low.
= Refilling Ink Tanks

D: Maintenance Cartridge
= Maintenance Cartridge

I Maintenance Cartridge

Model number: MC-32

Absorbs ink used for cleaning.
= Replacing the Maintenance Cartridge

32 Important

* When purchasing, check the Model number.
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I Back / Side

Cc

A: USB Port
Plug in the USB cable to connect the printer with a computer.

B: Wired LAN Connector
Plug in the LAN cable to connect the printer to a LAN.

C: Carrying Grips
When carrying the printer, have 2 people hold it by these handles under both sides. Furthermore, hold
the left and right of these parts when moving the printer with a stand.

D: Power Cord Connector
Plug in the supplied power cord.
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A: Top Feed
Load paper here. When loading sheets, open the top feed and then pull it upwards. Two or more sheets
of the same size and type of paper can be loaded at the same time, and fed automatically one sheet at
atime.

= | oading Sheets in the Printer

B: Paper Guides
Align with both sides of the paper stack.
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| Top View (with roll loaded)

A: Roll Holder
When the roll is loaded into the printer, it is attached and secured on either side of the roll paper.

= [ oading Rolls in the Printer

B: Slide Guide
Slide the roll holder over this guide to load the roll into the printer.

C: Roll Holder Siot
The roll holder shafts mounted on either side of the roll are set in these slots.

D: Roll Holder Support
Move this left or right when changing the width of the roll to be set.

= Moving the Roll Holder Support

E: Feed Cover Rollers
When feeding roll paper, these rollers help carry the paper to the paper retainer.
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A: Paper Retainer
This retainer holds paper as it is fed.

B: Platen
The print head moves across the platen to print.

C: Ink Valve Lever
Use when the printer is sent for repair.

= Repairing Your Printer

D: Carriage Rail
The Carriage slides along this rail.

E: Carriage
Moves the print head.

= Carriage
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I Carriage

A: Print Head Locking Cover
Secures the print head.

B: Print Head
= Print Head

C: Print Head Lock Lever
Lock print head locking cover.

I Print Head

Model number: PF-08

The print head is equipped with ink nozzles.

= Replacing the Print Head

32 Important

* When purchasing, check the Model number.
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I Operation Panel
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A: ON button

Turns the printer on or off. Lights after flashing when the power is turned on. Before turning on the
power, make sure that the document cover is closed.

= Turning the Printer On and Off

B: ON lamp
Remains lit after flashing when the printer is turned on.
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C: Touch Screen
Displays messages, menu items, and operating status. Touch the screen lightly with your finger to
select a menu item or button.

= Home Screen Menu Composition

D: Stop button
Cancels printing, copying or scanning.

E: Alarm lamp
Lights up or flashes in case of errors.

F: HOME button
Used to display the HOME screen.

= Home Screen Menu Composition

G: Back button
Returns to the previous screen.

H: Black button (TC-20M)
Starts black-and-white copying or scanning.

I: Color button (TC-20M)
Starts color copying or scanning.
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I Desktop Basket

The following basket is available for this printer.

* Desktop Basket BU-06

I Parts of Desktop Basket

A: Basket Adapters
Insert these into the printer body to attach the Desktop Basket.

B: Basket Arm
Move the arm to open or close the basket.

C: Basket Cloth
Catches the ejected printed documents.
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D: Support Stay
Attached in front of the output guide to support the basket cloth.

»» Note

 For instructions on how to use the Desktop Basket, see "Using the Desktop Basket".
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I Printer Stand

The following stand is available for this printer.

¢ Printer Stand SD-24

I Parts of Printer Stand

A: Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.

B: Basket Cloth
Catches the ejected printed documents.
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C: Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you
move it while the locking casters are locked, the floor may become scratched.

»>» Note

» For instructions on how to use the basket that comes with the printer stand, see "Using the Basket on
the Printer Stand".
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I Using the Printer

» Turning the Printer On and Off

» Loading Rolls in the Printer

» Loading Sheets in the Printer

» Using the Desktop Basket

» Using the Basket on the Printer Stand
» Stopping Printing

» Loading Originals on Document Platen

@ Loading Originals Correctly for each Function
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I Turning the Printer On and Off

I Turning on the printer

Press the ON button to turn on the printer.
The ON lamp flashes and then remains lit.

= Checking that Power Is On

»» Note

* It may take a while for the printer to start printing immediately after you turn on the printer.

* You can set the printer to automatically turn on when a print operation is performed from a computer
connected by USB cable or wireless network. This feature is set to off by default.

= ECO

Turning off the printer

Press the ON button to turn off the printer.

When the ON lamp stops flashing, the printer is turned off.

2% Important

* When you unplug the power cord after turning off the printer, be sure to confirm that the ON lamp is
off.
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»» Note

* You can set the printer to automatically turn off when no operations are performed or no print jobs
are sent to the printer for a certain interval. This feature is set to on by default.

= ECO

I Checking that Power Is On

The ON lamp is lit when the printer is turned on.

Even if the touch screen is off, if the ON lamp is lit, the printer is on.

»>» Note

» The touch screen display will turn off if the printer is not operated for about 5 minutes. To restore the
display, touch the touch screen. The display is also activated again when an original is printed from a
computer.
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I Using the Desktop Basket

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

3% Important

* When storing printed documents on the basket, always use it in position (1). If you do not, printed
documents may not be dropped into the basket, and the printed surface may become soiled.

« Lift the left and right sides of the basket arm (A) evenly so that the front of the basket is horizontal.

* The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

* The basket can hold printed documents from paper up to 36.0 inches (914.4 mm) long.

* Printed documents that are short in length relative to the roll paper width may not fall straight down and
miss the basket. For short printed documents, it is recommended to use Eject cut.

= Eject cut (when the paper surface is being scratched / to wait for ink to dry)
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« If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.
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I Using the Basket on the Printer Stand

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

(1) (2)
3% Important

* When storing printed documents on the basket, always use it in position (1). If you do not, printed
documents may not be dropped into the basket, and the printed surface may become soiled.

* To store printed documents in the basket, first pull down the side rod (B) evenly so that the front rod (A)
is not askew, and then use the basket.

* The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

* The basket can hold printed documents from paper up to 48 inches (1219.2 mm) long.
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* When moving the stand, make sure that the basket does not graze the floor and that all four of the

casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor,
or cause injuries.

+ If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.
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I Stopping Printing

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

o B

® | \ el

4]

A
N w A
When you press the Stop button during printing, the printer operation varies depending on the current
status.

* You press the Stop button before printing starts

The print job is canceled.
* You press the Stop button during printing
Printing stops immediately.

32 Important

+ If you press the ON button while printing is in progress, the print data sent from the computer queues in
the printer and you may not be able to continue to print. Press the Stop button to cancel printing.
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I Loading Originals on Document Platen

This function is available only for TC-20M.

You can load originals that meet the following conditions to the printer.

Item Details

Types of originals Text document, magazine, or newspaper

Printed photo, postcard, business card, or disc (BD/DVD/CD, etc.)

Size (width x height) Max. 8.5 x 11.7 in. (216 x 297 mm)

1. Open the document cover.

2. Load original with side to scan facing down on document platen.

= |oading Originals Correctly for each Function

3% Important

» Be sure to observe the following when loading the original on the document platen.

Failure to observe the following may cause the scanner to malfunction or the platen glass to
break.

— Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.
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— Do not put any pressure of 4.4 Ib (2.0 kg) or more on the platen glass, such as pressing
down the original.
— Make sure any liquids on documents, such as glue, ink, or correction fluid are dry before

loading.

3. Close the document cover gently.

o

3% Important

« After loading the original on the document platen, be sure to close the document cover before

starting to copy or scan.
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I Loading Originals Correctly for each Function

This function is available only for TC-20M.

Load the original in the correct position according to the function to use. If you do not load the original
correctly, it may not be scanned properly.

Originals

Function

How to Load

Magazines, Newspapers, and
Documents

Copying

Scanning by specifying a standard
size (A4, Letter, etc.)

If you scan using the operation pan-
el, select Document or Photo for
Doc.type in Scan and specify a stand-
ard size (A4, Letter, etc.) for Scan size
to scan originals.

= | oading the Original to Be Aligned
with the alignment mark

Photos, Postcards, Business
Cards, and Disc (BD/DVD/CD)

Scanning only one original

If you scan using the operation panel,
follow the operation below.

» Select Photo for Doc.type in Scan
and specify Auto scan for Scan
size to scan originals.

= | oading Only One Original in Cen-
ter of Document Platen

Scanning two or more originals

If you scan using the operation panel,
follow the operation below.

» Select Photo for Doc.type in Scan
and specify Auto multi scan for
Scan size to scan two or more orig-
inals.

= | oading Two or More Originals on
Document Platen

»» Note

 For details on how to scan from the computer and how to load originals, see below.

— For Windows:

= Scanning in Windows

— For macOS:

= Scanning in macOS

I Loading the Original to Be Aligned with the alignment mark &1

Place the original with the side to scan facing down on the Document Platen and align it with the

alignment mark . Portions placed on the diagonally striped area cannot be scanned.
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22 Important

» The printer cannot scan the striped area (A) (0.04 in. (1 mm) from the edges of the platen glass).

I Loading Only One Original in Center of Document Platen

Place the original with the side to scan facing down, with 0.40 in. (1 cm) or more space between the
edges (diagonally striped area) of the document platen. Portions placed on the diagonally striped area
cannot be scanned.

1A4 1Ad

e © LR
I Loading Two or More Originals on Document Platen

Place the originals with the side to scan facing down. Allow 0.40 in. (1 cm) or more space between
the edges (diagonally striped area) of the document platen and the originals, and between the originals.
Portions placed on the diagonally striped area cannot be scanned.

You can place up to 12 items.
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B: More than 0.40 in. (1 cm)
»» Note

» The Skew Correction function automatically compensates for the originals placed at an angle of up to
approximately 10 degrees.

» Non-rectangular or irregular shaped photos (such as cut out photos) may not be scanned properly.
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I Printing

» Printing from Your Computer (Windows)
& Printing with Easy Setup #Basics

Changing the Type of Paper

Printing Photos and Business Documents
Printing By Setting Print Purpose

Edit in PosterArtist and Print

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners (Large-Format Printing)
& See more...

» Printing from Computer (macOS)

»» Note
« See here for information on print settings in macOS 13 and later.

& Printing with Easy Setup #Basics
Changing the Type of Paper
@ Scaled Printing
@ Printing to Oversized Paper Sizes
a Setting Paper Dimensions (Custom Size)
@ Print Area
& Printing Hanging and Horizontal Banners (Large-Format Printing)
& See more...
» Printing from Computer (Chrome OS)
» Printing from Printer
a Printing Photographs Saved on USB Flash Drive

@ Printing Documents (PDF) Saved on USB Flash Drive
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» Printing from Smartphone/Tablet
@ Print Easily from a Smartphone or Tablet with Canon PRINT
& Printing from iOS Device (AirPrint)
& Printing with Mopria Print Service
& Printing with Canon Print Service

» Using PIXMA/MAXIFY Cloud Link
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I Printing from Your Computer (Windows)

>

>

Printing with Easy Setup 7Basic

Setting the Number of Copies and Printing Order
Printing Photos and Business Documents

Printing CAD Drawings

Changing the Print Quality and Correcting Image Data
Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners (Large-Format Printing)
Printing by Dividing/Joining Documents

Printing by Saving Roll Paper

Switching the Paper Source to Match the Purpose
Displaying the Print Results before Printing

Other Convenient Settings
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I Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

I Printing with Easy Setup

1. Check that printer is turned on

2. Load paper on the printer

Set roll paper or cut sheet to a printer.

3. Open the printer driver setup window

4. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

= Canoo Frinting Preferences =
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32 Important

» See "Paper Information List" for Canon authentic paper or Canon output check paper.

»» Note

* Click Get Information... to display the Paper Information on Printer dialog box. The Paper
Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

« For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."
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5. Select print target

From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.
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6. Select the print quality

For Print Quality, select High, Standard or Draft according to your purpose.

= Cancm Printing Preferemces i
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22 Important

» The print quality settings that can be selected may differ depending on a printing profile.
7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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8. Select the paper source

For Paper Source, select the setting that matches your purpose.
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9. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.
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10. Complete the setup

Click OK.
When you print, the document is printed with settings that match your purpose.
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»>» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

+ Under initial settings, Print Priority in Advanced Settings is set to Line Drawing/Text, so your print
data will be printed with the appropriate density for line drawings.
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I Checking Printer Settings and Applying Settings to Printer Driver
1. Open printer driver setup window

2. Click Get Information... on Main tab

The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Paper Width.

4. Apply settings
To apply the printer settings to the printer driver, click OK.

»» Note

« If the media type and the output paper size are not set on the printer, OK will be grayed out and
cannot be clicked.

+ If communication with the printer is disabled, the Get Information... does not appear or printer
media information from the printer cannot be obtained.
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I Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.

= Canon Printing Preferences .
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

Check the Collate check box when you are printing two or more copies, and want to print them in
groups, and uncheck the check box when you want to print them as a group on the same page.

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

32 Important

* When the application software that you used to create the document has the same function, specify
the settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.
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I Printing Photos and Business Documents

» Printing By Setting Print Purpose

» Edit in PosterArtist and Print
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose
For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.
8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterAtrtist.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist and printing in a poster layout.

1. Open the printer driver setup window

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.
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»» Note

» Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist

Click OK.
When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist

5. Edit page in PosterArtist

Image editing and sorting is implemented in PosterArtist.

By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple
application software can be arranged on one page.

After editing is complete, please print from PosterArtist menu.
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»» Note

» For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
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I Printing CAD Drawings

» Printing By Setting Print Purpose
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I Changing the Print Quality and Correcting Image Data

» Adjusting Color Balance

» Setting the Print Quality Level (Custom)

» Printing a Color Document in Monochrome
» Specifying Color Correction

» Adjusting Brightness

» Adjusting Contrast

¥

Printing Using Detailed Setting Mode
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I Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the advanced settings

Select Advanced Settings from the pull-down menu on the Main tab.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red

becomes stronger.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select the print quality

For Print Quality, select Custom.
The Custom dialog box opens.
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3% Important

« If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.

4. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.
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2% Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

I Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Monochrome or Monochrome Bitmap.

»» Note

» The selectable Color Mode depends on the media type selected for Media Type on the Main tab.
* You can select Monochrome Bitmap for Color Mode only if Line Drawing/Text is selected in
Print Priority.

4. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.
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3% Important

* When Monochrome or Monochrome Bitmap are selected, the printer driver processes image data as
sRGB data. In this case, actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to SRGB data
using an application software.

»» Note

* When Monochrome or Monochrome Bitmap is selected, inks other than black ink may also be used.
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I Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select Off.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the printer driver's original color profile. Normally, you should
choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

32 Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

« If Auto (Use Printer Settings) is selected for Media Type, the Matching sheet is not displayed, and
color correction occurs according to printer settings.
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I Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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I Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

I Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

»>» Note

* Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a
format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

I Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver

This section describes the procedure for printing data by using the color correction function of the
printer driver.

Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.

100



I Adjusting Colors with the Printer Driver

To use printer driver matching when printing, turn on the printer driver's color correction function. Printer
driver matching accurately applies the characteristics of data displayed on the monitor and allows you to
obtain print results of impressions that are close to those displayed on the monitor.

22 Important

» When printing using printer driver matching, Canon recommends that you set the monitor and the
environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

»>» Note

* When printing from an application software that can identify ICC profiles and allows you to specify them,
use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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5. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD)
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you print, the colors get adjusted by the printer driver when printing the data.
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I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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| Printing with IcC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

I Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself, be sure to select color management
items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Off for Color Correction.

104



Color Settings
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.
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5. Select input profile

Select the Input Profile you want to use.
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32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

6. Select the printer profile
Select Printer Profile as follows:

» To set the printer profile automatically:
Select Auto Settings.

» To set the printer profile manually:
Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

32 Important

* When you select Perceptual to print images, Canon recommends that you set the monitor
and the environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix + 125 Ix

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

3% Important

» Depending on the media type, you may obtain the same print results even when you change
the Rendering Intent setting.
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8. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Contrast
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I Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase

the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
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| Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
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3. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions
Set the following items as necessary.

Print Priority
Select elements to prioritize for print results.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with the print conditions you set.

I Related Topics

= Adjusting Color Balance

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source

For Paper Source, select the setting that matches your purpose.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.
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6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding

check box.
The current settings are displayed in the settings preview on the left side of the window.

* Fit Paper Size
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Scales the document to match the paper size.
* Fit Roll Paper Width

s
I
L s ol

Scales the document to match the roll paper width.
* Scaling

80%

e

—

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.

The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup
Click OK.

When you execute print, the document will be printed with the specified scale.

32 Important

* When the application software which you used to create the original has the scaled printing function,
configure the settings on your application software. You do not need to configure the same setting in
the printer driver.
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»» Note

+ Selecting Enlarged/Reduced Printing changes the printable area of the document.
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I Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...
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The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

. Select the paper source

For Paper Source, select the setting that matches your purpose.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

32 Important

» When printing to oversized paper sizes, use paper that has the following necessary margins added to
the document size.
— Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
— Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

> Note

» An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.

» To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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I Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

I Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab
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The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify a size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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4. Set user-defined paper

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

I Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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The Custom Size Settings dialog box opens.
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3. Set the custom paper size

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

22 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Paper Sizes."

» Any paper size that was set by using Custom Size can no longer be used after the application software

is closed.

»>» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can still print but you may not be able
to obtain correct print results.

» The maximum configurable size with Custom Size is 3.2m.
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Printing Hanging and Horizontal Banners (Large-Format
Printing)

A drapery or banner can be made by enlarging or reducing original documents made on application
software.

The procedure for printing hanging and horizontal banners is as follows:

| Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Size on the Page Setup
tab.

In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Paper Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in

the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

I Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

»» Note

» Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.

For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.

(when setting length to 1/6 the user-defined paper)

— User-defined paper 1: Width 600mm, Height 3,000mm

— User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software

Use the registered user-defined paper 2 size to create original document using an application.
3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in the Page Size on the Page Setup
tab.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

»>» Note

» Maximum printable length is 4.0m. In the event the enlarged length exceeds 4.0m, the part of the image
exceeding the length will not be printed.

« If printing cannot be performed correctly, you may be able to improve printing by using the Special
Settings dialog box on the Layout tab to change FineZoom Settings to Yes.
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I Printing by Dividing/Joining Documents

» Inputting Documents Created Using Multiple Applications into Free Layout plus
» Printing by Connecting Multiple Pages
» Printing Multiple Pages All on One Page

» Dividing and Printing Posters
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I Printing by Connecting Multiple Pages

Print documents with several pages as one continuous document. When you do this, the spaces between
the pages will be removed.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select Roll Paper.
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3. Set roll paper options

Click Roll Paper Options... to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

Rooll Paper Optazns .o

Cancel Diefouts Hels

4. Complete the setup

Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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I Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.

Page Layout Printing X
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Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, select something other than None from the list.

5. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

2» Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the
Page Setup tab, Page Layout is grayed out and cannot be set.

« If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW Spooling),
Page Layout is grayed out and cannot be set.
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| Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

I Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of divisions

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.

130



= Canom Frinting Preferences w
Man  Page Setp | et Favates | Lhity
Ir'! [ Page Layoas E‘E Pealer {2 5% -
- £ J
iﬁi#
—— e CORFIDENTIAL
==
Lestter (85147
ES0nx i1 00 R
Letier (B 5 =187 .
TP G_J5 [ Retate 180 degrees
Cogees 15 154
%’,i [ Pt freem Lot P
Want’ | [DCotas
Specisl Semrgs Dty
Cance | [ ook e

4. Complete the setup

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

3% Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on
the Page Setup tab, Page Layout is grayed out and cannot be set.

+ If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW
Spooling), Page Layout is grayed out and cannot be set.

I Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range

Clear the check boxes of the pages you do not want to print.

In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.

Check the pages to be printed, and then click OK.

131



Pages bo Print

(=] 2
r-‘ H1 4

o[ conen Dutats Heb

3> Note
* In the setting view on the left side of the Pages to Print dialog box, you can also clear the
display by clicking the pages you do not want to print.

To redisplay a cleared page, click that page again.
» To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

22 Important
« If you partition and print as a poster, the source document will be printed in enlarged form, so the print

results may become rough.
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I Printing by Saving Roll Paper

» Saving Roll Paper by Rotating Document 90 Degrees
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I Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
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3. Select the paper size
From the Page Size list on the Page Setup tab, select the same size as that of the document that was

created with the application software.

4. Select the paper source

In Paper Source, select Roll Paper.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.
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7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

22 Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the Page
Setup tab, Rotate Page 90 degrees is grayed out and cannot be set.
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* When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in the
vertical direction is longer than the width selected in Roll Paper Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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I Switching the Paper Source to Match the Purpose

This printer has two paper sources: Roll and Top Feed.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.
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Roll Paper
Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.
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»» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer,
an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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I Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

= Canoe Printing Preferences 0

Man  Page Setp Liysd | Favodes  Lbity

Media Type :P‘I.mPapﬁ ,.,:

Eany Setiings w
Peri Target

Letier (B5N117)
E 50 inx #1100 n

3. Complete the setup

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

I Related Topic

= Canon imagePROGRAF Preview
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I Other Convenient Settings

» Stamp Printing
» Setting a Page Size and Orientation

» Registering a Frequently Used Printing Profile
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I Stamp Printing

The Stamp function allows you to print a stamp text over or behind document data.
"DRAFT," "CONFIDENTIAL," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.
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3. Complete the setup
Click OK.

When you execute print, the data is printed with the specified stamp.

22 Important

» Depending on your usage environment, you may not be able to use the Stamp function. In this case,
set Spooling at Printer Driver in the Special Settings dialog box to Yes.
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I Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

I Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
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The Define Stamp dialog box opens.
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3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.

In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.

Change the Font, Style, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.

Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

I Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Stamps, select the title of the stamp you want to change the settings for.
3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

»» Note

» The stamp registered as the default setting cannot be changed.

I Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Stamps and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup
Click OK to return to the Layout tab.
3> Note

» The stamp registered as the default setting cannot be deleted.
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I Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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I Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:
I Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....
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4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.

The name and the icon appear in the Favorites list.

To check the settings of the registered favorite, click Settings Details.

»» Note

» To save the settings of the favorite to a file, click Export... on the Favorites tab.

I Printing Using Favorite Settings
1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

I Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.

» The settings of the favorite being applied to the current print settings cannot be deleted. To delete
that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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I Printing from Printer

This function is available only for TC-20M.
» Printing Photographs Saved on USB Flash Drive

» Printing Documents (PDF) Saved on USB Flash Drive
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I Printing Photographs Saved on USB Flash Drive

You can print the photograph saved on the USB flash drive easily.
¥>» Note

» Can print JPEG data taken with cameras conforming to Design Rule for Camera File System
specifications. Images must conform to Exif 2.2/2.21/2.3. Other types of images or movies such as
RAW images cannot be printed.

« Can print images scanned and saved by the printer itself with Doc.type set to Photo and Format set to
JPEG (file extension ".jpg").

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets in the Printer

3. Insert USB flash drive into USB flash drive port.

4. Select % Others on the HOME screen.

= Home Screen Menu Composition

5. Select L’ Print from.

6. Select Print from USB flash drive.

The photo selection screen is displayed.

> Note

« If both photo files and PDF files are saved on the USB flash drive, the confirmation screen to
select which file you print is displayed. Select Print photos in the displayed screen.

« If no printable photo data is saved on the USB flash drive, Saved data is not of a supported
type. is displayed on the touch screen.

« If more than 2,000 photo data are saved on the USB flash drive, the photo data is split by group
per 2,000 photos in reverse chronological order (date last modified) automatically. Check the
message displayed on the touch screen and select OK.

7. Specify settings as necessary.

* To select the photo to print:

Flick horizontally to select the photo.

You can also scroll through the photos with and .
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» To change the display method, the number of copies, or the print settings:

Select £ near the bottom of the displayed photo to display menus.

| I
G F E D

A: Total number of copies is displayed

When selecting, the Check total no. of copies screen is displayed and you can check the number
of copies for each photo. On the Check total no. of copies screen, you can change the number of
copies for each photo.

B: Specify the number of copies

_1‘0
1O

Use o and o to specify the number of copies.

Touch and hold to specify the number of copies by 10 copies.

You can also flick the number to specify.

22> Note

* You can specify the number of copies for each photo. Display the photo you want to print and
specify the number of copies when the desired photo is displayed.
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C: Select to switch the photo group.

Switch group

Switch to group of older dates
Switch to group of newer dates

Cancel

For details:

= Using Useful Display Functions

D: Select to display the Settings screen.

You can change the settings of page size, media type, and print quality and so on.

Settings

Paper src Top feed

Fage size Ad

Type Plain Paper
Print qity Standard @
2> Note

» Some settings cannot be specified in combination with the setting of other setting item. If the
setting which cannot be specified in combination is selected, ! appears on the touch screen.

In this case, select ! on the upper left on the touch screen to check the message and
change the setting.

E: Select to zoom in on the photo.

For details:

= Using Useful Display Functions

F: Select to display photo with specifying the date (last modified date of data).
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To most recent date

For details:

= Using Useful Display Functions

G: Select to display the multiple photos at once.

For more on the display method:

= Using Useful Display Functions

8. Press Color button.
The printer starts printing.
> Note
* To cancel printing, press the Stop button.
* While processing the print job, you can add the print job (Reserve photo print).

= Adding Print Job

| Adding Print Job

You can add the print job (Reserve photo print) while printing photos.

Follow the procedure below to add the print job.

1. Flick photo while printing to select next photo.

»» Note

» While you select the photo, the printer prints the reserved photos.

* The % appears on the photo included in the print job.
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2. Specify number of copies and print settings for each photo.

> Note

» While processing the print job, you cannot change the setting for Page size or Type on print
settings confirmation screen. The setting is the same as the setting for the photo included in the
print job.

3. Press Color button.

The reserved photo is printed next to the photo that has already been started printing.

If you want to print more photos, operate from step 1 again.

2> Note

While processing the print job, you cannot display the HOME screen, change the print menu, or print
from the computer or other devices.

While processing the print job, the photo in other group is not selected.

If you press the Stop button while processing the print job, the screen to select a method to cancel
reservation is displayed. If you select Cancel all reservations, you can cancel printing all photos. If
you select Cancel the last reservation, you can cancel the last printing job.

If there are many print jobs, Cannot reserve more print jobs. Please wait a while and redo the
operation. may be displayed on the touch screen. In this case, wait a while and add the print job.
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I Using Useful Display Functions

You can display the multiple photos at once, specify the date (last modified date of data) to select photos,
and switch the photo group.

Select £ on the photo selection screen to select the display menu.

= Viewing Multiple Photos to Select Photo
= Specifying Date to Select Photo

= Zooming in on Photo

= Switching Photo Group

I Viewing Multiple Photos to Select Photo
.

The following screen is displayed by selecting ™™ on the photo selection screen.

A: When the photo you want to print is selected, the touch screen returns to single photo display.
B: Select to display photo with specifying the date.

= Specifying Date to Select Photo

C: Select to increase the display photos. (54 photos display)
D: Drag to switch the number of display photos to 6 photos, 15 photos, or 54 photos.
E: Select to decrease the display photos. (6 photos display)

I Specifying Date to Select Photo

The following screen is displayed by selecting I-il on the photo selection screen.
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To most recent date

Flick horizontally to switch the date (update date of photo data).

The photos on date specified are displayed.

You can also select the date by using and .

¥ Note

» The date is displayed according to the settings of Date display format in Other printer settings
under Printer settings.

= Other printer settings

I Zooming in on Photo

The following screen is displayed by selecting —~* on the photo selection screen.

F: Select to switch the display magnification.

G: Drag to move the display position.

I Switching Photo Group

»» Note

« If more than 2,000 photo data are saved on the USB flash drive, the photo data is split by group per
2,000 photos in reverse chronological order (date last modified) automatically.

The following screen is displayed by selecting . on the photo selection screen.
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Switch group

Switch to group of older dates

Switch to aroup of newer dates

Cancel

H: Select to switch the photo group.
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I Printing Documents (PDF) Saved on USB Flash Drive

You can print following PDF files (Extension: .pdf) using the operation panel of the printer.
» PDF files scanned using the operation panel of the printer and saved on a USB flash drive

= Saving Scanned Data on USB Flash Drive

* PDF files made using Canon IJ Scan Utility
For Windows:

= Scanning Documents and Photos

For macOS:
= Scanning Documents and Photos
For more on PDF files you cannot print from the printer:

= PDF Files You Cannot Print

Follow the procedure below to print a PDF file.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

2. Insert USB flash drive into USB flash drive port.

3. Select % Others on the HOME screen.

= Home Screen Menu Composition

4, Select = Print from.

5. Select Print from USB flash drive.

The document list is displayed.

> Note

« If both photo files and PDF files are saved on the USB flash drive, the confirmation screen to
select which file you print is displayed. Select Print documents in the displayed screen.

6. Select document to print.
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File name list

PDF file print

{=| SCNfile. 002, pdf
f=| SCNfile. 003. pdf A

&l SCNfile, 004, pdf

L SR ERY . AAFN _ aE

Preview display

SCNfile. 003. pdf 3/7

A: Flick vertically to display the name of documents and select document to print.

B: Select to switch to the preview display.

C: Flick to display document preview and select document to print.

D: Select to switch to the file name list.

E: Select to display the Details screen.

»» Note

File names may not be displayed properly on the document list if the file name is long or includes
incompatible characters.

On the preview screen, the first page of each PDF file is displayed on the touch screen. Also, if a
document is in landscape format, it will be displayed rotated by 90 degrees.

For some PDF files, it may take longer to display the preview or part of the preview may be
cropped.

The name of the PDF files is displayed even though the PDF files cannot be printed using the
operation panel of the printer. If one of the following conditions is applicable to the PDF files, they
are not printable.

— PDF files saved using application software other than Canon IJ Scan Utility
— PDF files for which the preview screen is not available ("?" is displayed on the preview
screen.)

We recommend you display the Details screen and make sure whether a PDF file is printable. If
one of the following conditions is applicable to the PDF file, it is not printable.

— Information on the Details screen cannot be displayed.
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— Characters other than the printer name or IJ Scan Utility are displayed on Created with.

» The PDF files made using application software other than Canon IJ Scan Utility are not printable
even if they are saved using Canon IJ Scan Utility.

7. Specify settings as necessary.

PDF file print

Copies 1 1
Paper src Roll paper

Page size Letter

Copies
Specify the number of copies.

Paper src
Select the paper source.

Page size

Select the paper size of the loaded paper.
Type (Media type)

The paper type is set to Plain paper.

Print qlty (Print quality)
Specify the print quality.

8. Press the Black button or the Color button.
The printer starts printing.

»» Note

* You can print up to 250 pages at a time. If you try to print more than 250 pages of a PDF file, The
specified PDF file contains too many pages. The pages exceeding the number of printable pages
will not be printed. Continue? is displayed on the touch screen. To start printing, select Yes. If you
need to print more than 250 pages of a PDF file, print them from a computer.

» Depending on the PDF file, it may be printed rotated by 90 degrees.

+ If the document size is larger than the page size specified on the printer, the document will be printed
at a reduced size. In this case, thin lines on the document may not be printed or images may be
misaligned.

I PDF Files You Cannot Print

You cannot print the following PDF files even though the name of the PDF files is displayed on the list.

* Files scanned using the operation panel of the printer and saved on a USB flash drive with Format
set to other than PDF or Compact PDF

« Files made using Canon IJ Scan Utility and one of the following conditions is applied
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-Encrypted data
-Data more than 2 GB

-Data including images scanned at 9601 pixels or more in the vertical and horizontal directions
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I Printing from Smartphone/Tablet

or more on printing from a device, refer to the device's or application's instruction manual.
F ting fi d fer to the d ! lication' truct |

» Print Easily from a Smartphone or Tablet with Canon PRINT
» Printing from iOS Device (AirPrint)
» Printing with Mopria Print Service

» Printing with Canon Print Service
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I Copying

This function is available only for TC-20M.
» Copying to Roll Paper

@« Copying to the Roll Width

t.

Making Enlarged Copies with Basic Settings

t.

Print a Single Original to Roll Paper Multiple Times Using a Layout

t.

Reducing/Enlarging Copies

t.

Copying Thick Originals Such as Books
» Copying to Cut Sheet

@« Making Copies

t.

Reducing/Enlarging Copies

t.

Copying Two Pages onto Single Page

t.

Copying Four Pages onto Single Page

t.

Making Image Stitch Copies

t.

Copying ID Card to Fit onto Single Page

t.

Copying Thick Originals Such as Books
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I Copying to Roll Paper

» Copying to the Roll Width

» Making Enlarged Copies with Basic Settings

» Print a Single Original to Roll Paper Multiple Times Using a Layout
» Reducing/Enlarging Copies

» Copying Thick Originals Such as Books

163



I Copying to the Roll Width

The original can be enlarged and copied to the width of the roll paper.

A@_’A

1. Load paper.

= | oading Rolls in the Printer

2. Loading Originals on Document Platen

= | oading Originals on Document Platen

=F
3. Select . Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to roll paper.

4. Select Fit to roll width copy.

5. On the Copy standby screen, specify settings as necessary.

[ A
[ 24 in Roll
Plain Paper “ 1 — B
= Fit to roll width c
. ]
£* Settings
D

A: The size and type of the loaded paper.

B: Specify the number of copies.
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24 in Rol 1 =]
Plain Pap
= 1] 2 |3
= 4 6
— 7| 8| 9
g3 Settine | O OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

6. Press the Black button or the Color button.
»>» Note

» To cancel copying, press the Stop button.
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I Making Enlarged Copies with Basic Settings

1. Load paper.

= Loading Rolls in the Printer

2. Loading Originals on Document Platen

= Loading Originals on Document Platen

3. Select Copy on the HOME screen.

= Home Screen Menu Composition

> Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to roll paper.

4. Select Enlargement copy.

5. Select the size you want to enlarge.

Enlargement copy

141% A4+A3
200% Ad»A2

283% Ad3A1

6. On the Copy standby screen, specify settings as necessary.

A
|
24 in Roll
Plain Paper ” 1 — B
= 129% c
LTR»11"x17"
£* Settings
D
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A: The size and type of the loaded paper.

B: Specify the number of copies.

24 in Rol 1 P
Plain Pap
— 1] 2] 3
= 4 6
—| 7| 8| 9
g settine | O OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

7. Press the Black button or the Color button.
»» Note

» To cancel copying, press the Stop button.

* You can add the copying job while printing.

= Adding Copying Job (Reserve copy)
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Print a Single Original to Roll Paper Multiple Times Using a
Layout

A (=

AlA
AlA
e

1. Load paper.

= Loading Rolls in the Printer

2. Loading originals on document platen.

= | oading Originals on Document Platen

=k

=

3. Select —! Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to roll paper.

4. Select @, Repeat copy.

5. Select Layout on the copy standby screen.

Set the layout of the original.

24 in
Plain || § 2% 1
5 Ix1
4x1
1 1x2
Sl m 2% 2 v

6. Select Position on the copy standby screen.

Select the orientation.
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24in .
Plain Portrait

Landscape

£ Se

7. On the Copy standby screen, specify settings as necessary.

| A
24 in Roll ‘
Plain Paper 1 B
—E
c Position

Portrait E

£ Settings © How to set
‘ D

A: The size and type of the loaded paper.

B: Specify the number of copies.

24 in Rol 1 )

Plain Pap . =
1] 2] 3
| 4 | | 6
| 7] 8] 9

g3 Settine | O 0K

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

E: Set the layout of the original.

F: Select the orientation.

8. Press the Black button or the Color button.

The printer starts copying.
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»» Note

* To cancel copying, press the Stop button.
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I Reducing/Enlarging Copies

You can specify the magnification optionally or select the preset-ratio copying or fit-to-page copying.
»» NOTE
* You can make enlarged copies on to roll paper easily.

= Making Enlarged Copies with Basic Settings

* You can copy your originals to fit the roll paper width without having to specify the magnification.

= Copying to the Roll Width

1. Load paper.

= | oading Rolls in the Printer

2. Loading Originals on Document Platen.

= | oading Originals on Document Platen

=k

=

3. Select = Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to roll paper.

4. Select Scaled copy.

5. Select Settings.

6. Select a magnification level in Magnif..

: 100/% =

Copies 127% A4>115 B4
Intensityl 119% Ad>IS0 B4
Magnif. [ Same size ‘
Paper st Fit to page
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A: Flick to select the reduction/enlargement method.

= Reduction/enlargement Method

B: Select to display the screen below.

|
Copies | 2 3 |
Intensity 4 | 3 6 |
Magnif. 7 | 6 J |
0| ok |

Paper sit

Select the numbers to specify the magnification.
7. Select OK.

8. On the Copy standby screen, specify settings as necessary.

A
l
24 in Roll
Plain Paper 1 =
— C
£* Settings
D

A: The size and type of the loaded paper.

B: Specify the number of copies.

glil_inl-'inl" 1 ‘ I

ain Pap
ERERE
4] 5] 6
| 7] 8] 9

gesettin:| O | OK

Select the numbers to specify the number of copies.
C: The copy layout.
D: Display the print setting items.
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For more on the setting items:

= Setting Items for Copying

9. Press the Black button or the Color button.
3> Note

» To cancel copying, press the Stop button.

* You can add the copying job while printing.

= Adding Copying Job (Reserve copy)

I Reduction/enlargement Method

* Fit to page

The printer automatically reduces or enlarges the image to fit the page size.

DIEAIC]

The setting in Magnif.: Fit to page
»>» Note

* When you select Fit to page, the page size may not be detected correctly depending on the
original. In this case, select the setting other than Fit to page.

* Preset ratio

You can select one of the preset ratios to reduce or enlarge copies.

&

Select the appropriate ratio for size of original and page size.

»» Note

» Some of the preset ratios are not available depending on the country or region of purchase.

e

 Ratio specified copy

You can specify the copy ratio as a percentage to reduce or enlarge copies.

»>» Note

* 400% MAX (maximum copy ratio) and 25% MIN (minimum copy ratio) are selectable.
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« If you make a copy at the same size as the original, select Same size.
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I Copying Thick Originals Such as Books

When copying thick originals such as books, you can make a copy without black margins around the image
and gutter shadows. Using this function, you can reduce unnecessary ink consumption.

1. Load paper.

= | oading Rolls in the Printer

2. Load the original on the document platen.

= | oading Originals on Document Platen

=
3. Select —= Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to roll paper.

[
4. Select ""[i__r) Frame erase copy.

5. On the Copy standby screen, specify settings as necessary.

[ A
(24 in Roll
Plain Paper “ 1 — B
i * i e .C
[ £+ Settings J
D

A: The size and type of the loaded paper.
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B: Specify the number of copies.

24_in Rol '| e
Plain Pap
1 2 3
4 6
= 7 8 9
£ Settine | 0 OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

6. Press the Black button or the Color button.
»>» Note
¢ Close the document cover.

* There may be a narrow black margin that appears around the image. This function removes the dark
margins only. If a scanned book is too thin or when the printer is used near a window or in a bright
environment, a faint black frame may remain. Also, if the color of an original is dark, the printer cannot
distinguish the document color from the shadow and this may cause slight cropping or a shadow on the
crease.

» To cancel copying, press the Stop button.
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I Copying to Cut Sheet

» Making Copies

» Reducing/Enlarging Copies

» Copying Two Pages onto Single Page

» Copying Four Pages onto Single Page
» Making Image Stitch Copies

» Copying ID Card to Fit onto Single Page

» Copying Thick Originals Such as Books
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I Making Copies

This section describes the basic procedure to perform standard copying.

1. Load paper.

= | oading Sheets in the Printer

2. Loading originals on document platen.

= | oading Originals on Document Platen

=k

=

3. Select = Copy on the HOME screen.
= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

4. Select Standard copy.

5. On the Copy standby screen, specify settings as necessary.

A
‘:I‘:in paper " 1 — ®
' C

[ £k Settings
D

A: The size and type of the loaded paper.

B: Specify the number of copies.
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Plain pap
1 2 3
4 6
F | 8 9
£+ Settir 0 OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

6. Press the Black button or the Color button.

3% Important

* Do not open the document cover or remove the original from the platen until scanning is
completed.

»» Note

» To cancel copying, press the Stop button.

I Adding Copying Job (Reserve copy)

If you load the original on the platen, you can add the copying job while printing (Reserve copy).
The screen below is displayed when you can add the copying job.
Copying...

Place another original and
press [ to continue copying.

Left: 10

Load the original on the platen and select the same button (Black button or Color button) as the one
which you previously pressed.

22 Important

* When you load the original on the platen, move the document cover gently.
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»>» Note
* When Print glty (print quality) is set High, you cannot add the copying job.

* When you add the copying job, the number of copies or the settings such as the page size or media
type cannot be changed.

If you press Stop button while reserve copying is in progress, the screen to select the method
to cancel copying is displayed. If you select Cancel all reservations, you can cancel copying all
scanned data. If you select Cancel the last reservation, you can cancel the last copying job.

If you set a document of too many pages to add the copying job, Cannot add more copy jobs.
Please wait a while and redo the operation. may appear on the touch screen. Select OK and wait
a while, and then try copying again.

« If Failed to reserve the copy job. Start over from the beginning. appears on the touch screen
when scanning, select OK and press Stop button to cancel copying. After that, copy the documents
that have not been finished copying.
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I Setting Items for Copying

You can change the copy settings such as magnification and intensity.

I Print Settings Screen

The following screen is displayed by selecting Settings in the Copy standby screen.

[&Preview
Copies 1
Intensity Standard
Paper src Roll paper

Tvpe Plain Paper

I Preview

When Preview is displayed on the print settings screen, selecting Preview allows you to preview an
image of the printout on the preview screen.

OK

3% Important

» The original will be scanned to display the preview image. Therefore, do not open the document
cover until the preview screen is displayed.

« Originals are rescanned after displaying the preview screen and before copying starts. Therefore, do
not open the document cover or remove the original from the platen while Scanning original... is
displayed.

I Setting Items

Flick to display setting items and select the setting item to display the settings. Select to specify the
setting.

> Note

» The setting items displayed vary depending on the copy function.
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» Some settings cannot be specified in combination with the setting of other setting item. If the setting
which cannot be specified in combination is selected, ! appears on the touch screen. In this case,
select ! on the upper left on the touch screen to check the message and change the setting.

» The settings of the page size, media type, etc. are retained even if the printer is turned off.

» When copying starts in the copy setting that is not copied, The specified function is not available
with current settings. is displayed on the touch screen. Change the setting, following the on-screen
instructions.

Following setting items can be changed.
* Copies

Specify the number of copies.

Intensity

Specify the intensity.

Cop

— Intensity Standard

|

(Inte; T T e

: L — '—B
Mag

Pape L

A: Select to activate/deactivate automatic intensity adjustment.

When ON is selected, the intensity is adjusted automatically according to the originals loaded on the
platen.

B: Drag to specify the intensity.
» Magnif. (Magnification)
Specify the reduction/enlargement method.

= Reducing/Enlarging Copies (Roll paper)
= Reducing/Enlarging Copies (Cut sheet)

* Original size
Select the size of the document you want to copy.

= Making Image Stitch Copies

» Paper src

Select the paper source.
» Page size

Select the page size of the loaded paper.
* Type (Media type)

Select the media type of the loaded paper.
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* Print qlty (Print quality)
Adjust print quality according to the original.

22 Important

« If you use Draft with Type set to Plain paper and the quality is not as good as expected, select
Standard or High for Print qlty and try copying again.

 Select High for Print qlty to copy in grayscale. Grayscale renders tones in a range of grays
instead of black or white.

* Layout
Select the layout.

= Copying Two Pages onto Single Page
= Copying Four Pages onto Single Page

¢ Position

Select the orientation.
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I Reducing/Enlarging Copies

You can specify the magnification optionally or select the preset-ratio copying or fit-to-page copying.

1. Load paper.

= | oading Sheets in the Printer

2. Loading Originals on Document Platen.

= | oading Originals on Document Platen

=k

=

3. Select = Copy on the HOME screen.
= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

4. Select Standard copy.
5. Select Settings.

6. Select a magnification level in Magnif..

A
I 100/9% B
Copies 122% Ad>]1S B4
Intensity] 119% Ad>|S0 B4
Magnif. [ Same size ‘
Paper sr Fit to page

A: Flick to select the reduction/enlargement method.

= Reduction/enlargement Method

B: Select to display the screen below.

184



100 | @
Copies 1 : 2 . 3
Intensity 4 : 3 = 6
'.Magnif. 7 - 6 J
: 0 | OK
Paper sit P———

Select the numbers to specify the magnification.
7. Select OK.

8. On the Copy standby screen, specify settings as necessary.

A
i]iin paper H 1 .
= c

[;:c-s.enings
D

A: The size and type of the loaded paper.

B: Specify the number of copies.

Plain pap : :
1 2 =2
4 6
F | 8 9
& settin | O Ok

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

9. Press the Black button or the Color button.
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»» Note

» To cancel copying, press the Stop button.
* You can add the copying job while printing.

= Adding Copying Job (Reserve copy)

I Reduction/enlargement Method

* Fit to page

The printer automatically reduces or enlarges the image to fit the page size.

DL AIC]

The setting in Magnif.: Fit to page
»>» Note

* When you select Fit to page, the page size may not be detected correctly depending on the
original. In this case, select the setting other than Fit to page.

* Preset ratio

You can select one of the preset ratios to reduce or enlarge copies.

.;

Select the appropriate ratio for size of original and page size.

»» Note

» Some of the preset ratios are not available depending on the country or region of purchase.

i

b o

+ Ratio specified copy

You can specify the copy ratio as a percentage to reduce or enlarge copies.

L]

ui

&

»>» Note

* 400% MAX (maximum copy ratio) and 25% MIN (minimum copy ratio) are selectable.

+ If you make a copy at the same size as the original, select Same size.

186



I Copying Two Pages onto Single Page

You can copy two original pages onto a single sheet of paper by reducing each image.

1. Load paper.

= | oading Sheets in the Printer

2. Loading Originals on Document Platen.

= | oading Originals on Document Platen

=F

3. Select Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

o |
4. Select — Layout copy.

5. Select Settings.

6. Select 2-on-1 copy in Layout.

Type Plain Paper

Frint glty Standard

Layout Z2-on-1 copy

7. Select Advanced.
Specify the orientation and order of originals.

* When you select Orientation: Portrait and Left to right:

A B»AB

* When you select Orientation: Portrait and Right to left:
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A B»BA

* When you select Orientation: Landscape and Top to bottom:

A B’:

* When you select Orientation: Landscape and Bottom to top:

ALK

5. Select whether or not to show the preview screen.

If you select ON, the preview screen is displayed so that you can check the orientation and order of the
originals.

6. Select OK.

7. On the Copy standby screen, specify settings as necessary.

| A
Ad 'I B
Plain paper
i 4 C
| Lk Settings |
D

A: The size and type of the loaded paper.

B: Specify the number of copies.

Plain pap :
1 2 3
4 6
F | 8 9
£ Settin = O OK

Select the numbers to specify the number of copies.
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10.

1.

C: The copy layout.
D: Display the print setting items.
For more on the setting items:

= Setting Items for Copying

Press the Black button or the Color button.

When the first sheet of the original has been scanned, the following screen is displayed.

! A
Rescan ][ Scan j— B

' c

A: Select to rotate the original by 180 degrees.
B: Select to start scanning the original.

C: Select to rescan the original.

. Check the preview screen and select Scan.

The screen below appears after scanning the first sheet of original.

Page 2. Place the next
original and tap [Scan].

Print now ][ Scan ]— D
' E

D: Select to start scanning the original.

E: Select to start copying the original already scanned.
Load the second sheet of the original on the platen and select Scan.

Check the preview screen and select Scan.

The printer starts scanning the second sheet of original and copying.
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»» Note

+ If Cannot process because device memory is full. appears on the touch screen when scanning, set
Print qlty to Standard and try copying again. If the problem is not resolved when Media type is set to

Plain paper, set Print qlty to Draft and try copying again.
* To cancel copying, press the Stop button.
* You can add the copying job while printing.

= Adding Copying Job (Reserve copy)
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I Copying Four Pages onto Single Page

You can copy four original pages onto a single sheet of paper by reducing each image. Four different
layouts are available.

1. Load paper.

= | oading Sheets in the Printer

2. Loading Originals on Document Platen.

= Loading Originals on Document Platen

=F

3. Select Copy on the HOME screen.

= Home Screen Menu Composition

> Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

o |
4. Select . — Layout copy.

5. Select Settings.

6. Select 4-on-1 copy in Layout.

Type Plain Paper

Print glty Standard

[Laynut 4-0n-1 copy ]

7. Select Advanced.
Specify the orientation and order of originals.

»» Note

* The order is the same regardless of the orientation.

* When you select Upper-left to right
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A

Eleb]? e

* When you select Upper-right to left

A BreA

2 b % ode

* When you select Upper-left to bottom

A C

A
SNl

* When you select Upper-right to bottom

A CcC A
Sy

8. Select whether or not to show the preview screen.

If you select ON, the preview screen is displayed so that you can check the orientation and order of the
originals.

9. Select OK.

10. On the Copy standby screen, specify settings as necessary.

[ A

A4 -
Plain paper 1 =
C
[ Lk Settings
D
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1.

12.

A: The size and type of the loaded paper.

B: Specify the number of copies.

Plain pap
1 2 3
4 6
F | 8 9
£ settin | O OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

Press the Black button or the Color button.

When the first sheet of the original has been scanned, the following screen is displayed.

| ..::- A
Rescan ][ Scan ﬁ— B

' c

A: Select to rotate the original by 180 degrees.
B: Select to start scanning the original.

C: Select to rescan the original.

Check the preview screen and select Scan.

The screen below appears after scanning each sheet of original.
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Page 2, Place the next
original and tap [Scan].

Print now ][ Scan ]— D
' E

D: Select to start scanning the original.

E: Select to start copying the original already scanned.

13. Load the second sheet of the original on the document platen and select Scan.
14. Check the preview screen and select Scan.

15. Repeat steps 13 and 14 to scan the third and fourth sheets of originals.
After scanning the fourth sheet of original, the printer starts copying.

»>» Note

« If Device memory is full. Cannot continue process. appears on the touch screen when scanning, set
Print qlty to Standard and try copying again. If the problem is not resolved when Media type is set to
Plain paper, set Print qlty to Draft and try copying again.

» To cancel copying, press the Stop button.
* You can add the copying job while printing.

= Adding Copying Job (Reserve copy)
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I Making Image Stitch Copies

You can scan oversized originals in two halves and then print them onto a single sheet.

1. Load paper.

= | oading Sheets in the Printer

2. Select Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

Image stitch copy.
4. Check message and select OK.
5. Select the size of the original.

6. Select page size to print onto.

7. Loading Originals on Document Platen

= Loading Originals on Document Platen
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8. Check message and select OK.

9. On the Copy standby screen, specify settings as necessary.

I A
#Iiin paper l[ 1 — B
=
=2= c
§—
[ﬁ- Settings ~
D

A: The size and type of the loaded paper.

B: Specify the number of copies.

Plain pap: = e .
o 2 | 3 _
4 5 | 6
7 8| 9
2 Settin | O OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying
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10. Press the Black button or the Color button.
The printer starts scanning of the first half of the original.

When scanning of the original is finished, the printer beeps.

11. Rotate the oversized original 180 degrees to place its other half on platen, and then align it

with alignment mark (£9).

12. Check the message, and select Scan.

The printer scans the other half of the oversized original and starts copying.

3> Note
* To cancel copying, press the Stop button.

» White lines or image misalignment may occur in the center of the copy due to the contents of the
original or how it was placed. If the print results are not as expected, try Canon IJ Scan Utility
(Windows) or Canon IJ Scan Utility Lite (macOS) located on the computer.

= Scanning Originals Larger than the Platen (Image Stitch) (Windows)
= Scanning Originals Larger than the Platen (Image Stitch) (macOS)
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I Copying ID Card to Fit onto Single Page

You can copy a card sized original such as an ID card onto a single sheet of paper consecutively.

R

L=

1. Load paper.

= | oading Sheets in the Printer

=E

—a —

2. Select —! Copy on the HOME screen.
= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

3. Select — ID card copy.

4. Check message and select OK.

5. On the Copy standby screen, specify settings as necessary.

| A
Ad A
Plain paper [ 1 &
=
= ¢
[ £* Settings ]

A: The size and type of the loaded paper.

B: Specify the number of copies.
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Plain pap
1 2 3

6

8 9
OK

o~ || B

£+ Settin

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

»» Note

* If you select Preview in the print settings screen, you can check printing result of the front side.

= Using Preview Screen to Check Printing Result of Front Side

6. Press the Black button or the Color button.

7. Load the original on the document platen.

= | oading Originals on Document Platen

Place the ID card face up on the
document platen as shown and
tap [Scan].
Scan
Follow the on-screen instructions to load the original.

8. Select Scan.

9. Turn the original over and set it on the document platen.
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Flace the |D card face down

on the platen as shown and
tap [OK].

OK

Follow the on-screen instructions to load the original.

10. Select OK.
»>» Note

* To cancel copying, press the Stop button.

I Using Preview Screen to Check Printing Result of Front Side

Selecting Preview in the print setting screen displays how to load the original. Loading the original

following the on-screen instructions and selecting Scan displays the preview screen to check the printing
result of the front side.

£l

Selecting OK on the preview screen returns to print settings screen.

Pressing the Color button or Black button starts scanning the front side.
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I Copying Thick Originals Such as Books

When copying thick originals such as books, you can make a copy without black margins around the image
and gutter shadows. Using this function, you can reduce unnecessary ink consumption.

1. Load paper.

= | oading Sheets in the Printer

2. Load the original on the document platen.

= | oading Originals on Document Platen

=
3. Select —= Copy on the HOME screen.

= Home Screen Menu Composition

»» Note

« If both roll paper and cut sheet are loaded, a screen will appear asking which one to use. Select
Copy to cut sheet.

4. Select Frame erase copy.

5. On the Copy standby screen, specify settings as necessary.

| A
Ad
Plain paper |[ 1 — B
i * i b C
£+ Settings ]
D

A: The size and type of the loaded paper.
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B: Specify the number of copies.

iy 1 @
Plain pap

1 2 L

4

") 8 9
£ Settir 0 OK

Select the numbers to specify the number of copies.
C: The copy layout.

D: Display the print setting items.

For more on the setting items:

= Setting Items for Copying

6. Press the Black button or the Color button.
»» Note
* Close the document cover.

* There may be a narrow black margin that appears around the image. This function removes the dark
margins only. If a scanned book is too thin or when the printer is used near a window or in a bright
environment, a faint black frame may remain. Also, if the color of an original is dark, the printer cannot
distinguish the document color from the shadow and this may cause slight cropping or a shadow on the
crease.

* To cancel copying, press the Stop button.
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I Scanning

This function is available only for TC-20M.

» Saving Scanned Data to Your Computer 7Basics
» Sending Scanned Data as E-Mail from Printer
» Sending Scanned Data as E-Mail from Computer
» Saving Scanned Data on USB Flash Drive
» Forwarding Scanned Data to Shared Folder on Computer
» Scanning with a Computer Application
@« Scanning with Windows

@« Scanninng with macOS

203



I Saving Scanned Data to Your Computer

Before saving the scanned data to the computer, check the following:

* Printer driver is installed. (Windows)

If the printer driver is not installed yet, install the printer driver from the Setup CD-ROM or the Canon
website.

= |nstalling the Printer Driver

* When scanning via a network connection
Make sure the printer is connected to the computer correctly.
o For Windows:

= Network Scan Settings

o For macOS:
= Scan-from-Operation-Panel Settings Screen

Follow the procedure below to save scanned data to the computer.

1. Loading Originals on Document Platen

= | oading Originals on Document Platen

2. Select % Others on the HOME screen.

= Home Screen Menu Composition

3. Select H

Scan.

4. Select Save to computer.

5. Select where to save the scanned data.

Select Local (USB) for a USB-connected computer, or select the computer to save the scanned data for
a network-connected computer.

Select PC
Local (USB)
PC0O0
PC002

Search again
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6. On the Scan standy screen, specify the settings as necessary.

Doc.type Document A
[ £ Settings PDF
Ad B
. 200 dpi
m Local (USB) ]7 c

A: Select the document type.

Document
Select to scan the document.

Photo
Select to scan the photo.

B: Displays Scan settings screen.
For more on the setting items:

= Setting Items for Scanning Using Operation Panel

C: Displays the screen to select the save.

7. Press the Black button or the Color button.

> Note

« If the original is not loaded properly, a message is displayed on the touch screen. Load the
original on the platen according to the scan settings.

* When you select JPEG or TIFF for Format on the scan setting screen:
The printer starts scanning and scanned data is saved to the computer.
* When you select PDF or Compact PDF for Format on the scan setting screen:

The confirmation screen asking you if you continue scanning is displayed after scanning is
complete.

To continue scanning, place the
next original on the document
platen and press E .

End

If you continue scanning, load the original on the platen and start scanning.

If you do not continue scanning, select End. The scanned data is saved to the computer in one
PDF file.
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Scanned data is saved to the computer according to the settings specified in Canon IJ Scan Utility/
Canon IJ Scan Utility Lite.

»» Note

* You can use the following scanning method.

— Scanning with a WIA-compliant application software (Windows)
For details:

= Scanning with WIA Driver

— Converting a scanned document to text (OCR)
For details:

— For Windows:

= Extracting Text from Scanned Images (OCR)(Windows)
— For macOS:
= Extracting Text from Scanned Images (OCR)(macOS)
— Forwarding the scanned data to the computer using WSD (one of the network protocols
supported in Windows)

= \WSD scan from this printer

* When using Windows, the program selection screen may be displayed after pressing Black button or
Color button.

In this case, select Canon IJ Scan Utility and click OK.

* You can change where scanned data is saved and the file name by using Canon IJ Scan Utility
(Windows) or Canon IJ Scan Utility Lite (macOS). For the settings of Canon IJ Scan Utility and Canon
IJ Scan Utility Lite, see the following.

— For Windows:

= Settings Dialog Box

— For macOS:
= Settings Dialog

» Canon IJ Scan Utility (Windows) or Canon |J Scan Utility Lite (macOS) allows you to specify how to
respond when scanning from the operation panel. For more on settings of Canon IJ Scan Utility/Canon
IJ Scan Utility Lite:

— For Windows:

= Setting Up Operation Panel with I1J Scan Utility (Windows)

— For macOS:

= Setting Up Operation Panel with IJ Scan Utility Lite (macOS)
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I Setting Items for Scanning Using Operation Panel

You can change the scan settings such as the scan size, resolution, or data format.

When the Scan standby screen is displayed, select Scan settings to select the setting item. Flick to display
setting items and select the setting item to display the settings. Select to specify the setting.

2> Note
» The scan setting cannot be specified under the following conditions:

— When you forward the scanned data to the computer using WSD (one of the network protocols
supported in Windows)

» Some settings cannot be specified in combination with the setting of other setting item, the document
type selected for Doc.type, or the scan menu on the screen for selecting to which you save the data. If

the setting which cannot be specified in combination is selected, ! and Error details are displayed on

the touch screen. In this case, select ! on the upper left on the touch screen to check the message
and change the setting.

» The specified scan settings such as the scan size, resolution, and data format are retained even if the
printer is turned off.

* When scanning starts in the scan menu that is not available with the specified setting, The specified
function is not available with current settings. is displayed on the touch screen. Change the setting,
following the on-screen instructions.

* When you save the scanned data to the computer or attach the data to an e-mail, you can specify the
destination and file name using Canon IJ Scan Utility (Windows)/Canon IJ Scan Utility Lite (macOS).

— For Windows:

= Settings Dialog Box

— For macOS:
= Settings Dialog

« If you scan originals from the computer, you can scan with advanced settings. For more on scanning
from the computer:

— For Windows:

= Scanning with Windows

— For macOS:

= Scanning with macOS

Scan settings
Scan size Ad
Format PDF

Scan res 200 dpi
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Scan size

Select the size of the original.

Format

Select the data format of the scanned data.

Scan res (Scan resolution)

Select the resolution for scanning.

Preview

Select to preview the scanned data or not when saving the data on a USB flash drive.
Reduce show-thru (Reducing show-through)

Characters on the back may show through when scanning a thin document such as a newspaper.
Select ON if characters seem to show through on the scanned document.

This setting item is not available when Photo is selected for Doc.type.
Descreen

A printout consists of minute dots to make characters or graphs. Interfering with each dot may result in
uneven shades or a striped pattern. Select ON if you notice any uneven shades or a striped pattern on
the scanned image.

This setting item is not available when Photo is selected for Doc.type.

»» Note

» Even if ON is selected for this setting, some moire effects may remain if Unsharp mask is set to
ON. In that case, select OFF for Unsharp mask.

Unsharp mask

The outline of small characters or thin objects such as a hair or leaves on a photo can be accentuated.
Select ON if you want to accentuate the outline of the scanned data.

32 Important

* For macOS, the unsharp mask function does not work even if you select ON.
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I Sending Scanned Data as E-Mail from Printer

» Sending Scanned Data as E-Mail from Printer
» Registering Recipients’' E-Mail Address

» Registering Recipients in Group E-Mail

» Changing Registered Information

» Deleting Registered Information

» Importing/Exporting E-Mail Address Book
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I Sending Scanned Data as E-Mail from Printer

You can send scanned data as an e-mail from the printer.

1. Configure the mail server settings in the remote UI.

= Setting Mail Server

2. Loading Originals on Document Platen

= | oading Originals on Document Platen

3. Select % Others on the HOME screen.

= Home Screen Menu Composition

4, Select Scan.

5. Select Attach to email.

i} @

6. Select E-mail directly from device.
7. Select Select recipients.

8. Specify recipient(s).

Select recipients

Select from e-mail address book A
Direct entry —B
Select from input history —_C

A: Select the recipient(s) from the address book.
B: Enter recipient's e-mail address.

C: Select the recipient(s) from the input history.

9. Perform mail sending settings.

The screen below appears.
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{no subject)

—D

= —E
abcdRefgh. ij
Add recipient OK
I
G
D: Enter the subject.
E: Select the items below.
(n
o Check address —H
E
Delete —
Change to Cc —_—J
Change to Bce —K

 Ade

H: Check the address. Selecting Edit allows you to change the address.

I: Selecting Yes deletes the recipient.

J: Select to change to Cc (carbon copy).

K: Select to change to Bcc (blind carbon copy).

»>» Note

» To change Cc or Bcc to To, Select the recipient and select Change to To.

F: Complete specifying the recipient.

G: Add the recipient.

10. Specify settings as necessary.

Doc.type Document p— ]
£+ Settings PDF
Ad —M
200 dpi
@ abcdeefah. ij N

L: Select the document type.
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Document
Select to scan the document.

Photo
Select to scan the photo.

M: Displays Scan settings screen.
For more on the setting items:

= Setting Items for Scanning Using Operation Panel

N: Changes the destination of e-mail/screen.

11. Press the Black button or the Color button.
> Note

« If the original is not loaded properly, a message is displayed on the touch screen. Load the
original on the platen according to the scan settings.

* If you select ON for Preview on the scan setting screen:

The preview screen is displayed before sending the scanned original as an e-mail.

0

. | W —P

| Rescan | Apply Q
| R

O: The preview screen of the scanning data is displayed.
P: Select to rotate the preview screen.

Displayed when you select PDF or Compact PDF for Format on the scan setting screen.
Q: Select to send the scanned original as an e-mail.

R: Select to rescan the original.

* When you select JPEG for Format on the scan setting screen:

The printer starts scanning and scanned data is sent as an e-mail.

* When you select PDF or Compact PDF for Format on the scan setting screen:

The confirmation screen asking you if you continue scanning is displayed after scanning is
complete.
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To continue scanning, place the
next original on the document
platen and press E .

End

If you continue scanning, load the original on the platen and start scanning.

If you do not continue scanning, select End. The scanned data is sent as an e-mail in one PDF file.

I Checking Send Log

Selecting Check send log on E-mail directly from device displays the items below.
» Display send log
Displays the send log of the printer (up to 100). Select the item to check more information.
* Print send log
Prints out the send log of the printer. Select Yes to start printing.

»>» Note

» When sending scanned data as an e-mail attachment, you can specify the subject line, body text, and
attachment file size limit using the remote UI.

= Specifying Mail Setting for Sending Scanned Data
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I Registering Recipients’ E-Mail Address

Before you can use the printer's address book, you need to register the recipients' e-mail address. Follow
the procedure below to register the recipients' e-mail address.

“ | Others on the HOME screen.

!

1. Select

= Home Screen Menu Composition

2. Select Scan.

3. Select Attach to E-mail.

b

4. Select E-mail directly from device.

5. Select Edit e-mail address book.

6. Select Display e-mail address book.
The screen to select an ID number is displayed.
E-mail address book {by ID}
00 | Cemmmmeeeee
1
02 2 ememmeeeee

Q New entry

»» Note

+ If you already registered the recipients, the recipients' name is displayed next to the ID number.

If you already registered the group mail, % and the group name are displayed next to the ID
number.

7. Select unregistered ID number.

»» Note

+ If you already registered the recipients and they are displayed by name, select Switch view. The
registered recipients are displayed by ID number.
* If you select New entry, an unregistered ID number will be selected in numerical order.
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8. Select Register e-mail address.

9. Select registration method.
* Direct entry

The screen to register the recipient's e-mail address and name is displayed. Go to next step.

E-mail address book 00

Name

E-mail address

» Select from send log

When you select this registration method, the screen to select the e-mail address from the send
logs is displayed.

Select from send log
cdefidghij. k1
bcde@fghi. jk
abcd@efgh. ij

Selecting an e-mail address from the send logs, the screen to register the recipient's e-mail
address and name is displayed. Go to next step.

10. Enter recipient's name.
1. Select entry field of name.
The screen to enter the character is displayed.

2. Enter recipient's name.

L. George 4
abc def x)
ghi jkl mno
pars tuv WKYZ
Azle | @ e- | %
3. Select OK.
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»» Note

* You can enter the name up to 16 characters, including spaces.

11. Enter recipient's e-mail address.

If you select an e-mail address on Select from send log, the e-mail address is already entered. If you
do not change the e-mail address, go to next step.

1. Select entry field of e-mail address.

2. Enter recipient's mail address.

abcd@efgh. 1] 4 p»
abc def || &
ghi jkl mno
pars tuv WXYZ
Amie | 4 g- || O
3. Select OK.
»>» Note

* You can enter the e-mail address up to 60 characters (40 characters for the US, Canada, Korea
and some regions of Latin America), including spaces.

12. Select Register to finalize registration.

> Note

» To register another recipient's number and name, select an unregistered ID number and operate
in the same procedure.
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I Registering Recipients in Group E-Mail

If you register two or more registered e-mail address to a group e-mail, you can send the same mail
successively to all recipients registered to the group e-mail.

!

1. Select I Others on the HOME screen.

= Home Screen Menu Composition

2. Select Scan.

3. Select Attach to email

b

4. Select E-mail directly from device.

5. Select Edit e-mail address book.

6. Select Display e-mail address book.
The screen to select an ID number is displayed.
E-mail address book {by ID}
00 L. George
(1) Alice
02  D.V.Michael

Switch view @ Q New entry

> Note

« If you already registered the recipients, the recipients' name is displayed next to the ID number.

If you already registered the group mail, % and the group name are displayed next to the ID
number.

7. Select unregistered ID number.

»» Note

« If you already registered the recipients and they are displayed by name, select Switch view. The
registered recipients are displayed by ID number.
* If you select New entry, an unregistered ID number will be selected in numerical order.
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8. Select Register group e-mail.

The screen to register the group name and the member of the group is displayed.

=

Group name

Add member

9. Enter group name.
1. Select entry field of group name.
The screen to enter the character is displayed.

2. Enter group name.

OFFICEOT < »
1 2 3 |a
4 5 6
7 8 9
A %18 0 2 || K
3. Select OK.
2> Note

* You can enter the name up to 16 characters, including spaces.
10. Register the registered recipient as a member of the group e-mail.

1. Select Add member.
The address book is displayed.
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Display by name
E-mail address book {by name)

01
03
02

Alice
B. Dylan
D.V.Michael

Sﬁ'rtch ﬁew Q .
|
A

l
B
Display by ID number
E-mail address book {by ID})

00 L. George

0 Alice

02

D.V.Michael

—

Switch ﬁe'}r Q

| I
A c

A: Select to switch the display by name and by ID number.

B: Select to display the screen to select an initial. You can search the registered recipient by initial.

E-mak ABC | DEF
01
KL
03
02
Switch v

By selecting the initial, the registered recipients are displayed in alphabetical order from the
selected character.

C: Select to display the screen to select an ID number of the registered recipient. You can search
the registered recipient by ID number.
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00 «
Bkl 1] 21 3
a 4 6
i 71 81| 9
switchvi | O OK

By entering the ID number and selecting OK, the registered recipients are displayed in order from
the recipient of the ID number selected.

D: The recipients that can be registered are displayed.
2. Select recipient to register as group member.

The member to register is displayed on the list.
“ . OFFICEM

001 00 L. George

Add member Complete

»» Note

» To delete the recipient from the group e-mail, select a recipient that you want to delete from
the list. After the confirmation screen is displayed, select Yes to delete the recipient from the
group e-mail.

3. To add another member, select Add member again.
The address book is displayed.
4. Select recipient to register as group member.

The member to register is displayed on the list.
“ . OFFICEM
001 00 L, George
002 01 Alice

Add member Complete

Repeat the procedure to register another member to the same group e-mail.

11. Select Complete to finalize registration.
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»» Note

» To register another group, select an unregistered ID number and operate in the same procedure.
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I Changing Registered Information

To change information registered for recipient and group e-mail, follow the procedure below.

1. Select % Others on the HOME screen.

= Home Screen Menu Composition

2. Select H’

Scan.

3. Select Attach to email.

4. Select g

E-mail directly from device.

5. Select Edit e-mail address book.

6. Select Display e-mail address book.

7. Select recipient or group e-mail to change.

8. Change registered information.

* To change an individual recipient:

1.

5.

Select Edit e-mail address.

The registered information screen of the selected recipient is displayed.
Select entry field of name or entry field of e-mail addresses.

The each edit screen is displayed.

Change name or e-mail addresses.

Select OK.

The touch screen returns to the registered information screen.

Select Register.

* To change a group e-mail:

1.

2.

3.

Select Edit group e-mail.

The registered information screen of the group e-mail is displayed.

To change group name, select entry field of name.

When edit screen of group name is displayed, change the group name then select OK.
To add member, select Add member.

When the e-mail address book is displayed, select the recipient you want to add.
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4. To delete member, select recipient on list.

When the confirmation screen is displayed, select Yes to delete the recipient from the group
e-mail.

5. Select Complete to finalize changing.
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I Deleting Registered Information

To delete information registered for recipient and group e-mail, follow the procedure below.

1. Select % Others on the HOME screen.

= Home Screen Menu Composition

2. Select H’ Scan.
3. Select Attach to email.
4, Select g

5. Select Edit e-mail address book.

E-mail directly from device.

6. Select Display e-mail address book.
7. Select recipient or group e-mail to delete.
8. Select Delete e-mail address or Delete group e-mail.

9. When confirmation screen is displayed, select Yes to delete.
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I Importing/Exporting E-Mail Address Book

You can import an e-mail address book saved on a USB flash drive, or export the e-mail address book
saved on the printer to a USB flash drive.

= |mporting E-Mail Address Book
= Exporting E-Mail Address Book

I Importing E-Mail Address Book

Follow the procedure below to import the e-mail address book.

1. Insert USB flash drive into USB flash drive port.

2. Select % Others on the HOME screen.

= Home Screen Menu Composition

3. Select H Scan.
4. Select Attach to email.
5. Select E

6. Select Edit e-mail address book.

E-mail directly from device.

7. Select Import e-mail address book.

8. Check message that is displayed and select Yes.

The address book saved on the USB flash drive is imported and the address book on the printer is
overwritten. (The address book name is "EMAIL_ADDRESS.BIN").

I Exporting E-Mail Address Book

Follow the procedure below to export the e-mail address book.

1. Insert USB flash drive into USB flash drive port.
3> Note

» To avoid overwriting the e-mail address book, you cannot save the book on a USB flash drive
which already includes it.

Delete the book from the USB flash drive or use the one which includes no book.
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» The address book is stored in "CANON_SC\EMAIL_ADDRESS.BIN".

B

. Select “| Others on the HOME screen.

= Home Screen Menu Composition

. Select Scan

. Select Attach to email.

n

. Select E-mail directly from device.
. Select Edit e-mail address book.

. Select Export e-mail address book.

. Check message that is displayed and select Yes.

The address book on the printer is saved on the USB flash drive.
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I Sending Scanned Data as E-Mail from Computer

Before attaching scanned data to an e-mail, check the following:

* Printer driver is installed. (Windows)

If the printer driver is not installed yet, install the printer driver from the Setup CD-ROM or the Canon
website.

= |nstalling the Printer Driver

* When scanning via a network connection
Make sure the printer is connected to the computer correctly.
o For Windows:

= Network Scan Settings

o For macOS:
= Scan-from-Operation-Panel Settings Screen

Follow the procedure below to send the scanned data as an e-mail from the computer.

1. Loading Originals on Document Platen.

= | oading Originals on Document Platen

2. Select % Others on the HOME screen.

= Home Screen Menu Composition

4, Select Attach to email.

5. Select E-mail from PC.

6. Select a computer to save scanned data.

Select Local (USB) for a USB-connected computer, or select the computer to save the scanned data for
a network-connected computer.
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Select PC
Local (USB)
PC0O0
PC002

Search again
The Scan standby screen is displayed.

7. Specify settings as necessary.

Doc.type Document A
" Settings PDF
Ad ——B
. 200
m Local (USB) ]7 c

A: Select the document type.

Document
Select to scan the document.

Photo
Select to scan the photo.

B: Displays Scan settings screen.
For more on the setting items:

= Setting Items for Scanning Using Operation Panel

C: Displays the screen to select the save.

8. Press the Black button or the Color button.
> Note

« If the original is not loaded properly, a message is displayed on the touch screen. Load the
original on the platen according to the scan settings.

* When you select JPEG for Format on the scan setting screen:
The printer starts scanning and scanned data is saved to the computer and attached to an e-mail.
* When you select PDF or Compact PDF for Format on the scan setting screen:

The confirmation screen asking you if you continue scanning is displayed after scanning is
complete.
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=}

To continue scanning, place the
next original on the document
platen and press E .

End

If you continue scanning, load the original on the platen and start scanning.

If you do not continue scanning, select End. The scanned data is saved to the computer in one
PDF file and attached to an e-mail.

9. Send e-mail from your computer.

»>» Note

You can specify the email software used to send attachments from Canon IJ Scan Utility and Canon IJ
Scan Utility Lite. For more on settings of Canon IJ Scan Utility/Canon IJ Scan Utility Lite:

— For Windows:

= Settings Dialog Box

— For macOS:
= Settings Dialog

When using Windows, the program selection screen may be displayed after pressing Black button or
Color button.

In this case, select Canon IJ Scan Utility and click OK.

Canon IJ Scan Utility (Windows) or Canon IJ Scan Utility Lite (macOS) allows you to specify how to
respond when scanning from the operation panel. For more on settings of Canon IJ Scan Utility/Canon
IJ Scan Utility Lite:

— For Windows:

= Setting Up Operation Panel with 1J Scan Utility (Windows)

— For macOS:

= Setting Up Operation Panel with |J Scan Utility Lite (macOS)
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I Saving Scanned Data on USB Flash Drive

You can save the scanned data directly to a USB flash drive. You can also delete the saved scanned data.

= Saving Scanned Data on USB Flash Drive
= Deleting Scanned Data on USB Flash Drive

22 Important

» Do not remove the USB flash drive from the printer under the following conditions:

— While scanning is in progress
— Before saving the scanned data

» For safety reasons, we recommend backing up the scanned data saved on a USB flash drive to another
media periodically to avoid unexpected accidents.

* We assume no responsibility for damage to or loss of data for whatever reason even within the warranty
period.

I Saving Scanned Data on USB Flash Drive

1. Loading Originals on Document Platen.

= [oading Originals on Document Platen

2. Insert USB flash drive into USB flash drive port.

3. Select % Others on the HOME screen.

= Home Screen Menu Composition

4. Select Scan.

i

5. Select Save to USB flash drive
6. Select Save to USB flash drive

7. Specify settings as necessary.
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Doc.type Document A

L "

£+ Settings PDF
Ad ——B
. 200 dpi
PEH USE flash drive —_—1

A: Select the document type.

Document
Select to scan the document.

Photo
Select to scan the photo.

B: Displays Scan settings screen.
For more on the setting items:

= Setting Items for Scanning Using Operation Panel

C: Displays the screen to select the save.

8. Press the Black button or the Color button.
> Note

« If the original is not loaded properly, a message is displayed on the touch screen. Load the
original on the platen according to the scan settings.

« If you select ON for Preview on the scan setting screen:

The preview screen is displayed before saving the scanned original on the USB flash drive.

. | WH—E
| Rescan | | Apply i— F

| G

E: The preview screen of the scanning data is displayed.
F: Select to rotate the preview screen.
Displayed when you select PDF or Compact PDF for Format on the scan setting screen.
G: Select to save the scanned original on the USB flash drive.
H: Select to rescan the original.

* When you select JPEG for Format on the scan setting screen:
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The printer starts scanning and scanned data is saved on the USB flash drive.
* When you select PDF or Compact PDF for Format on the scan settings screen:

The confirmation screen asking you if you continue scanning is displayed after scanning is
complete.

=4
To continue scanning, place the

next original on the document
platen and press E .

End

If you continue scanning, load the original on the platen and start scanning.

If you do not continue scanning, select End. The scanned data is saved on the USB flash drive
in one PDF file.

When you scan the originals continuously, you can save up to 100 pages of images in one PDF
file.

> Note

« If the USB flash drive becomes full while scanning images is in progress, only the images already
scanned can be saved.

* You can save up to 2000 files of scanned data saved on the USB flash drive in both PDF and JPEG
data format.

* The folder and file name of scanned data saved on the USB flash drive is as follows:
— Folder name: (file extension: PDF): CANON_SC\DOCUMENT\0001
— Folder name: (file extension: JPG): CANON_SC\IMAGE\0001
— File name: Running numbers, starting from SCN_0001
— File date: The date and time of saving as set in the printer.
For details on how to set the date and time:

= Other printer settings

* You can import the scanned data saved on a USB flash drive to the computer. After scanning the
data, connect the USB flash drive to the computer and import the data.

I Deleting Scanned Data on USB Flash Drive

With the USB flash drive loaded in the USB flash drive port, select Others > Scan > Save to USB flash
drive > Delete saved data from the printer's operation panel. Select the file you want to delete from the
list of files displayed, and select Yes on the confirmation screen to delete the file.
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I Forwarding Scanned Data to Shared Folder on Computer

Before forwarding scanned data to the shared folder on computer, check the following:

* Printer driver and Canon Quick Utility Toolbox are installed. (Windows)

If the printer driver is not installed yet, install the printer driver from the Setup CD-ROM or the Canon
website.

= |nstalling the Printer Driver

Install Canon Quick Utility Toolbox if it is not yet installed.

= Downloading Quick Utility Toolbox

* The Canon Quick Utility Toolbox is installed. (macOS)
Install Canon Quick Utility Toolbox if it is not yet installed.

= Downloading Quick Utility Toolbox

* The printer is connected to a computer via a LAN correctly.
o For Windows:

= Network Scan Settings

o For macOS:
= Scan-from-Operation-Panel Settings Screen

Follow the procedure below to forward scanned data to the shared folder on the computer.

1. Setting the Destination

You can register the destination folder using Canon Quick Utility Toolbox. For more on settings of Canon
Quick Utility Toolbox:

* For Windows:

= Destination Folder Settings(Windows)
* For Mac OS:

= Destination Folder Settings(macOS)

2. Loading Originals on Document Platen.

= | oading Originals on Document Platen

3. Select % Others on the HOME screen.

= Home Screen Menu Composition

4. Select H

Scan.
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5. Select

6. Select the folder to save scanned data on the Select folder screen.

»» Note

Save to destination folder.

» When you specify a PIN code for a registered folder, a screen asking you to enter a PIN code is
displayed. Entering the PIN code allows you to assign the shared folder as the destination.

7. Specify settings as necessary.

Doc.type Document — A
£* Settings PDF
Ad e |
200 dpi
[ SharedFolder 3 | c

A: Select the document type.

Document
Select to scan the document.

Photo
Select to scan the photo.

B: Displays Scan settings screen.
For more on the setting items:

= Setting ltems for Scanning Using Operation Panel

C: Displays the screen to select the save/forward.

8. Press the Black button or the Color button.

2> Note

« |If the original is not loaded properly, a message is displayed on the touch screen. Load the
original on the platen according to the scan settings.

* If you select ON for Preview on the scan setting screen:

The preview screen is displayed before forwarding scanned data to shared folder on computer.

234



‘ | A —E
| Rescan | Apply F
|

G

D: The preview screen of the scanning data is displayed.
E: Select to rotate the preview screen.
Displayed when you select PDF or Compact PDF for Format on the scan setting screen.

F: Select to forward the scanned original to the shared folder on the computer.

G: Select to rescan the original.
* When you select JPEG for Format on the scan setting screen:

The printer starts scanning and scanned data is forwarded to the shared folder of the computer.
* When you select PDF or Compact PDF for Format on the scan setting screen:

The confirmation screen asking you if you continue scanning is displayed after scanning is
complete.

e v
g
a0t
-
[ B
el =3
1

]
HI

To continue scanning, place the
next original on the document
platen and press B & .

End

If you continue scanning, load the original on the platen and start scanning.

If you do not continue scanning, select End. The scanned data is forwarded to the computer in one
PDF file.

Scanned data is forwarded to the computer according to the settings specified in Canon Quick Utility
Toolbox.
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I Scanning with a Computer Application

» Scanning with Windows

» Scanning with macOS
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I Scanning in Windows

» Scanning According to Item Type or Purpose (IJ Scan Utility)
« |J Scan Utility Features
@« Scanning Documents and Photos
« Creating/Editing PDF Files

Setting Passwords for PDF Files

Editing Password-Protected PDF Files
@ Scanning with Favorite Settings
@« Scanning Originals Larger than the Platen (Image Stitch)
Adjusting Cropping Frames in the Image Stitch Window
@ Scanning Multiple Originals at One Time
@« Extracting Text from Scanned Images (OCR)
@« Sending Scanned Images via E-mail
@« Saving after Checking Scan Results
« Starting IJ Scan Utility
« |J Scan Utility Screens
» Scanning Using Application Software (ScanGear)
» Scanning Tips
@ Positioning Originals (Scanning from Computer)
@« Network Scan Settings

IJ Network Scanner Selector EX2 Menu and Setting Screen

Scanning with WIA Driver

Resolution

Data Formats

t.

Color Matching
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3% Important

+ Available functions and settings vary depending on your scanner or printer.
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I Scanning According to Iltem Type or Purpose (IJ Scan Utility)

» |J Scan Utility Features
» Scanning Documents and Photos
» Creating/Editing PDF Files
@« Setting Passwords for PDF Files
« Editing Password-Protected PDF Files
» Scanning with Favorite Settings
» Scanning Originals Larger than the Platen (Image Stitch)
« Adjusting Cropping Frames in the Image Stitch Window
» Scanning Multiple Originals at One Time
» Sending Scanned Images via E-mail
» Extracting Text from Scanned Images (OCR)
» Saving after Checking Scan Results
» Starting IJ Scan Utility

» |J Scan Utility Screens

22 Important

 Available functions and settings vary depending on your scanner or printer.
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I IJ Scan Utility Features

Use IJ Scan Utility to scan and save documents, photos, or other items at one time by simply clicking the
corresponding icon.

32 Important

 Available functions, the displayed items, and available settings vary depending on your model.

I Multiple Scanning Modes

Auto allows for one click scanning with default settings for various items. Document will sharpen text in a
document or magazine for better readability, and Photo is best suited for scanning photos.

»>» Note

 For details on the IJ Scan Utility main screen, see |J Scan Utility Main Screen.

I Save Scanned Images Automatically
Scanned images are automatically saved to a preset folder. The folder can be changed as needed.

»>» Note

¢ The default save folders are as follows.

— Windows 11/Windows 10/Windows 8.1:

Documents folder

— Windows 7:
My Documents folder

» To change folder, see Settings Dialog Box.

I Application Integration

Scanned images can be sent to other applications. For example, display scanned images in your favorite
graphics application, attach them to e-mails, or extract text from images.
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Settings (Custom Scan)
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23> Note

» To set the applications to integrate with, see Settings Dialog Box.
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I Scanning Documents and Photos

Scan items placed on the platen with settings suitable for documents or photos.

Save documents in formats such as PDF and JPEG, and photos in formats such as JPEG and TIFF.

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. To specify the paper size, resolution, PDF settings, etc., click —| Settings..., and then
set each item in the Settings (Scanning from a Computer) dialog box.

»» Note

» Once settings are made in the Settings dialog box, the same settings can be used for scanning
from the next time.

+ In the Settings dialog box, specify image processing settings such as slant correction and outline
emphasis, set the destination of the scanned images, and more, as needed.

When setting is completed, click OK.

ad
4. Click Document or Photo in the IJ Scan Utility main screen.

Scanning starts.

»» Note

» To cancel the scan, click Cancel.
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| creating/Editing PDF Files

You can create PDF files by scanning items placed on the platen or ADF (Auto Document Feeder). Add,
delete, rearrange pages or make other edits in the created PDF files.

3% Important

* You can create or edit up to 100 pages of a PDF file at one time.

» Only PDF files created or edited in IJ Scan Utility or IJ PDF Editor are supported. PDF files created or
edited in other applications are not supported.

»» Note

* You can also create PDF files from images saved on a computer.
 Selectable file formats are PDF, JPEG, TIFF, and PNG.

+ Images whose number of pixels in the vertical or horizontal direction is 10501 or more cannot be used.
* When you select a password-protected PDF file, you must enter the password.

= Editing Password-Protected PDF Files

1. Place items on platen or ADF.

2. Start IJ Scan Utility.

3. click ™3/ ppF Editor in the 1J Scan Utility main screen.

|J PDF Editor starts.

4. To specify the paper size, resolution, and other settings, click Settings... from the File
menu, and then set each item in the Settings (Scanning from a Computer) dialog box.

> Note

» Once settings are made in the Settings dialog box, the same settings can be used for scanning
from the next time.

* In the Settings dialog box, specify image processing settings such as slant correction and outline
emphasis.

When setting is completed, click OK.

5. Click (Scan) on Toolbar.
Scanning starts.

> Note

* To open a file saved on the computer, click Open... from the File menu, and then select the file
you want to edit.

¢ You can switch the view with the Toolbar buttons. For details, see PDF Edit Screen.
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6. Add pages as needed.

When scanning and adding more items:

Place items, and then click (Scan) on the Toolbar.

When adding existing images or PDF files:

Click L+ (Add Page) on the Toolbar. After the Open dialog box appears, select the image(s) or PDF
file(s) you want to add, and then click Open.

> Note

* You can also add images or PDF files from Add Page from Saved Data... in the File menu.

7. Edit pages as needed.

When changing page order:

Click the page you want to move, and then click - (Page Up) or T (Page Down) on the Toolbar to
change the page order. You can also change the page order by dragging and dropping a page to the
target location.

When deleting pages:

»
Click the page you want to delete, and then click (Delete Page) on the Toolbar.

»» Note

* These buttons appear when two or more pages have been created.

8. Select Save As... in File menu.

The Save dialog box appears.

9. Specify save settings.

3% Important

» The following items cannot be set for images whose resolution is outside the range of 75 dpi to
600 dpi or whose number of pixels in the vertical or horizontal direction is between 10201 pixels
and 10500 pixels.

— PDF Compression

— Create a PDF file that supports keyword search

— Correct slanted text originals

— Detect the orientation of text original and rotate image

File Name
Enter a file name for the PDF file to be saved. When two or more pages have been created and you
are saving each page separately, a sequential number is appended to the file names.
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Save in
Set the folder in which to save PDF files. To change the folder, click Browse..., and then specify the
destination folder.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
created or edited PDF files in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

File Type
Select the file format for saving PDF files.

PDF
Save each page as a separate PDF file.

PDF (Multiple Pages)
Save multiple pages in one PDF file.

»» Note

» PDF (Multiple Pages) appears when two or more pages have been created.

PDF Compression
Select the compression type for saving.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving. This will reduce the load on your network and server.

32 Important

* If you save PDF files with high compression repeatedly, images may degrade.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

Correct slanted text originals
Select this checkbox to detect the document orientation based on the text in images and correct the
angle (within the range of -0.1 to -10 degrees or +0.1 to +10 degrees) for creating PDF files.

22 Important

» The following types of image may not be corrected properly since the text cannot be detected
correctly.

— Images in which the text lines are inclined more than 10 degrees or the angles vary by line
— Images containing both vertical and horizontal text

— Images with extremely large or small fonts

— Images with small amount of text

— Images containing figures/images

— Hand-written images
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Detect the orientation of text original and rotate image
Select this checkbox to detect the page orientation based on the text in images and automatically
rotate the images to the correct orientation for creating PDF files.

3% Important

 This function is available only for images (text documents) containing languages that can be
selected from Document Language in the Settings (General Settings) dialog box of IJ Scan
Utility. This function is not available depending on the language in the image.

» The page orientation of the following types of image may not be detected since the text cannot
be detected correctly.

— Images with small amount of text

— Images containing text whose font size is outside the range of 8 points to 48 points
— Images containing special fonts, effects, italics, or hand-written text

— Images with patterned backgrounds

Set up password security
Select this checkbox to display the Password Security Settings dialog box for setting a password
for opening the created PDF file or a password for printing/editing it.

32 Important

» When a password-protected PDF file is edited, the passwords will be deleted. Reset the
passwords.

= Setting Passwords for PDF Files

10. Click Save.
The PDF file is saved.

»» Note

* When a password-protected PDF file is edited, the passwords will be deleted. Reset the
passwords in the Save dialog box.

= Setting Passwords for PDF Files

iy
» To overwrite a saved file, click (Save) on the Toolbar.
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I Setting Passwords for PDF Files

Set passwords for PDF files you create in IJ Scan Utility to restrict opening, editing, and printing of the files.

The following two types of password can be set.

» Password for opening the PDF file
» Permissions password for printing or editing the PDF file

22 Important

* You will not be able to open or edit the PDF file if you forget the password. It is recommended that you
write down the passwords and keep them in a safe place for future reference.

» Password-protected PDF files cannot be opened in applications that do not support security settings for
PDF files.

» Even if a permissions password is set for a PDF file, the restricted commands (print, edit, etc.) may
differ from those in IJ Scan Utility depending on your application.

> Note

+ Setting passwords from the PDF edit screen is used as an example in the following descriptions.

1. Start IJ Scan Utility.

2. Click 3| ppF Editor in the 1J Scan Utility main screen.

IJ PDF Editor starts.
3. Open the PDF file for which you want to set password.

4. Select Save As... in File menu.

The Save dialog box appears.

5. Select Set up password security checkbox.

The Password Security Settings dialog box appears.

6. Select Require a password to open the document or Require a password to print or
edit the document checkbox, and then enter the password you want to set.

2 Important

« Enter a password of up to 32 characters using single-byte letters, numbers, and/or symbols (!"#$
%&' () +,-./:;<=>?2@[\"*_"{|}~). Passwords are case sensitive.

> Note

* To set both Document Open Password and Permissions Password, select both checkboxes
and specify a different password for each.

In each Password (Confirmation), enter the corresponding password you have set.
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7. Click OK.

Click OK to set the password(s) and return to the Save dialog box (PDF edit screen).

8. Click Save.
The PDF file is saved.
3% Important

» Even if you set password(s) and save the PDF file, the password(s) will be deleted once you edit
the file.
To reset the password(s) and save the file, select Save As... from the File menu, and then reset
the password(s).

»» Note

¥y
» To overwrite a saved file, click (Save) on the Toolbar.
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I Editing Password-Protected PDF Files

When editing a password-protected PDF file, you must enter the password.

22 Important

» Only PDF files whose password was set in IJ Scan Utility can be edited. PDF files edited in other
applications or whose password was set in other applications cannot be edited.

+ Passwords are case sensitive.

* You can create or edit up to 100 pages of a PDF file at one time.

1. Start IJ Scan Utility.

2. click ™3/ ppF Editor in the 1J Scan Utility main screen.

IJ PDF Editor starts.
3. Select Open... in File menu.

4. Select password-protected PDF file.

The Password dialog box appears.

5. Enter Permissions Password, and then click OK.

If only Document Open Password is set, enter Document Open Password.

The PDF file opens; edit as needed.
»» Note

* If both Document Open Password and Permissions Password are set, enter only Permissions
Password to open the file.

» The displayed dialog box varies depending on the type of the set password.

« If multiple files are selected, check the file name displayed in the dialog box, and then enter the
corresponding password.

22 Important

* When a password-protected PDF file is edited, the passwords will be deleted. Reset the passwords in
the Password Security Settings dialog box.

= Setting Passwords for PDF Files
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I Scanning with Favorite Settings

You can scan items placed on the platen with your favorite settings saved beforehand.

This is convenient for saving frequently used settings or when specifying scan settings in detail.

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. To specify the paper size, resolution, PDF settings, etc., click = Settings..., and then
set each item in the Settings (Scanning from a Computer) dialog box.

> Note

» Once settings are made in the Settings dialog box, the same settings can be used for scanning
from the next time.

+ In the Settings dialog box, specify image processing settings such as slant correction and outline
emphasis, set the destination of the scanned images, and more, as needed.

When setting is completed, click OK.

4. Click ! Custom in the IJ Scan Utility main screen.

Scanning starts.

»» Note

* To cancel the scan, click Cancel.
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I Scanning Originals Larger than the Platen (Image Stitch)

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. Items up to approximately twice as large as the platen are supported.

»» Note

» The following explains how to scan from the item to be placed on the left side.

1. Start |J Scan Utility.

2. To specify the item type, resolution, and PDF settings, click
each item in the Settings (Scanning from a Computer) dialog box.

»» Note

» Once settings are made in the Settings (Scan and Stitch) dialog box, the same settings can be
used for scanning from the next time.

* In the Settings (Scan and Stitch) dialog box, set image processing settings such as show-
through reduction and moire pattern reduction, set where to save the scanned images, and more,
as needed.

Settings..., and then set

When setting is completed, click OK.

=
3. Click Stitch in the IJ Scan Utility main screen.

The Image Stitch window appears.

4. In Select Output Size, select an output size according to the paper size.

Select Output Size
B4 (B5 x 2)
Scans the left and right halves of a B4 size item separately.

A3 (Ad x 2)
Scans the left and right halves of an A3 size item separately.

11 x 17 (Letter x 2)
Scans the left and right halves of an item twice as large as Letter size separately.

Full Platen x 2
Scans the left and right halves of an item twice as large as the platen separately.

»» Note

» The displayed items vary depending on the select source and view.

5. Make sure that Scan from Left is selected in Scan Direction.

6. Place the item's side that is to be displayed on the left side of the screen (1) face-down on
the platen.
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Align the upper corner of the item with the corner at the arrow (alignment mark) of the platen.

]

. Click Start Scanning Image 1.

The first item is scanned and appears in 1.

2> Note

» To cancel the scan, click Cancel.

. Rotate the item 180 degrees, and then align the lower corner of the side that is to be
displayed on the right side of the screen (2) with the corner at the arrow (alignment mark) of
the platen.

]

. Click Start Scanning Image 2.
The second item is scanned and appears in 2.

> Note

» To cancel the scan, click Cancel.

. Adjust the scanned images as required.
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( \I r
Use the N '—-I
positions.

> Note

» Select the Adjust cropping frames checkbox to specify the area to be saved.

i

e
'—I (Toolbar) to rotate or zoom in/out, or drag the images to adjust their

= Adjusting Cropping Frames in the Image Stitch Window

» To scan an item again, select the image in the Preview area or the thumbnail at the top of the
screen, then click x (
again.

Delete). The selected image is deleted, allowing you to scan the item

11. Click Save.

The combined image is saved.
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I Adjusting Cropping Frames in the Image Stitch Window

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.
In the Image Stitch window, you can specify a cropping frame on the image displayed in the Preview area.

»» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for how to adjust cropping frames with ScanGear
(scanner driver).

I Initial Cropping Frame

No cropping frame is specified. When you select the Adjust cropping frames checkbox, an active
cropping frame is automatically specified around the image in the Preview area. You can drag the
cropping frame to specify the area.

When you perform a scan, the image in the area specified with the cropping frame will be scanned.

I Adjusting a Cropping Frame

The cursor will change into = i R"ﬂ ffﬂ (Arrow) when it is positioned over a cropping frame. Click and
drag the mouse to expand or contract the cropping frame.

The cursor will change into G%D (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

I Deleting Cropping Frames

To delete the cropping frame, deselect the Adjust cropping frames checkbox.
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I Scanning Multiple Originals at One Time

You can scan two or more photos (small items) placed on the platen at one time and save each image
individually.

32 Important

* The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver), and then scan again.

— Photos with a whitish background

— Items printed on white paper, hand-written text, business cards, and other unclear items
— Thin items

— Thick items

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" for details.

» Auto does not appear depending on your model.

In the Settings dialog box, set Original Size to Auto scan and scan.

»» Note

» The screens for scanning with favorite settings are used as examples in the following descriptions.

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click = Settings...

The Settings dialog box appears.

4. Click Custom Scan in the Settings (Scanning from a Computer) Dialog Box.

5. Select Source Type according to the items to be scanned.

6. Select Auto scan for Original Size, then click OK.
The 1J Scan Utility main screen appears.

»» Note

» Once settings are made in the Settings dialog box, the same settings can be used for scanning
from the next time.

* In the Settings dialog box, specify image processing settings such as slant correction, set where
to save the scanned images, and more, as needed.

7. Click Custom in the |J Scan Utility main screen.
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Multiple items are scanned at one time.

»» Note

* To cancel the scan, click Cancel.
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I Sending Scanned Images via E-mail

You can send scanned images via e-mail easily by simply clicking E-mail in the 1J Scan Utility main screen.

22 Important

» E-mail does not appear depending on your model. If it does not appear, see If There Is No Icon for
E-Mail Scan.

»>» Note

* You can also send scanned images via e-mail from Document, Photo, Custom, or ScanGear.

1. Place the Iltem on the Platen

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click = Settings..., then set the item type, resolution, etc. in the Settings (Scanning
from a Computer) dialog box, and then select an e-mail client.

When setting is completed, click OK.

4. Click E-mail in the 1J Scan Utility main screen.

Scanning starts.

When scanning is completed, the specified e-mail client starts and the images will be attached to a new
message.

> Note

» To cancel the scan, click Cancel.

* The scanned images are saved according to the settings made in the Settings dialog box.

+ If the Check scan results and specify save settings checkbox is selected in the Settings dialog
box, the Save Settings dialog box appears. After you set the save options and click OK, the
scanned images are saved and automatically attached to a new message of the specified e-mail
client. For how to check the scan results before saving them, see Saving after Checking Scan
Results.

5. Specify the recipient, enter the subject and message, then send e-mail.

Refer to the manual of your e-mail client for e-mail settings.

I If There Is No Icon for E-Mail Scan
»>» Note

» The screens for scanning photos are used as examples in the following descriptions.
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1. Start |J Scan Utility.

2. Click = Settings...

The Settings dialog box appears.

3. Click Photo Scan in the Settings (Scanning from a Computer) Dialog Box.

4. Select Attach to e-mail in Application Settings, then select an e-mail client.

»» Note

* You can add e-mail clients to use for attachments from the pull-down menu.
+ If None (Attach Manually) is selected, manually attach scanned and saved images to e-mail.

5. Click OK.
The 1J Scan Utility main screen appears.

»» Note

« For the setting items in the Settings dialog box, see Settings (Scanning from a Computer) dialog
box.

6. Click Photo in the IJ Scan Utility main screen.

Scanning starts.

When scanning is completed, the specified e-mail client starts and the images will be attached to a
new message.

> Note

» To cancel the scan, click Cancel.

» The scanned images are saved according to the settings made in the Settings dialog box.

« If the Check scan results and specify save settings checkbox is selected in the Settings
dialog box, the Save Settings dialog box appears. After you set the save options and click OK,
the scanned images are saved and automatically attached to a new message of the specified
e-mail client. For how to check the scan results before saving them, see Saving after Checking
Scan Results.

7. Specify the recipient, enter the subject and message, then send e-mail.

Refer to the manual of your e-mail client for e-mail settings.
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I Extracting Text from Scanned Images (OCR)

Click OCR in the 1J Scan Utility main screen to scan text in scanned magazines and newspapers and
display it in a specified application.

»» Note

* You can also extract text from Document, Custom, or ScanGear.

1. Place the Item on the Platen

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click & Settings..., then set the document type, resolution, etc. in the Settings
(Scanning from a Computer) dialog box, and then select the application in which you want
to display the result.

When setting is completed, click OK.

> Note

» For Resolution, only 300 dpi or 400 dpi can be set.

+ If a compatible application is not installed, the text in the image is extracted and appears in your
text editor.
Text to be displayed is based on Document Language in the Settings (General Settings) dialog
box. Select the language you want to extract in Document Language and scan.

* You can add the application from the pull-down menu.

4. Click 2 OCR in the IJ Scan Utility main screen.

Scanning starts.

When scanning is completed, the scanned images are saved according to the settings, and the extracted
text appears in the specified application.

> Note

» To cancel the scan, click Cancel.
» Text displayed in your text editor is for guidance only. Text in the image of the following types of
documents may not be detected correctly.

— Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)

— Slanted documents

— Documents placed upside down or documents with text in the wrong orientation (rotated
characters)

— Documents containing special fonts, effects, italics, or hand-written text

— Documents with narrow line spacing

— Documents with colors in the background of text
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— Documents containing multiple languages
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I Saving after Checking Scan Results

You can check the scan results, then save the images to a computer.

22 Important

* In the following cases, you cannot check the scan results in the Save Settings dialog box before saving
them.

— When scanned with Auto scan

— When scanned from the operation panel or scanner buttons

— When scanned by selecting Canon IJ PDF Editor for Open with an application in Application
Settings

+ Available functions, the displayed items, and available settings vary depending on your model.

»» Note

» Photo scanning is used as an example in the following descriptions.

1. Start IJ Scan Utility.

2. Click = Settings...

The Settings dialog box appears.

3. Click Photo Scan in the Settings (Scanning from a Computer) Dialog Box.

4. Select Check scan results and specify save settings checkbox, and then click OK.

The IJ Scan Utility main screen appears.

»» Note

* For the setting items in the Settings dialog box, see Settings (Scanning from a Computer) dialog
box.

5. Click Photo in the IJ Scan Utility main screen.

Scanning starts.

When scanning is completed, the Save Settings dialog box appears.

»» Note

» To cancel the scan, click Cancel.

6. Change the image order or file save options as required.

You can change the image order or file save options in the Save Settings dialog box.
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x (Delete)

Deletes the image selected in the Scan Results area.

£ 3
-—I / -—I (Rotate Left 90°)/(Rotate Right 90°)

Rotates scanned images 90 degrees counter-clockwise or clockwise.

£ 3
Select the image you want to rotate, then click -—I (Rotate Left 90°) or -—I (Rotate Right 90°).

32 Important

» The buttons for handling scanned images do not appear when the Enable large image scans
checkbox is selected in the Settings (ScanGear) dialog box.

Scan More
Starts scanning again, and then adds the image to the Scan Results area.

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the
pull-down menu, then click Add in the displayed Select Destination Folder dialog box and specify

the destination folder.

The default save folders are as follows.

* Windows 11/Windows 10/Windows 8.1:

Documents folder

* Windows 7:
My Documents folder

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important
* You cannot select PDF or PDF (Multiple Pages) in the following cases.

— When scanned by clicking Photo or OCR in the IJ Scan Utility main screen
— The Enable large image scans checkbox is selected in Save Settings of the Settings

(ScanGear) dialog box
— Start OCR is selected in Application Settings of the Settings (Document Scan),
Settings (Custom Scan), or Settings (ScanGear) dialog box

* You cannot select JPEG/Exif when Color Mode is Black and White.
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2> Note
» With network connection, scanning may take longer than usual when you set TIFF or PNG in

Data Format.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important
» This appears only when JPEG/EXxif is selected in Data Format.
PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important
 This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important
 This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

1

» PDF files that are searchable in the language selected in Document Language on the
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and

save scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Save
Saves the scanned images.

Cancel
Cancels saving.

. Click OK.

Scanned images are saved according to the settings.
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I Starting IJ Scan Utility

»» Note

* If you have more than one scanner or have changed from USB to network connection, set up the
network environment from IJ Scan Utility.

= Network Scan Settings

Follow the steps below to start IJ Scan Utility. The following screenshot is from Windows 11.

um
From the Taskbar ®M (Start button), select All apps > Canon Utilities > 1J Scan Utility.

C

Canon Utliies

—
"EH 1} Printer Assistant Tool

=2, WScan Utility
] ]
[ - -

IJ Scan Utility starts.
3> Note

¢ Windows 10:

From the Taskbar E (Start button), select Canon Utilities > IJ Scan Utility.

* Windows 8.1:
Select IJ Scan Utility on the Start screen.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, and then search for "IJ
Scan Utility".

 Windows 7:

From Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility.
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I IJ Scan Utility Screens

» |J Scan Utility Main Screen

» Settings Dialog Box
@« Settings (Scanning from a Computer) Dialog Box
@« Settings (Scanning from the Operation Panel) Dialog Box
« Settings (General Settings) Dialog Box

» PDF Edit Screen
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I IJ Scan Utility Main Screen

You can complete from scanning to saving at one time by simply clicking the corresponding icon.

22 Important

» The displayed items vary depending on your model.

Settings...
Displays the Settings dialog box in which you can specify the scan/save settings and the response after
scanning.

Scanner
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.
In addition, for network connection, select one with "Network" after the product name.

»» Note

» Refer to "Network Scan Settings" for how to set up a network environment.

« (Help)
Opens this guide.

|

Auto
Detects the item type automatically and saves them to a computer. The data format for saving will also
be set automatically.

Ad
Document
Scans items as documents and saves them to a computer.

Doc (Duplex)
Scans both sides of each document at one time and saves them to a computer.

Photo
Scans items as photos and saves them to a computer.

Custom
Scans items with your favorite settings and saves the images to a computer. The item type can be
automatically detected.

E-mail
You can send scanned images via e-mail.

'-') OCR
Scan text in scanned magazines and newspapers and display it in a specified application.
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Eﬂ Stitch

Displays the Image Stitch window in which you can scan the left and right halves of an item larger than
the platen and combine the scanned images back into one image.

b

~~ ScanGear
Starts ScanGear (scanner driver) in which you can make image corrections and color adjustments when
scanning.

I£I PDF Editor

Displays the PDF edit screen for creating or editing PDF files.
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I Settings Dialog Box

22 Important

+ Available functions, the displayed items, and available settings vary depending on your model.

The Settings dialog has the following three tabs.

-

(Scanning from a Computer) Tab

+ - (Scanning from the Operation Panel) Tab

| &
. I“ (General Settings) Tab

Click to open the corresponding tab and set the details of each function as needed.

4 (Scanning from a Computer) Tab

Set the default actions when scanning from IJ Scan Utility or IJ PDF Editor.

= Settings (Scanning from a Computer) Dialog Box

I 4 (Scanning from the Operation Panel) Tab

Set the default actions when scanning from the operation panel.

= Settings (Scanning from the Operation Panel) Dialog Box

32 Important

* When the Settings dialog box is displayed from |J PDF Editor, the -# (Scanning from the Operation
Panel) tab does not appear.

| 8
10) (General Settings) Tab

Set the model to use, file size restriction on e-mail attachment, language for detecting text in images, and
the folder in which to save images temporarily.

= Settings (General Settings) Dialog Box
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I Settings (General Settings) Dialog Box

| &
Click the I “ (General Settings) tab to display the Settings (General Settings) dialog box.

In the Settings (General Settings) dialog box, you can set the product to use, file size restriction on e-mail
attachment, language to detect text in images, and folder in which to save images temporarily.

3% Important
» The displayed items vary depending on your model.
* When the Settings dialog box is displayed from |J PDF Editor, only Product Name appears.
Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.
If the displayed product is not the one you want to use, select the desired product from the list.

In addition, for network connection, select one with "Network™ after the product name.

»» Note

» With network connection, Select appears on the right side of the product name. Click Select to
display IJ Network Scanner Selector EX from which you can change the scanner to use. Refer to
"Network Scan Settings" for the setting procedure.

E-mail Attachment Size
You can restrict the size of scanned images to be attached to an e-mail.
You can select Small (Suitable for 640 x 480 Screen Resolution), Medium (Suitable for 800 x 600
Screen Resolution), Large (Suitable for 1024 x 768 Screen Resolution), or No Change.

Document Language

You can select the language for detecting text in images and for use with search when a PDF file that
supports keyword search is created.

Folder to Save Temporary Files

Displays the folder in which to temporarily save images scanned with 1J Scan Utility or IJ PDF Editor.
Click Browse... to specify the destination folder.

22 Important
* If you change the Folder to Save Temporary Files while IJ PDF Editor is running, files will be
saved to the previous folder. The change will be reflected after restarting IJ PDF Editor.
Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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I Settings (Scanning from a Computer) Dialog Box

Click the item you want to scan on the “® (Scanning from a Computer) tab to switch to the
corresponding settings.

In the Settings (Scanning from a Computer) dialog box, you can set the default actions when scanning from
IJ Scan Utility or IJ PDF Editor.

22 Important
* The displayed items vary depending on your model, the item you want to scan, or settings.
»» Note
» The following screen is displayed when Auto Scan is selected.
Settings [futo Scan]
]
E’ @ Hﬁ
= [t mzomirerade mage corechon A
‘| Duecurmeent Sosn
Save et B
._;; P — Fiiz Marme: MG 1
Save i %] Documents -
"Tu:? Cusstom Sean Dt Format: Autn w
— JPEG Inags Quskby: 5 baraiand w
=y oo
—Ib POF Compr ession: 5 baradard -
‘iil Semn and SHich A create a PO fie St supports keyword search
. - D 5ave toa subfolder wth curment dabe
e SonGes
= Agpbcaton Sebtng
(%) Dpen weh an applcation: ‘1 Vindoss Explorer r c
(21 5end b an appication! Preview
(Z15and bo s folders & OreDre
(D1 autach o emads Hone (Attach Marually)
("100 not skart an appboaton
Mare Functios
s T — —

= A: Scan Options Area
= B: Save Settings Area
= C: Application Settings Area

I A: Scan Options Area

Apply recommended image correction
Applies suitable corrections automatically based on the item type.
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3% Important

» The color tone may differ from the source image due to corrections. In that case, deselect the
checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Source Type
Select the type of item to be scanned.

» Automatically detecting the item: Auto

» Scanning documents: Document or Document (ADF/Platen)

» Scanning documents from the ADF (Auto Document Feeder): Document (ADF Simplex),
Document (ADF Manual Duplex), Document (ADF Duplex), or Document (ADF/Platen)

» Scanning magazines: Magazine

» Scanning photos: Photo

22 Important

+ |tem types supported by Auto: photos, postcards, business cards, magazines, newspapers,
documents, BD/DVD/CD.

» To scan the following types of items, specify the item type or size. You cannot scan correctly with
Auto.

— A4 size photos

— Text documents smaller than 2L (5 x 7 inches) (127 x 178 mm), such as paperback pages
with the spine cut off

— Items printed on thin white paper

— Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.
* Place items correctly according to the type of item to be scanned. Otherwise, items may not be
scanned correctly.

Refer to "Positioning Originals (Scanning from Computer)" for how to place items.

* When scanning two or more documents from the ADF, place documents of the same size even if
Auto is set.

»» Note

» To convert text in the image into text data after scanning, specify Source Type instead of
selecting Auto.

» To reduce moire, set Source Type to Magazine or select the Reduce moire checkbox in Image
Processing Settings.

 Select Auto to set Color Mode, Original Size, and Resolution automatically.

* When Document (ADF/Platen) is selected and documents are placed both on the platen and
ADF, those placed on the ADF will be scanned.

* To scan both sides of each document at one time, select Document (ADF/Platen), and then
select the Scan both sides when scanning from the ADF checkbox.

Color Mode
Select the color mode in which to scan the item.
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Original Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

»>» Note
* Click Defaults to restore the specified settings to the default settings.
Resolution
Select the resolution of the item to be scanned.
The higher the resolution (value), the more detail in your image.
= Resolution

Original Scan Orientation Settings...
This appears when you select ADF for Source Type.

Click to display the Original Scan Orientation Settings dialog box in which you can set the
orientation and binding side of the documents to be scanned from the ADF.

22 Important

» Binding Side cannot be specified when scanning only the front side of each document.

Scan both sides when scanning from the ADF
This appears when you select Document (ADF/Platen) or Auto for Source Type. Scans both sides
of the documents placed on the ADF.

Documents are scanned in the long-edge binding format, with the end inserted to the ADF being the
upper end. The scanned documents are output in the back-to-front order.

Image Processing Settings

+

Click (Plus) to set the following.

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

32 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.
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Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots
are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Correct gutter shadow/Correct gutter shadow (platen)
Reduces gutter shadows that appear between pages when scanning open booklets.

32 Important

« This function is available only when scanning from the platen.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for details.

* When you enable this function, scanning may take longer than usual with network
connection.

Correct slanted text originals
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

3» Important

» The following types of documents may not be corrected properly since the text cannot be
detected correctly.

— Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

— Documents containing both vertical and horizontal text

— Documents with extremely large or small fonts

— Documents with small amount of text

— Documents containing figures/images

— Hand-written text

— Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text originals.

273



Detect the orientation of text original and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

32 Important

* Only text documents written in the language selected from Document Language in the
Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

— Resolution is outside the range of 300 dpi to 600 dpi

— Font size is outside the range of 8 points to 48 points

— Documents containing special fonts, effects, italics, or hand-written text
— Documents with patterned backgrounds

In that case, select the Check scan results and specify save settings checkbox, and then
rotate the image in the Save Settings dialog box.

I B: Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

3> Note
» When you select the Save to a subfolder with current date checkbox, the date and four digits

are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the
pull-down menu, then click Add in the displayed Select Destination Folder dialog box and specify
the destination folder.

The default save folders are as follows.

* Windows 11/Windows 10/Windows 8.1:

Documents folder

* Windows 7:
My Documents folder

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, PDF (Multiple Pages), or Auto.
3> Note

* When Auto is selected and the items are placed correctly, the scanned images are automatically
saved in the following data formats.

— Photos, postcards, BD/DVD/CD, and business cards: JPEG
— Magazines, newspapers, and documents: PDF
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Refer to "Positioning Originals (Scanning from Computer)" for how to place items.

+ With network connection, scanning may take longer than usual when you set TIFF or PNG in
Data Format.

* When PDF or PDF (Multiple Pages) is selected in ScanGear, images up to 9600 pixels x 9600
pixels can be scanned.

JPEG Image Quality
You can specify the image quality of JPEG files.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.
Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»>» Note

« If text cannot be searched correctly, we recommend that you select 300 dpi or higher for
Resolution.

i

» PDF files that are searchable in the language selected in Document Language on the
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and
save scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Enable large image scans
Select this checkbox to scan images up to 21000 pixels x 30000 pixels and 1.8 GB.

»» Note

* When this checkbox is not selected, images up to 10208 pixels x 14032 pixels can be scanned.

Check scan results and specify save settings
Displays the Save Settings dialog box after scanning.

I C: Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.
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Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.
OCR Application
Displays the extracted text in a specified application.
3> Note

» To add an application to the pull-down menu, select Add... from the pull-down menu, then click
Add in the displayed Select Application dialog box and specify the application.

Do not start an application
Saves to the folder specified in Save in.

»» Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu,
then click Add in the displayed Select Application or Select Destination Folder dialog box and
specify the application or folder.

E-mail Client
Specify the e-mail client to use for attaching scanned images.

»» Note

* To add an e-mail client to the pull-down menu, select Add... from the pull-down menu, then click
Add in the displayed Select Application dialog box and specify the e-mail client.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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I Settings (Scanning from the Operation Panel) Dialog Box

Click the item you want to scan on the ¥ (Scanning from the Operation Panel) tab to switch to the
corresponding settings.

In the Settings (Scanning from the Operation Panel) dialog box, you can set the default actions when

scanning from the operation panel.

32 Important

» The displayed items vary depending on your model, the item you want to scan, or settings.

»» Note

* The following screen is displayed when Save to Computer (Auto) is selected.
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= A: Scan Options Area
= B: Save Settings Area
= C: Application Settings Area

I A: Scan Options Area

Original Size
Set from the operation panel.

Resolution
Set from the operation panel.
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Image Processing Settings

Click . * (Plus) to set the following.

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

3» Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Correct gutter shadow (platen)/Correct gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

22 Important

+ This function is available only when scanning from the platen.

»» Note

* When you enable this function, scanning may take longer than usual with network
connection.

Correct slanted text originals
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

» The following types of documents may not be corrected properly since the text cannot be
detected correctly.

— Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

— Documents containing both vertical and horizontal text

— Documents with extremely large or small fonts

— Documents with small amount of text

— Documents containing figures/images

— Hand-written text

— Documents containing both vertical and horizontal lines (tables)
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»» Note

» Scanning takes longer than usual when you enable Correct slanted text originals.

Detect the orientation of text original and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

3» Important

» Only text documents written in languages that can be selected from Document Language
in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

— Resolution is outside the range of 300 dpi to 600 dpi

— Font size is outside the range of 8 points to 48 points

— Documents containing special fonts, effects, italics, or hand-written text
— Documents with patterned backgrounds

I B: Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the
pull-down menu, then click Add in the displayed Select Destination Folder dialog box and specify
the destination folder.

The default save folders are as follows.

* Windows 11/Windows 10/Windows 8.1:

Documents folder

* Windows 7:
My Documents folder

Data Format
Set from the operation panel.

»» Note

* When Auto is selected and the items are placed correctly, the scanned images are automatically
saved in the following data formats.

— Photos, postcards, BD/DVD/CD, and business cards: JPEG
— Magazines, newspapers, and documents: PDF
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Refer to "Positioning Originals (Scanning from Computer)" for how to place items.

JPEG Image Quality
You can specify the image quality of JPEG files.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»>» Note
|

8
» PDF files that are searchable in the language selected in Document Language on the i “
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and
save scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

I C: Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Do not start an application
Saves to the folder specified in Save in.
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»» Note

* To add an application or folder to the pull-down menu, select Add... from the pull-down menu,
then click Add in the displayed Select Application or Select Destination Folder dialog box and
specify the application or folder.

E-mail Client
Specify the e-mail client to use for attaching scanned images.
You can specify the e-mail client you want to start from the pull-down menu.

»» Note

» To add an e-mail client to the pull-down menu, select Add... from the pull-down menu, then click
Add in the displayed Select Application dialog box and specify the e-mail client.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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| PDF Edit Screen

You can create PDF files by scanning items placed on the platen or ADF (Auto Document Feeder). Add,
delete, rearrange pages, or make other edits in the created PDF files.

Open IJ PDF Editor, an application for creating/printing PDF files, by one of the following operations.

 Click PDF Editor in the |J Scan Utility main screen

» Select Canon IJ PDF Editor for Open with an application in the Settings (Scanning from a Computer)
dialog box, and then scan by clicking Document in the |J Scan Utility main screen.

T Canan U POF Editor - [IMG ]
File Edrt WView Send Help

SERHEEEIH

|4

-

W

| Selected pages: 1

Tatal pages: 3

= A: Toolbar
= B: Thumbnails Area

I A: Toolbar

i 4
(Save)

Overwrites the displayed PDF file. An existing PDF file can be overwritten once it is edited.

»>» Note

* You can also name and save the PDF file in the Save dialog box (PDF edit screen) by selecting
Save As... in the File menu.

L (Scan)
Starts scanning.

éil‘ﬁ (Settings)

Displays the Settings dialog box of IJ Scan Utility for specifying how to respond when scanning.
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+ (Add Page)
Displays the Open dialog box; select the image or PDF file you want to add, and then click Open to
add a page to the end.

»
(Delete Page)
Deletes the selected page(s).

(Move Up)
Moves the selected page up one page.

T (Move Down)
Moves the selected page down one page.

.
(Rotate Left 90°)

Rotates the selected page 90 degrees counter-clockwise.

3
(Rotate Right 90°)

Rotates the selected page 90 degrees clockwise.

(Page View)
Switches to Page view and displays the page thumbnails and a preview image.

(Thumbnail View)
Switches to Thumbnail view and displays a list of thumbnails of all pages in the PDF file.

+

(Previous Page)
Displays the page immediately before the displayed page.

- (Next Page)
Displays the page immediately after the displayed page.
T 2 -
(Specified Page)
Enter a page number to display the specified page.

(Reduce)
Reduces the display size of the preview image displayed in Page view.

(Enlarge)
Enlarges the display size of the preview image displayed in Page view.

=+ 7 (Send)
Open in PDF Viewer
Open the saved PDF file in a PDF viewer.

Display Save Location
Displays the folder in which the PDF file is saved.

(Instructions)
Opens this guide.
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| B: Thumbnails Area

Displays the thumbnails of pages.
Change the page order via drag-and-drop.

From the Toolbar, switch between Page view and Thumbnail view.

> Note

* The following operations are available from the Edit menu.
— Undo
Undoes the last operation.
— Select All
Selects all the pages displayed in the Thumbnails area.
— Select Odd Pages
Selects odd-numbered pages displayed in the Thumbnails area.
— Select Even Pages

Selects even-numbered pages displayed in the Thumbnails area.

Page view:

The preview of the thumbnail selected on the left side appears on the right side.

i Canan I POF Editar - [IMG | - O ¥
File Edit View 5end Help
FER BRI MEe>» ' 2|QQ 0|7
IMG - x| =
]
- -
2
]
e _— .
Selected pages: 1 Total pages: 2

Thumbnail view:

Thumbnails appear in the page order from the top left.
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I Scanning Using Application Software (ScanGear)

» What Is ScanGear (Scanner Driver)?

» Starting ScanGear (Scanner Driver)

» Scanning in Basic Mode

» ScanGear (Scanner Driver) Screens

» General Notes (Scanner Driver)

» Scanning in Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
» Correcting Images and Adjusting Colors with ScanGear (Scanner Driver)

» Positioning Originals (Scanning from Computer)

L4

Adjusting Cropping Frames (ScanGear)

L4

Updating the ScanGear (Scanner Driver)

22 Important

+ Available functions and settings vary depending on your scanner or printer.
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I What Is ScanGear (Scanner Driver)?

ScanGear (scanner driver) is software required for scanning documents. Use the software to specify the
output size, image corrections, and other settings.

ScanGear can be started from IJ Scan Utility or applications that are compatible with the standard TWAIN
interface. (ScanGear is a TWAIN-compatible driver.)
I Features

Specify the document type, output size, and other settings when scanning documents and preview scan
results. Make various correction settings or finely adjust the brightness, contrast, and other parameters to
scan in a specific color tone.

I Screens

There are two modes: Basic Mode and Advanced Mode.

Switch modes with the tabs on the upper right of the screen.
Basic Mode

222 Note

» ScanGear starts in the last used mode.
» Settings are not retained when you switch modes.

Basic Mode

Use the Basic Mode tab to scan easily by following three simple on-screen steps ( o 9 and

0,
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Advanced Mode

Use the Advanced Mode tab to scan by specifying the color mode, output resolution, image brightness,
color tone, and other settings.
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I Starting ScanGear (Scanner Driver)

Use ScanGear (scanner driver) to make image corrections and color adjustments when scanning. Start
ScanGear from IJ Scan Utility or other applications.

»» Note

+ If you have more than one scanner or have a network compatible model and changed the connection
from USB connection to network connection, set up the network environment.

I Starting from IJ Scan Utility

1. Start IJ Scan Utility.

For how to start it, see Starting IJ Scan Utility.

2. In IJ Scan Utility main screen, click ScanGear.

The ScanGear screen appears.

I Starting from Application

The procedure varies depending on the application. For details, see the application's manual.

1. Start application.

2. On application's menu, select machine.

> Note

* A machine connected over a network, will have "Network" displayed after the product name.

3. Scan document.

The ScanGear screen appears.
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I Scanning in Basic Mode

Use the Basic Mode tab to scan easily by following these simple on-screen steps.

To scan multiple documents at one time from the Platen, see Scanning Multiple Documents at One Time
with ScanGear (Scanner Driver).

When scanning from the ADF (Auto Document Feeder), preview is not available.

=% Important

* The following types of documents may not be scanned correctly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

— Photos with a whitish background

— Documents printed on white paper, hand-written text, business cards, and other unclear documents
Thin documents

— Thick documents

* The following types of documents cannot be scanned correctly.

— Documents smaller than 1.2 inches (3 cm) square
— Photos that have been cut to irregular shapes

23 Note

» Both sides of a two sided document can be scanned simultaneously on models with ADF duplex
scanning support.

1. Place document on machine's Platen or ADF, and then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source to match your document.
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22 Important

» Some applications do not support continuous scanning from the ADF. For details, see the
application's manual.

22> Note

» To scan magazines containing many color photos, select Magazine (Color).

3. Click Preview.

Preview image appears in the Preview area.
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2% Important

* Preview is not available when scanning from the ADF.

17%%» Note

» Colors are adjusted based on the document type selected in Select Source.

4. Set Destination.

27> Note
» Skip ahead to Step 7 if an ADF option is selected in Select Source.

5. Set Output Size.

Output size options vary with the selected Destination.

6. Adjust cropping frames (scan areas) as needed.
Adjust the size and position of the cropping frames on the preview image.

= Adjusting Cropping Frames (ScanGear)
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7. Set Image corrections as needed.

8. Click Scan.
Scanning starts.

»» Note

* Click "-‘ (Information) to display a dialog box showing the document type and other details of the

current scan settings.
* How ScanGear behaves after scanning is complete can be set from Status of ScanGear dialog after

scanning on the Scan tab of the Preferences dialog box.

I Related Topic

= Basic Mode Tab
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I ScanGear (Scanner Driver) Screens

» Basic Mode Tab
*» Advanced Mode Tab

» Preferences Dialog Box

293



I Basic Mode Tab

Use the Basic Mode tab to scan easily by following these simple on-screen steps.

This section describes the settings and functions available on the Basic Mode tab.
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= (1) Settings and Operation Buttons

= (2) Toolbar
= (3) Preview Area

23 Note

* The displayed items vary by document type and view.
* Preview is not available when scanning from the ADF (Auto Document Feeder).

I (1) Settings and Operation Buttons

Select Source
Photo (Color)
Scan color photos.

Magazine (Color)
Scan color magazines.

Document (Color)
Scan documents in color.

Document (Grayscale)
Scan documents in black and white.

Document (Color) ADF Simplex
Scan documents from the ADF in color.

Document (Grayscale) ADF Simplex
Scan documents from the ADF in black and white.
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Document (Color) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in color.

Document (Grayscale) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in black and white.

22 Important

» Some applications do not support continuous scanning from the ADF. For details, see the
application's manual.

»>» Note

* When you select a document type, the unsharp mask function will be active.

* When you select an option other than the ADF types, the image adjustment function which
adjusts images based on the document type will also be active.

* When you select Magazine (Color), the descreen function will be active.

Display Preview Image
Preview
Performs a trial scan.
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»» Note

* When using the machine for the first time, scanner calibration starts automatically. Wait a
while until the preview image appears.

Destination
Select what you want to do with the scanned image.

Print
Select this to print the scanned image on a printer.

Image display
Select this to view the scanned image on a monitor.

OCR
Select this to use the scanned image with OCR software.
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"OCR software" is software that converts text scanned as an image into text data that can be
edited in word processors and other programs.

Output Size
Select an output size.

Output size options vary by the item selected in Destination.

Flexible
Adjust the cropping frames (scan areas) freely.

In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is
displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

Paper Size (such as L or A4)
Select an output paper size. The portion within the cropping frame will be scanned at the size
of the selected paper size. Drag the cropping frame to enlarge/reduce it while maintaining the
aspect ratio.

Monitor Size (such as 1024 x 768 pixels)
Select an output size in pixels. A cropping frame of the selected monitor size will appear and the
portion within the cropping frame will be scanned. Drag the cropping frame to enlarge/reduce it
while maintaining the aspect ratio.

Add/Delete...
Displays the Add/Delete the Output Size dialog box for specifying custom output sizes. This
option can be selected when Destination is Print or Image display.

Acd/Delete the Output Size
Dutpet Sire Hame « Cutput Sine List =
P Satting [
Width ; 6,00
Heght: | 4.00
Unt 3 nches v

In the Add/Delete the Output Size dialog box, multiple output sizes can be specified and then
saved at one time. Saved items will be registered to the Output Size list and can be selected,
along with the predefined items.

Adding:

Enter Output Size Name, Width, and Height, and then click Add. For Unit, select inches or
mm if Destination is Print; if it is Image display, only pixels can be selected. The name of the
added size appears in Output Size List. Click Save to save the items listed in Output Size List.
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Deleting:

Select the output size you want to delete in Output Size List, and then click Delete. Click Save
to save the items listed in Output Size List.

32 Important

» Predefined output sizes such as A4 and 1024 x 768 pixels cannot be deleted.

»» Note

» Save up to 10 items.

* An error message appears when you enter a value outside the setting range. Enter a value
within the setting range.

»» Note

 For details on whether or how the cropping frame initially appears on a preview image, see
Cropping Frame on Previewed Images in Preview tab of Preferences Dialog Box.

““ Invert aspect ratio
Available when Output Size is set to anything but Flexible.
Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Adjust cropping frames
Adjust the scan area within the Preview area.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the cropping frame will be scanned.

= Adjusting Cropping Frames (ScanGear)

Image corrections
Correct the image to be scanned.

32 Important
» Apply Auto Document Fix and Correct fading are available when Recommended is selected
on the Color Settings tab of the Preferences dialog box.
3> Note
+ Available functions vary by the document type selected in Select Source.
Apply Auto Document Fix
Sharpens text in a document or magazine for better readability.

32 Important

+ Scanning may take longer than usual when this checkbox is selected.

» The color tone may change from the source image due to corrections. In that case, deselect
the checkbox and scan.

» Correction may not be applied properly if the scan area is too small.

Correct fading
Corrects photos that have faded with time or have a colorcast.
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Correct gutter shadow
Corrects shadows that appear between pages when scanning open booklets.

22 Important

* Be sure to see Gutter Shadow Correction for precautions and other information on using
this function.

Color Pattern...
Adjust the image's overall color. Correct colors that have faded due to colorcast or other reasons
and reproduce natural colors while previewing color changes.

= Adjusting Colors Using a Color Pattern

22 Important

 This setting is not available when Color Matching is selected on the Color Settings tab of
the Preferences dialog box.

Scan Image
Scan
Starts scanning.

»» Note

* When scanning starts, the progress appears. To cancel the scan, click Cancel.

Preferences...

Displays the Preferences dialog box for making scan/preview settings.

Close
Closes ScanGear (scanner driver).

| @ Toolbar

Adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:

In whole image view:

- ;]‘ il :E: e d U/

——

-— [ |
lﬂ] (Thumbnail) / - (Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

c
= (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

* The result will be reflected in the scanned image.
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* The image returns to its original state when you preview again.

3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

u _“i
)'!L (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KR
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the images in thumbnail view.

oo
LI (Uncheck All Frames)

Available when two or more frames are displayed.

Deselects the checkboxes of the images in thumbnail view.

B&
EJE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

-------- (Select All Cropping Frames)

Available when two or more cropping frames are specified.
Turns the cropping frames into thick broken lines and applies the settings to all of them.

X

(Remove Cropping Frame)
Removes the selected cropping frame.

"-‘ (Information)
Displays the version of ScanGear, along with the document type and other details of the current scan
settings.

/

< (Open Guide)
Opens this page.

I (3) Preview Area

This is where a trial image appears after you click Preview. The results of image corrections, color
adjustments, and other settings made in (1) Settings and Operation Buttons are also reflected.
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When @ (Thumbnail) is displayed on Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images
appear. Only the images with the checkbox selected will be scanned.

13» Note

* When multiple images are previewed, different outlines indicate different selection status.

— Focus Frame (thick blue outline): The displayed settings will be applied.

— Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. To select multiple images, click them while pressing the Ctrl key.

— Unselected (no outline): The settings will not be applied.

» Double-click a frame to enlarge the image. Click E E (Frame Advance) at the bottom of the
screen to display the previous or next frame. Double-click the enlarged frame again to return it to its
original state.

=
When ‘JJ (Whole Image) is displayed on Toolbar:

Iltems on the Platen are scanned and appear as a single image. All portions in the cropping frames will be
scanned.
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> Note

* Create cropping frame(s) on the displayed image. In thumbnail view, one cropping frame can be
created per image. In whole image view, multiple cropping frames can be created.

= Adjusting Cropping Frames (ScanGear)

I Related Topic

= Scanning in Basic Mode
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I Advanced Mode Tab

This mode allows you to make advanced scan settings such as the color mode, output resolution, image
brightness, and color tone.

This section describes the settings and functions available on the Advanced Mode tab.
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= (1) Settings and Operation Buttons

= (2) Toolbar
= (3) Preview Area

= 3% Important

» The displayed items vary depending on your model, document type, and view.
» The preview function is not available when scanning from the ADF (Auto Document Feeder).

I (1) Settings and Operation Buttons

Favorite Settings
You can name and save a group of settings (Input Settings, Output Settings, Image Settings, and
Color Adjustment Buttons) on the Advanced Mode tab, and load it as required. It is convenient to
save a group of settings if you will be using it repeatedly. You can also use this to reload the default
settings.

Select Add/Delete... from the pull-down menu to open the Add/Delete Favorite Settings dialog box.
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Add/Delete Favorite Settings
Seating Marse 2 Farvoeiie Settings List &
Mew Besting [
add =
Cancel

Enter Setting Name and click Add; the name appears in Favorite Settings List.

When you click Save, the item appears in the Favorite Settings list and can be selected, along with
the predefined items.

To delete an item, select it in Favorite Settings List and click Delete. Click Save to save the settings
displayed in Favorite Settings List.

»>» Note

* You can set Add/Delete... in Favorite Settings after preview.
» Save up to 10 items.

Input Settings
Specify the input settings such as the document type and size.

Output Settings
Specify the output settings such as the output resolution and size.

Image Settings
Enable/disable various image correction functions.

Color Adjustment Buttons
Fine corrections to the image brightness and color tones can be made including adjustments to the
image's overall brightness or contrast and adjustments to its highlight and shadow values (histogram)
or balance (tone curve).

Zoom
Zooms in on a frame, or zooms in on the image in the area specified with a cropping frame
(scan area). When zoomed in, Zoom changes to Undo. Click Undo to return the display to its
non-magnified state.
In thumbnail view:

When multiple images are displayed in thumbnail view, clicking this button zooms in on the selected

frame. Click W8l &d (Frame Advance) at the bottom of the screen to display the previous or next
frame.

»» Note

* You can also zoom in on an image by double-clicking the frame. Double-click the enlarged frame
again to return it to its original state.

In whole image view:

Rescans the image in the area specified with a cropping frame at higher magnification.
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»» Note

» Zoom rescans the document and displays high-resolution image in Preview.

- N (Enlarge/Reduce) on the Toolbar zooms in on the preview image quickly. However, the
resolution of the displayed image will be low.

Preview
Performs a trial scan.
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Scan
Starts scanning.

»» Note

» When scanning starts, the progress appears. To cancel the scan, click Cancel.

* When scanning is completed, a dialog box prompting you to select the next action may appear.
Follow the prompt to complete. For details, see Status of ScanGear dialog after scanning in
Scan tab of Preferences dialog box.

+ It will take time to process the images if the total size of the scanned images exceeds a certain

size. In that case, a warning message appears; it is recommended that you reduce the total size.
To continue, scan in whole image view.

Preferences...
Displays the Preferences dialog box for making scan/preview settings.

Close
Closes ScanGear (scanner driver).

I (2) Toolbar

Adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.
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In thumbnail view:
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5] (Thumbnait) / | Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

— (Clear)
Deletes the preview image from the Preview area.

It also resets the Toolbar and color adjustment settings.

- (Crop)
Allows you to specify the scan area by dragging the mouse.

(Move Image)

Allows you to drag the image until the part you want to see is displayed when an image enlarged in
the Preview area does not fit in the screen. You can also move the image using the scroll bars.

N (Enlarge/Reduce)
Allows you to zoom in on the Preview area by clicking the image. Right-click the image to zoom out.

c
= (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

* The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

b1 _“i
ﬂd& (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KR
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the images in thumbnail view.
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oo
0o (Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the images in thumbnail view.

BE
EE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

nim (Select All Cropping Frames)
Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

X

(Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)
Displays the version of ScanGear, along with the document type and other details of the current scan
settings.
24 _
= (Open Guide)
Opens this page.

I (3) Preview Area

This is where a trial image appears after you click Preview. The results of image corrections, color
adjustments, and other settings made in (1) Settings and Operation Buttons are also reflected.

When lﬂ (Thumbnail) is displayed on Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images
appear. Only the images with the checkbox selected will be scanned.
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> Note

* When multiple images are previewed, different outlines indicate different selection status.

— Focus Frame (thick blue outline): The displayed settings will be applied.

— Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. To select multiple images, click them while pressing the Ctrl key.

— Unselected (no outline): The settings will not be applied.

=
When (Whole Image) is displayed on Toolbar:

Iltems on the Platen are scanned and appear as a single image. All portions in the cropping frames will be
scanned.

»>» Note

 Create cropping frame(s) on the displayed image. In thumbnail view, one cropping frame can be
created per image. In whole image view, multiple cropping frames can be created.

= Adjusting Cropping Frames (ScanGear)

I Related Topic

= Scanning in Advanced Mode
= Scanning Multiple Documents from the ADF (Auto Document Feeder) in Advanced Mode
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I Input Settings
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Input Settings allows you to set the following items:
22 Important
* Available functions and settings vary depending on your scanner or printer.

Select Source

The type of document to be scanned is displayed. To scan from the Platen, select Platen; to scan from
the ADF (Auto Document Feeder), select Document (ADF Simplex) or Document (ADF Duplex).

22 Important
» Some applications do not support continuous scanning from the ADF. For details, see the
application's manual.
2> Note
* You can select Document (ADF Duplex) when using a model supporting ADF duplex scanning.
Original Size

Select the size of the document to be scanned. This setting is available in whole image view only.
When you select a size, the Preview area size changes accordingly.

22 Important

» Some applications have a limit to the amount of scan data they can receive. Available scan range
is as follows.

— 21000 pixels x 30000 pixels or less (and 1.8 GB or less in data size)

+ If you change Original Size after previewing, the preview image will be deleted.
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»>» Note
« If you are not sure which size you should select for Original Size, set Original Size to Full Platen,

then measure the size of the document and enter the values into ‘0 (Width) and = (Height).

Original Orientation

Set the orientation and stapling side of the documents to scan from the ADF.

Click Settings... to open the Orientation dialog box.
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32 Important

» The Orientation dialog box can only be opened when Select Source is Document (ADF
Simplex) or Document (ADF Duplex).

* Binding Location is displayed when using a model supporting ADF duplex scanning.
» Binding Location cannot be specified when Select Source is Document (ADF Simplex).

Color Mode
Select how to scan the document.
Color

Select this mode to scan color documents or to create color images. This mode renders the image
in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Color (48bit)

Select this mode to scan color photos. This mode renders the image in 65536 levels (16 bit) of
R(ed), G(reen), and B(lue).

22 Important

» Some applications cannot display images scanned in Color (48bit).

» Color (48bit) is displayed only when the Enable 48/16 bit output checkbox is selected on the
Scan tab of the Preferences dialog box.

Grayscale

Select this mode to scan black and white photos or to create black and white images. This mode
renders the image in 256 levels (8 bit) of black and white.
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Black and White
Select this mode to scan photos and documents in black and white. This mode renders the image
in black and white. The contrast in the image is divided at certain levels (threshold level) into black

A

and white and is rendered in two colors. The threshold level can be set with (Threshold).

Input Size
In thumbnail view, the cropped document size is displayed after preview.

In whole image view, the Original Size is displayed before preview, and the cropping frame (scan area)
size is displayed after preview.

You can adjust the cropping frame size by entering the values into = (Width) and H (Height).

Click g (Change Aspect Ratio) and change it to g (Keep Aspect Ratio) to maintain the aspect ratio
when you specify the cropping frame size.

32 Important

* Input size settings are available only when Output Size in Output Settings is Flexible. If you
select a size other than Flexible, a cropping frame calculated from Output Size and Output
Resolution is displayed, and its aspect ratio is fixed.

»» Note

» The values you can enter will be within the range of the selected document size. The minimum size
is 96 pixels x 96 pixels when Output Resolution is 600 dpi, scaled at 100 %.

* When Auto Crop is performed in whole image view, the aspect ratio will not be maintained since
the size will be prioritized.

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
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I Output Settings

Output Settings allows you to set the following items:

Output Resolution
Select the resolution to scan at.

The higher the resolution (value), the more detail in your image.

Select a resolution from the options displayed by clicking the button, or enter a value within the range of
25 dpi to 19200 dpi (in 1 dpi increments).

For details on the resolution, see Resolution.

When Select Source is Platen:

You can enter a value within the range of 25 dpi to 19200 dpi.

When Select Source is Document (ADF Simplex) or Document (ADF Duplex):

You can enter a value within the range of 25 dpi to 600 dpi.

»» Note

* When preview images are in thumbnail view, entering 1201 dpi or a greater value will set Output
Resolution as follows.

— When you enter 1201 dpi to 2399 dpi: 2400 dpi
— When you enter 2401 dpi to 4799 dpi: 4800 dpi
— When you enter 4801 dpi to 9599 dpi: 9600 dpi
— When you enter 9601 dpi to 19199 dpi: 19200 dpi

Output Size
Select an output size.
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Select Flexible to set custom sizes or select a size for printing or displaying. Select Add/Delete... to set
custom size and save it as a new output size option.

Flexible
You can specify the output resolution and scale, and adjust the cropping frames (scan areas).

In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is displayed,
the portion within the cropping frame will be scanned. When no cropping frame is displayed, each
frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

»>» Note

» To enlarge/reduce the scanned image, enter values into = (Width) and o (Height) in
Output Settings or specify a value (by 1 %) for %. Although the maximum value available for
% depends on the Output Resolution, it can be specified for up to 19200 dpi (the maximum
available output resolution).

Paper Size (L, A4, etc.) & Monitor Size (1024 x 768 pixels, etc.)

B (Width), = (Height), and scale cannot be specified. The preview image will be cropped
according to the selected output size and resolution. The portion within the cropping frame will
be scanned at the size of the selected paper/monitor size. You can drag the cropping frame to
enlarge, reduce, or move it while maintaining the aspect ratio.

Add/Delete...
Displays the Add/Delete the Output Size dialog box for specifying custom output sizes.

Add/Delete the Output size. IEH
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In the Add/Delete the Output Size dialog box, multiple output sizes can be specified and then
saved at one time. Saved items will be registered to the Output Size list and can be selected,
along with the predefined items.

Adding:

Select Print or Image display for Destination, then enter Output Size Name, Width, and Height,
then click Add. For Unit, you can select inches or mm when Destination is Print but you can only
select pixels when Destination is Image display. The name of the added size appears in Output
Size List. Click Save to save the items listed in Output Size List.
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Deleting:

Select the output size you want to delete in Output Size List, and then click Delete. Click Save to
save the items listed in Output Size List.

32 Important

» Predefined output sizes such as A4 and 1024 x 768 pixels cannot be deleted.

»» Note

» Save up to 10 items for each destination.
* An error message appears when you enter a value outside the setting range. Enter a value
within the range displayed in the message.

»» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
» For details on whether or how the cropping frame initially appears on a preview image, see
Cropping Frame on Previewed Images in Preview tab of Preferences Dialog Box.

K (Switch Aspect Ratio)

Available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.
Data Size

The data size when scanned with the current settings is displayed.

»» Note

* When the data size exceeds a certain size, the value appears in red. In that case, a warning
message appears when you click Scan. It is recommended that you adjust the settings to reduce
Data Size. To continue, scan in whole image view.

313



I Image Settings
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22 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Image correction results may not be reflected in the preview image.

»» Note

» Selectable settings depend on Color Mode settings.
» Scanning may take longer than usual when you use Image Settings.

Image Settings allows you to set the following items:

Image Adjustment
When Image Adjustment is set, the brightness of the specified portion of the image is optimized. Images
can be adjusted according to the automatically detected document type or the specified document type.
The result of the adjustment will be reflected in the entire image.

None
Image Adjustment will not be applied.

Auto
Applies Image Adjustment by automatically detecting the document type. It is recommended that
you normally select this setting.

Photo
Applies Image Adjustment suitable for photos.

Magazine
Applies Image Adjustment suitable for magazines.
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Document
Applies Image Adjustment suitable for text documents.

22 Important

* You can set Image Adjustment after preview.
* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

»» Note

« If the image is not adjusted properly with Auto, specify the document type.
» The color tone may change from the source image due to the Image Adjustment. In that case, set
Image Adjustment to None.

Reduce Show-through
Use this function to reduce show-through in duplex documents or lighten the base color in recycled
paper and other colored paper when scanning documents.

OFF
Show-through will not be reduced.

ON

Select this to reduce show-through in duplex documents or lighten the base color. It is
recommended that you normally select this setting.

22 Important

* Reduce Show-through can be set when Recommended is selected on the Color Settings tab of
the Preferences dialog box and Document or Magazine is selected for Image Adjustment.

Unsharp Mask
Emphasizes the outline of the subjects to sharpen the image when scanning photos.

OFF
Unsharp Mask will not be applied.

ON
Emphasizes the outline of the subjects to sharpen the image. It is recommended that you normally
select this setting.

Descreen
Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are
scanned. Descreen is the function for reducing this moire effect.

OFF
Moire will not be reduced.

ON
Reduces moire. It is recommended that you normally select this setting.

»» Note

» Even if Descreen is set to ON, some moire effects may remain if Unsharp Mask is set to ON. In
that case, set Unsharp Mask to OFF.
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Reduce Dust and Scratches

Scanned photos may contain white dots caused by dust or scratches. Use this function to reduce such
noise.

None
Dust and scratches will not be reduced.
Low
Select this to reduce small dust particles and scratches. Large ones may remain.

Medium
It is recommended that you normally select this setting.

High
Select this to reduce large dust particles and scratches; however, evidence of the reduction
process may remain or delicate parts of the image may be removed.

32 Important

 This function may not be effective for some types of photos.

»» Note

* It is recommended that you select None when scanning printed materials.

Fading Correction

Corrects photos that have faded with time or have a colorcast. "Colorcast" is a phenomenon where a
specific color affects the entire picture due to the weather or ambient strong colors.

None
Fading Correction will not be applied.
Low
Select this to correct a small amount of fading and colorcast.
Medium
It is recommended that you normally select this setting.
High
Select this to correct a large amount of fading and colorcast. This can affect the tone of the image.

32 Important

* You can set Fading Correction after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

» Correction may not be applied properly if the scan area is too small.

Grain Correction
Use this function to reduce graininess (roughness) in photos taken with high-speed or sensitized film.

None
Graininess will not be reduced.

Low
Select this when the photo is slightly grainy.

Medium
It is recommended that you normally select this setting.
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High
Select this when the photo is very grainy. This can affect the gradation and sharpness of the
image.
32 Important

» Correction may not be applied properly if the scan area is too small.

Gutter Shadow Correction
Corrects shadows that appear between pages when scanning open booklets.

When you set the Gutter Shadow Correction setting in the preview image, the result will be reflected.
Preview the effects before scanning, as results vary depending on the type of document and how it is
pressed.

Unclear or blurred text/lines caused by curved pages are not corrected.

None
Gutter shadow will not be corrected.

Low
Select this when the effect level is too strong with the medium setting.

Medium
It is recommended that you normally select this setting.
High
Select this when the effect level is too weak with the medium setting.

22 Important

* You can set Gutter Shadow Correction after preview.

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the
document with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work
correctly or you might break the glass.

* Align the document with the edge of the Platen. If not, the shadow will not be corrected properly.

+ Shadows may not be corrected properly depending on the document. If the page background is not
white, shadows may not be detected correctly or may not be detected at all.

» While scanning, press down on the spine with the same amount of pressure you used to preview
the scan. If the binding part is not even, the shadow will not be corrected properly.

317



P HIEe

* How to place the document depends on your model and the document to be scanned.

»» Note

» Cover the document with black cloth if white spots, streaks, or colored patterns appear in scan
results due to ambient light entering between the document and the Platen.

+ If the shadow is not corrected properly, adjust the cropping frame (scan area) on the preview
image.

= Adjusting Cropping Frames (ScanGear)
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I Color Adjustment Buttons

The Color Adjustment Buttons allow you to make fine corrections to the image brightness and color tones
including adjustments to the image's overall brightness or contrast and adjustments to its highlight and
shadow values (histogram) or balance (tone curve).

) )
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22 Important

» The Color Adjustment Buttons are not available when you select Color Matching on the Color
Settings tab of the Preferences dialog box.

»» Note

+ Selectable settings depend on Color Mode settings.
» When you adjust the image via the Color Adjustment Buttons, the results will be reflected in the preview
image.

Click a Color Adjustment Button to set the following items:

e

(Saturation/Color Balance)
Adjust the saturation (vividness) and color tone of the image. Use this function to brighten colors that
have faded with time or due to colorcast. "Colorcast" is a phenomenon where a specific color affects the
entire picture due to the weather or ambient strong colors.

= Adjusting Saturation and Color Balance

P (Brightness/Contrast)

Adjust the brightness and contrast of the image. If the image is too dark or too bright, or if the image
quality is flat due to lack of contrast, you can adjust the levels of brightness and contrast.

= Adjusting Brightness and Contrast
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o (Histogram)

A histogram allows you to see the data concentration at each brightness level of an image. You can
specify the brightest level (highlight) and darkest level (shadow) within an image, cut the levels and
expand the middle of the tonal range of the image.

= Adjusting Histogram

(Tone Curve Settings)
Adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance of
tone input and output. You can make fine adjustments to the brightness of a specific area.

= Adjusting Tone Curve

7 (Final Review)

Make a final check of color adjustments. The final synthesized tone curve and the histogram derived
from the subsequent image processing will be displayed. There are no settings to make in this screen.

Firal Review

Chanred = gt o

 For a color image, select a color in Channel to check either Red, Green, or Blue, or select Master
to check three colors together.

« If you place the cursor on the preview image, the portion will be enlarged and its RGB values (only
L when Color Mode is Grayscale) before and after the adjustments will be displayed.

4 (Threshold)

Set the boundary (threshold) at which black and white are divided. By adjusting the threshold level, you
can sharpen text in a document or reduce show-through in newspapers.

= Setting Threshold

Custom
You can name and save a set of tone curve and threshold settings of the Color Adjustment Buttons.

Select Add/Delete... from the pull-down menu; when Color Mode is set to anything but Black and
White, the Add/Delete Tone Curve Settings dialog box opens; when Color Mode is Black and
White, the Add/Delete Threshold Settings dialog box opens.

320



Add/Delete Tone Cunve Settings n
Setting Name : Tone Curve Settings List :
Mew Setting | |
i =
Carel

Enter Setting Name and click Add; the name appears in Tone Curve Settings List or Threshold
Settings List. Click Save to save.

To delete an item, select it in Tone Curve Settings List or Threshold Settings List and click Delete.
Click Save to save the settings displayed in Tone Curve Settings List or Threshold Settings List.

You can load and apply the saved tone curve/threshold settings to a preview image. To load the
settings, select the saved item from the pull-down menu.

»» Note

» Save up to 20 items.

Defaults
Reset all adjustments (saturation/color balance, brightness/contrast, histogram, and tone curve).
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I Preferences Dialog Box

In the Preferences dialog box, you can make advanced settings to ScanGear (scanner driver) functions via
the Scanner, Preview, Scan, and Color Settings tabs.

Click Preferences... in the ScanGear screen to open the Preferences dialog box.

22 Important

» The displayed items vary depending on your model, document type, and view.
+ Available functions and settings vary depending on your model.

Preferences ﬂ
Serrer | Preview | Soan | Ol Setegn
st Pmer Settrg [ et |
Queet Settrags Sattngs...
Celowt Faldder Wheve Tergarory Flies srg faved
Soored So e
[ty e mbeen s
[ Ptary el oty s b eneplited
Catbraton Sattrgs
Perfors a1 Every Soam oFF W
[ Cancel

= Scanner Tab

= Preview Tab

= Scan Tab

= Color Settings Tab

I Scanner Tab

Set the auto power settings and quiet settings, specify the folder in which to save images temporarily, set
the music file to play during or at the end of a scan, and more.

Auto Power Settings
You can set to turn the machine on or off automatically.
Click Settings... to display the Auto Power Settings dialog box.
»>» Note

« If the machine is off or bi-directional communication is disabled, a message may appear because
the computer cannot collect the machine status. In that case, click OK to exit ScanGear (scanner
driver).
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Auto Power On
Select Enable to turn on the machine automatically when data is received.

Auto Power Off
Specify the amount of time you want to set from the list. When this time lapses without any data
being received, the machine turns off automatically.

22 Important

» When connected to the network, depending on your model, the power does not turn off
automatically even if Auto Power Off is set.

To check unsupported models, see List of Unsupported Models (Auto Power Off).

Quiet Settings

The silent function allows you to reduce the operating noise of this machine. Use this when you wish
to reduce the operating noise such as when scanning or printing at night.

Click Settings... to set the quiet mode.
»» Note

* You can set the quiet mode from the operation panel of the machine, the printer driver, or
ScanGear.

No matter how the setting is made, it applies to operations from the operation panel of the
machine or when printing/scanning from a computer, etc.

» Scanning or printing may take longer than usual when this function is used.
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Do not use quiet mode

Select this option when you wish to use the machine with volume of normal operating noise.
Always use quiet mode

Select this option when you wish to reduce the operating noise of the machine.
Use quiet mode during specified hours

Select this option when you wish to reduce the operating noise of the machine during a specified

period of time.

Set the Start time and End time during which quiet mode is to be activated.
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3» Important

* The time specified in Start time and in End time must be different.

« If your scanner or printer does not support fax functions, quiet mode is not applied to
operations (copy, direct print, etc.) performed directly from the machine even if the hours are
specified.

Select Folder Where Temporary Files are Saved
Displays the folder in which to save images temporarily. To change the folder, click Browse... to
specify another one.

Sound Settings
You can set the machine to play music during/at the end of a scan.

Select the Play music when scanning or Play sound when scanning is completed checkbox,
then click Browse... and specify a sound file.

You can specify the following files.

+ MIDI file (*.mid, *.rmi, *.midi)
* Audio file (*.wav, *.aif, *.aiff)
* MP3 file (*.mp3)

Calibration Settings
Platen Calibration
When you click Start, calibration starts and the scanner will be adjusted to reproduce correct
color tones in scanned images. Perform calibration when the color tones in the preview image
are significantly different from the original item or when colors appear in white areas.

Perform at Every Scan
When you set to ON, the scanner will be calibrated every time before previewing and scanning,
to reproduce correct color tones in scanned images.

»» Note

» Even when Perform at Every Scan is set to OFF, the scanner may be calibrated
automatically in some cases (such as immediately after you turn the machine on).

»>» Note

+ Calibration may take time depending on your computer.

Test Scanner...
Opens the Scanner Diagnostics dialog box from which you can run the scanner performance test.
Click Start to start the diagnostics.

I Preview Tab

Allows you to select what to do with Preview when ScanGear is started, how to display cropping frames
after previewing images, and the cropping size for thumbnails of scanned documents.

Preview When ScanGear Starts
Select what to do with Preview when ScanGear (scanner driver) is started.
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Automatic preview
ScanGear will automatically start previewing at startup.

Display saved preview image
The previously previewed image will be displayed.

The Color Adjustment Button settings, the Toolbar settings, and the Advanced Mode tab
settings are also saved.

None
No preview image will be displayed at startup.

»» Note

» Select None if you do not want to save the preview image.

Cropping Frame on Previewed Images
Select how to display cropping frames after previewing images.

Auto crop previewed images
The cropping frame (scan area) will automatically be displayed in the document size after
previewing.

Display the last frame
A cropping frame of the same size as the last used cropping frame will be displayed after
previewing.

None
No cropping frame will be displayed after previewing.

Thumbnail Viewing Size
Select the cropping size for thumbnails of scanned documents.

Larger
Displays 105 % (in width and height) of the area displayed for the standard size.

Standard
The standard size.

Smaller
Displays 95 % (in width and height) of the area displayed for the standard size.

»» Note

* When you change the Thumbnail Viewing Size setting, the preview images will be refreshed
and cropped to the new size. As the preview images are refreshed, the color adjustments and
other settings applied to them are reset.

I Scan Tab

Allows you to select what to do with ScanGear after scanning and set the Color Mode (48 bit output)
option for Advanced Mode tab. Allows you to select what to do with ScanGear after scanning image.

Status of ScanGear dialog after scanning
Select what to do with ScanGear (scanner driver) after scanning images.
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Close ScanGear automatically
Select this to return to the original application when scanning is completed.

Do not close ScanGear automatically
Select this to return to the ScanGear screen for another scan when scanning is completed.

Display the dialog to select the next action
Select this to open a screen and select what to do when scanning is completed.
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»» Note

» Even if Do not close ScanGear automatically or Display the dialog to select the next action
is set, some applications may not support it.

Advanced Mode Settings
Enable 48/16 bit output
Select this checkbox to display Color (48bit) in Color Mode on the Advanced Mode tab.
3» Important

» Some applications cannot receive images scanned in Color (48bit) or may close when such
images are received.

»» Note

* When Color (48bit) is selected for Color Mode, deselecting this checkbox changes Color
(48bit) to Color.
* When using a model supporting 16 bit output, Grayscale (16bit) appears in Color Mode.

I Color Settings Tab
Allows you to select how to adjust color, and specify the monitor gamma value.

Recommended
Select this to vividly reproduce the tone of a document on the screen. It is recommended that you
normally select this setting.

Color Matching
Select this to automatically match the scanner, monitor, and color printer colors, thus reducing time
and trouble to manually match the monitor and printer colors.

Source (Scanner)
Select scanner profile.

Target
Select target profile.
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Monitor
Select this checkbox to display preview image with optimum correction for monitor.

Defaults
Returns to the default Color Matching settings.

»>» Note

» The Color Adjustment Buttons on the Advanced Mode tab are not available when you select
Color Matching.
 This function is available when Color Mode is Color or Color (48bit).

None
Select this to disable color correction provided by ScanGear (scanner driver).

»>» Note

» Depending on your scanner or printer, this setting may not be available when scanning from the ADF
(Auto Document Feeder).

* You can select one when Color Mode is Color, Color (48bit), or Grayscale.

» Color Matching is available when ScanGear, monitor, color management-compliant application (such
as Adobe Photoshop), and printer are set up correctly.

Refer to the corresponding manual for the monitor, printer, and application settings.

Monitor Gamma
By setting the gamma value of a monitor, you can adjust the input data to the brightness
characteristics of the monitor. Adjust the value if your monitor's gamma value does not match the
default value set in ScanGear, and the colors of the original image are not accurately reflected in the
monitor.

Click Defaults to return to the default Monitor Gamma value (2.20).

»>» Note

» Refer to the manual of your monitor to check its gamma value. If it is not written in the manual,
contact the manufacturer.
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I List of Unsupported Models (Auto Power Off)

= MG series
= MX series
= [E series

I MG series

Model Name

Auto Power Off Function

With USB Connection

With Network Connection

MG7500 series

v

X

MG7100 series

X

MG6700 series

MG6600 series

MG6500 series

MG6400 series

MG5600 series

MG5500 series

MG3500 series

MG2900 series

STSNTSTSNINISNSTSNINS

I MX series

Model Name

Auto Power Off Function

With USB Connection

With Network Connection

MX530 series

X

X

MX490 series v x
MX470 series x x
I E series
Auto Power Off Function
Model Name
With USB Connection With Network Connection
E560 series v x
E480 series v x
E460 series v x
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I General Notes (Scanner Driver)

ScanGear (scanner driver) is subject to the following restrictions. Keep these points in mind when using it.

I Scanner Driver Restrictions

When using the NTFS file system, the TWAIN data source may not be invoked. This is because the
TWAIN module cannot be written to the winnt folder for security reasons. Contact the computer's
administrator for help.

Some computers (including laptops) connected to the machine may not resume correctly from
standby mode. In that case, restart the computer.

Do not connect two or more scanners or multifunction printers with scanner function to the same
computer simultaneously. If multiple scanning devices are connected, you cannot scan from the
operation panel or scanner buttons of the machine and also may experience errors while accessing
the devices.

Calibration may take time if the machine is connected via USB 1.1.

Scanning may fail if the computer has resumed from sleep or standby mode. In that case, follow these
steps and scan again.

If your model has no power button, perform Step 2 only.

1. Turn off the machine.
2. Exit ScanGear, then disconnect the USB cable from the computer and reconnect it.
3. Turn on the machine.

If scanning still fails, restart the computer.

ScanGear cannot be opened in multiple applications at the same time. Within an application,
ScanGear cannot be opened for the second time when it is already open.

Be sure to close the ScanGear window before closing the application.

When using a network compatible model by connecting to a network, the machine cannot be
accessed from multiple computers at the same time.

When using a network compatible model by connecting to a network, scanning takes longer than
usual.

Make sure that you have adequate disk space available when scanning large images at high
resolutions. For example, at least 300 MB of free space is required to scan an A4 document at
600 dpi in full-color.

ScanGear and WIA driver cannot be used at the same time.

Do not enter the computer into sleep or hibernate state during scanning.

I Applications with Restrictions on Use

Some applications may not display the TWAIN user interface. In that case, refer to the application's
manual and change the settings accordingly.

Some applications do not support continuous scanning of multiple documents. In some cases, only
the first scanned image is accepted, or multiple images are scanned as one image. For such
applications, do not scan multiple documents from the ADF (Auto Document Feeder).

To import scanned images into Microsoft Office 2000, first save them using IJ Scan Utility, then import
the saved files from the Insert menu.
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When scanning Platen size images into Microsoft Office 2003 (Word, Excel, PowerPoint, etc.), click
Custom Insert in the Insert Picture from Scanner or Camera screen. Otherwise, images may not
be scanned correctly.

When scanning images into Microsoft Office 2007/Microsoft Office 2010 (Word, Excel, PowerPoint,
etc.), use Microsoft Clip Organizer.

Images may not be scanned correctly in some applications. In that case, increase the operating
system's virtual memory and retry.

When image size is too large (such as when scanning large images at high resolution), your computer
may not respond or the progress bar may remain at 0 % depending on the application. In that case,
cancel the action (for example by clicking Cancel on the progress bar), then increase the operating
system's virtual memory or reduce the image size/resolution and retry. Alternatively, scan the image
via IJ Scan Utility first, then save and import it into the application.
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I Scanning in Advanced Mode

Use the Advanced Mode tab to scan by specifying the color mode, output resolution, image brightness,
color tone, and other settings.

To scan multiple documents at one time, see Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver).

To scan multiple documents placed on the ADF (Auto Document Feeder), see Scanning Multiple
Documents from the ADF (Auto Document Feeder) in Advanced Mode.

=% Important

* The following types of documents may not be scanned correctly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

— Photos with a whitish background

— Documents printed on white paper, hand-written text, business cards, and other unclear documents
— Thin documents
— Thick documents

* The following types of documents cannot be scanned correctly.

— Documents smaller than 1.2 inches (3 cm) square
— Photos that have been cut to irregular shapes

1. Place document on Platen, and then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Click Advanced Mode tab.

The tab switches to Advanced Mode.

— T
s a|E2E0EE @ ¥
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23 Note

» Settings are not retained when you switch modes.

3. Set Input Settings.

4. Click Preview.

Preview images appear in the Preview area.

22 Important

* Preview is not available when scanning from the ADF.

5. Set Output Settings.

6. Adjust cropping frame (scan area), correct image, and then adjust colors as needed.

= Adjusting Cropping Frames (ScanGear)

= Image Settings
= Color Adjustment Buttons

7. Click Scan.
Scanning starts.

23> Note

* Click @ (Information) to display a dialog box showing the document type and other details of the

current scan settings.
* How ScanGear behaves after scanning is complete can be set from Status of ScanGear dialog after
scanning on the Scan tab of the Preferences dialog box.
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I Related Topic

= Advanced Mode Tab
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Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver)

You can scan two or more photos (small documents) on the Platen at one time on the Basic Mode tab and
Advanced Mode tab.

This section explains how to scan multiple documents from the Basic Mode tab.

22 Important

» To scan multiple documents as a single image, scan in whole image view.
» The following types of documents may not be cropped correctly. In that case, adjust the cropping
frames (scan areas) in whole image view and scan.

— Photos with a whitish background

— Documents printed on white paper, hand-written text, business cards, and other unclear documents
— Thin documents

— Thick documents

= Scanning Multiple Documents in Whole Image View

» The following types of documents cannot be scanned correctly.

— Documents smaller than 1.2 inches (3 cm) square
— Photos that have been cut to various shapes

»» Note

* You can also scan multiple documents at one time from the Advanced Mode tab. Use the Advanced
Mode tab to make advanced scan settings such as the color mode, output resolution, image brightness,
and color tone.

» Refer to the corresponding sections below for details on the Basic Mode tab and Advanced Mode tab.

= Basic Mode Tab
= Advanced Mode Tab

1. Place document on Platen, and then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen.
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3. Click Preview.

Thumbnails of the preview images appear in the Preview area. Cropping frames are specified
automatically according to the document size.
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4. Set Destination.
5. Set Output Size according to purpose.

6. Adjust the cropping frames and set Image corrections as required.

12> Note

* You can correct each image separately. Select the frame you want to correct.
* In thumbnail view, you can only create one cropping frame per image. To create multiple cropping
frames in an image, scan in whole image view.
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= Scanning Multiple Documents in Whole Image View

7. Select the images you want to scan.

Select the checkboxes of the images you want to scan.

8. Click Scan.

I Scanning Multiple Documents in Whole Image View

Follow these steps if thumbnails are not displayed correctly when previewed or if you want to scan
multiple documents as a single image.

13%» Note

 Positions of slanted documents are not corrected in whole image view.

1. After previewing images, click :@ (Thumbnail) on the Toolbar.

Switch to whole image view.
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* When the whole image is displayed, the icon changes to =) (Whole Image).

2. Set Destination.

3. Set Output Size according to purpose.
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Invert aspect ratio will be enabled when Output Size is set to anything but Flexible. Click this button
to rotate the cropping frame. Click again to return it to the original orientation.

4. Adjust the cropping frames.

Adjust the size and position of the cropping frames on the preview image. You can also create two or
more cropping frames.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the specified area will be scanned.

= Adjusting Cropping Frames (ScanGear)

5. Set Image corrections as needed.

6. Click Scan.

Areas framed by broken lines are scanned.

»» Note

* How ScanGear behaves after scanning is complete can be set from Status of ScanGear dialog after
scanning on the Scan tab of the Preferences dialog box.
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Correcting Images and Adjusting Colors with ScanGear
(Scanner Driver)

¥

Correcting Images (Unsharp Mask, Reduce Dust and Scratches, Fading
Correction, etc.)

Adjusting Colors Using a Color Pattern
Adjusting Saturation and Color Balance
Adjusting Brightness and Contrast
Adjusting Histogram

Adjusting Tone Curve

Setting Threshold

338



Correcting Images (Unsharp Mask, Reduce Dust and
Scratches, Fading Correction, etc.)

The Image Settings functions on the Advanced Mode tab of ScanGear (scanner driver) allow you to
enhance the outline of the subjects, reduce dust/scratches, and correct faded colors when scanning images.
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I Setting Items

Click ¥ (Arrow) of a function and select an item from the pull-down menu.

Reduoe Dust and Soatches Tone o
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22 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Refer to "Image Settings" for details and precautions on each function.

7> Note

* Refer to "Scanning in Advanced Mode" to start the Advanced Mode tab of ScanGear and scan.

Adjusting the image brightness and color tone

Set Image Adjustment to Auto, Photo, Magazine, or Document according to the document type.

None Auto
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Reducing show-through in text documents or lightening the base color in
recycled paper, newspapers, etc. when scanning documents

Set Reduce Show-through to ON.

Sharpening slightly out-of-focus images
Set Unsharp Mask to ON.

OFF ON

Reducing gradations and stripe patterns

Set Descreen to ON.
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»» Note

+ Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon
where uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned. Descreen is the function for reducing this moire effect.

Reducing dust and scratches

Set Reduce Dust and Scratches to Low, Medium, or High according to the degree of dust and
scratches.

None Medium

Correcting photos that have faded with time or due to colorcast

Set Fading Correction to Low, Medium, or High according to the degree of fading or colorcast.

None Medium

"

“;}-1* ':-

Reducing graininess

Set Grain Correction to Low, Medium, or High according to the degree of graininess.

None Medium

Correcting shadows that appear between pages when scanning open booklets

Set Gutter Shadow Correction to Low, Medium, or High according to the degree of shadows.
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Medium

None
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I Adjusting Colors Using a Color Pattern

You can preview color changes and reproduce natural colors by using the color pattern function in
ScanGear (scanner driver)'s Basic Mode tab.
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I Color Adjustment

Correct colors that have faded with time or due to colorcast. "Colorcast" is a phenomenon where a
specific color affects the entire picture due to the weather or ambient strong colors.
Click an arrow in Color Adjustment to emphasize the corresponding color.

Cyan & red, magenta & green, and yellow & blue are complementary color pairs (each pair produces a
shade of gray when mixed). You can reproduce the natural colors of the scene by reducing the cast color
and increasing the complementary color.
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It is recommended that you find a portion in the image where it should be white, and adjust the colors so
that the portion turns white.

Preview image appears in the center. Preview image colors change as you adjust them.

cao.-:qr.m?rm:

miE
=Y

Cyan 7
Blue

Below is an example of correcting a bluish image.

Since Blue and Green are too strong, click the Yellow and Magenta arrows to correct.

Before

»>» Note

 Color adjustments are applied only to the cropping frames (scan areas) or the frame selected in
thumbnail view.

* You can select multiple frames or cropping frames by clicking them while pressing the Ctrl key.

* You can also select a color tone from the color pattern displayed on the left of the Color Pattern
screen.

* You can also use this function to add a specific tint to an image. Increase the magenta to add a warm
tint, and increase the blue to add a cool tint.
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I Adjusting Saturation and Color Balance

You can brighten colors that have faded with time or due to colorcast by using ¢
Balance) in ScanGear (scanner driver)'s Advanced Mode tab.

(Saturation/Color

Saturation/Color Balance = |
Image Settmgs T —
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——y
Diesress @ OFF bl I F
Color Balance 1
ﬁ | 4 1 Custom w . -
i Ol Cyan Red
L e—
i ]
0 -
Magenta Grren
_———e
| =x |
o
Welios [ F
L — [ ]
Defaults a2
»» Note

* Click Defaults to reset all adjustments in the current window.

I Saturation
Adjust the image's saturation (vividness). You can brighten colors that have faded with time, etc.

Move 4 (Slider) under Saturation to the left to decrease the saturation (darken the image), and to the
right to increase the saturation (brighten the image). You can also enter a value (-127 to 127).

Saturation @ - =
o |5

Low High

° = ¢

Saturation decreased Original image Saturation increased

»>» Note

» The natural color tone of the original image may be lost if you increase saturation too much.
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I Color Balance

Adjust images that have a colorcast. "Colorcast" is a phenomenon where a specific color affects the entire
picture due to the weather or ambient strong colors.

Move 4 (Slider) under Color Balance to the left or right to emphasize the corresponding color.

Cyan & Red

Magenta & Green

Yellow & Blue

These are complementary color pairs (each pair produces a shade of gray when mixed). You can
reproduce the natural colors of the scene by reducing the cast color and increasing the complementary
color.

It is usually difficult to correct the image completely by adjusting only one color pair. It is recommended
that you find a portion in the image where it should be white, and adjust all three color pairs so that the
portion turns white.

You can also enter a value (-127 to 127).

Below is an example of an image in which the "Cyan & Red" pair has been adjusted.

Coler Balance

Cyan
m .

Cyan is increased Red is increased
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I Adjusting Brightness and Contrast

You can adjust images that are too dark or bright, or too flat due to lack of contrast by using
(Brightness/Contrast) in ScanGear (scanner driver)'s Advanced Mode tab.
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3> Note

* Click Defaults to reset all adjustments in the current window.

I Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

I Brightness

Adjust the image brightness.
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Move 4 (Slider) under Brightness to the left to darken and right to brighten the image. You can also
enter a value (-127 to 127).

Erightness : o B
Diark Bright
* s K
Darkened Original image Brightened

»» Note

+ Highlights may be lost if you brighten the image too much, and shadows may be lost if you darken the
image too much.

I Contrast

"Contrast" is the degree of difference between the brighter and darker parts of an image. Increasing

contrast will increase the difference, thus sharpening the image. Decreasing contrast will decrease the
difference, thus softening the image.

Move 4 (Slider) under Contrast to the left to decrease and right to increase the contrast of the image.
You can also enter a value (-127 to 127).

Conirast ] %
Low High
0 == °
Decreased contrast Original image Increased contrast

.l

»>» Note

* Increasing the contrast is effective in adding a three-dimensional feel to soft images. However,
shadows and highlights may be lost if you increase the contrast too much.
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| Adjusting Histogram

You can adjust the image color tone by using a graph (histogram) showing brightness distribution, via 4

(Histogram) in ScanGear (scanner driver)'s Advanced Mode tab.

Histogram  IE
Image Seltimgs
Channed Hagter e
Inage Adutnent = Auto v
Lirsharn Mak ; ol » *
Ciesress @ OFF hll I /
CUE T v v
o Onfindts
F Y o s
Ao || & || 2] 288
Grary Balance © Fad
R G 3:
D faits: e
2> Note

* Click Defaults to reset all adjustments in the current window.

I Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

I Reading Histograms

You can see the histogram of a specified area for each Channel. The higher the histogram peak, the
more data is distributed to that level.
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(1) Bright area (2) Dark area (3) Whole image
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More data is distributed to the high- | More data is distributed to the shad-| Data is widely distributed between the
light side. ow side. highlight and shadow.

I Adjusting Histograms (Using the Slider)

Select a Channel, then move 4 (Black-point Slider) or .2~ (White-point Slider) to specify the level to be
set as the shadow or highlight.

—

 All parts to the left of 4 (Black-point Slider) will be black (level 0).

» The parts at .~ (Mid-point Slider) will turn to the color exactly between the black-point and white-
point.

* All parts to the right of ... (White-point Slider) will turn white (level 255).

When Image Adjustment is set to anything but None, the adjustments shown below are performed
automatically.

Moving the Black-point and White-point Sliders
Move the Black-point Slider or White-point Slider to adjust brightness.

Images with more data distributed to the highlight side

Move the Black-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the White-point Slider toward the shadow side.

350



Images with widely distributed data

Move the Black-point Slider toward the highlight side, and White-point Slider toward the shadow side.

Moving the Mid-point Slider

Move the Mid-point Slider to specify the level to be set as the middle of the tonal range.

Images with more data distributed to the highlight side
Move the Mid-point Slider toward the highlight side.

B

I Adjusting Histograms (Using the Droppers)

When you select a Channel and click the Black-point, Mid-point, or White-point Dropper, the mouse

pointer on the preview image changes to a dropper. Click a Dropper displayed below the histogram to
change the setting.
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* The point clicked with
(0 to 245).

(Black-point Dropper) will be the darkest point. You can also enter a value

* The point clicked with i
enter a value (5 to 250).

Vd

(Mid-point Dropper) will be the middle of the tonal range. You can also

* The point clicked with
value (10 to 255).

(White-point Dropper) will be the brightest point. You can also enter a

* Click i (Dropper) for Gray Balance and click the area you want to adjust the color in the preview
image.

The clicked point will be set as the achromatic color reference, and the rest of the image is adjusted
accordingly. For instance, if snow in a photo appears bluish, click the bluish part to adjust the whole image
and reproduce natural colors.
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I Adjusting Tone Curve

You can adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance

v
of tone input and output, via | * (Tone Curve Settings) in ScanGear (scanner driver)'s Advanced Mode
tab.
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¥>» Note

* Click Defaults to reset all adjustments in the current window.

I Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

I Reading Tone Curves

With ScanGear, scanning images via a scanner is the input, and displaying to a monitor is the output.
"Tone Curve" shows the balance of tone input and output for each Channel.
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Highlight
Output brightness
Shadow -

Shadow Highlight

Input brightness

I Adjusting Tone Curve

In Select Tone Curve, select a tone curve from No correction, Overexposure, Underexposure, High
contrast, Reverse the negative/positive image, and Edit custom curve.

No correction (No adjustment)

Overexposure (Convex curve)

The midtone data of the input side is stretched toward the highlight of the output side, resulting in a
bright-toned image when viewed on a monitor.

Underexposure (Concave curve)

The midtone data of the input side is stretched toward the shadow of the output side, resulting in a
dark-toned image when viewed on a monitor.

High contrast (S curve)

The highlight and shadow of the input side are enhanced, resulting in a high-contrast image.
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Reverse the negative/positive image (Downward-sloping line)

The input and output sides are reversed, resulting in a negative-positive inverted image.

Edit custom curve

You can drag specific points on the Tone Curve to freely adjust the brightness of the corresponding areas.
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I Setting Threshold

You can sharpen text in a document or reduce show-through in newspapers by adjusting the threshold level

A

via (Threshold) in ScanGear (scanner driver)'s Advanced Mode tab.

Tl'u'ashord

A Custom w

=)

Defadiz

Defmits Oz

»» Note

» This function is available when Color Mode is Black and White.
* Click Defaults to reset all adjustments in the current window.

| Adjusting Threshold

The brightness of color and grayscale images is expressed in a value between 0 and 255. However, in
creating black and white images, all colors are mapped to either black (0) or white (255). "Threshold" is
the borderline value that determines a color as black or white.

Move 4 (Slider) to the right to increase the threshold value and thus increase the black areas. Move the
slider to the left to decrease the value and thus increase the white areas. You can also enter a value (0 to
255).
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I Positioning Originals (Scanning from Computer)

This section describes how to load originals on the platen or ADF (Auto Document Feeder) for scanning. If

items are not placed correctly they may not be scanned correctly.

3% Important

» Be sure to observe the following when loading the original on the platen. Failure to observe the

following may cause the scanner to malfunction or the platen glass to break.

— Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.
— Do not put any pressure of 4.4 |b (2.0 kg) or more on the platen glass, such as pressing down the

original.

* Close the document cover when scanning.

Do not touch the operation panel buttons or LCD (Liquid Crystal Display) when opening/closing the

document cover. May result in unintended operation.

* When using a personal scanner in the upright position, the item type may not be detected automatically.
In that case, specify the item type in IJ Scan Utility or ScanGear (scanner driver) and scan.

= Placing ltems (Platen)
= Placing Documents (ADF (Auto Document Feeder))
= Placing Items (When Using Stand)

I Placing Items (Platen)

Place items as described below to scan by detecting the item type and size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.
» Photos that have been cut to irregular shapes and items smaller than 1.2 inches (3 cm) square

cannot be cropped accurately when scanning.
» Reflective disc labels may not be scanned as expected.

Photos, Postcards, Business Cards, and BD/DVD/CD

Magazines, Newspapers,
and Documents

Single item:

Place the item face-down on the platen, with 0.4 inch (1 cm) or more space between
the edges (diagonally striped area) of the platen and the item. Portions placed on
the diagonally striped area cannot be scanned.
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1A4

LTR

2% Important

* Large items (such as A4 size photos) that cannot be placed away from the
edges/arrow (alignment mark) of the platen may be saved as PDF files. To save
in a format other than PDF, scan by specifying the data format.

Multiple items:

Allow 0.4 inch (1 cm) or more space between the edges (diagonally striped area) of
the platen and items, and between items. Portions placed on the diagonally striped
area cannot be scanned.
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A : 0.4 inch (1 cm) or more

> Note

* Place up to 12 items.

* Place up to four items if the Compress scanned images upon transfer check-
box is selected in the Settings dialog box of IJ Scan Utility.

With network connection, items may not be scanned correctly when five or
more items are placed. In that case, reduce the number of items placed on the
platen to four or less, and then scan again.

Positions of slanted items (10 degrees or less) are corrected automatically.

1A4
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3% Important

* Inkjet All-In-One print-
er:

For the portions in which
items cannot be scan-
ned, see Loading Origi-
nals.

¢ Personal scanner:

For the portions in which
items cannot be scan-
ned, see Iltems You Can
Place & How to Place
Items.

I Placing Documents (ADF (Auto Document Feeder))
22 Important

» Do not leave thick items on the platen when scanning from the ADF. May result in paper jam.
 Place and align documents of the same size when scanning two or more documents.
» For supported document sizes when scanning from the ADF, see Supported Originals.
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1. Make sure any original has been removed from platen.

2. Open document tray (A).

»» Note

» The location and number of document guides may vary depending on your model.

4. Load document with side to scan facing up in document tray.

Insert the document until it stops.

5. Adjust document guide to match width of document.

Do not slide the document guide too hard against the document. The document may not be fed
properly.
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»>» Note

* When scanning duplex documents, place the front sides facing up. They will not be scanned correctly
if placed the other way around.

I Placing Items (When Using Stand)

1. Place item on platen.
1. Open the document cover.

2. Place the item with the side to scan facing the platen, and then align it with the alignment
mark.

32 Important

* If you open the document cover wide, the scanner may fall over.
* Portions placed over (A) (0.094 inch (2.4 mm) from the left edge of the platen) or (B) (0.106 inch
(2.7 mm) from the front edge) cannot be scanned.

A

2. Gently close document cover.
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While scanning, hold the document cover gently with your hand to keep it closed.

32 Important

» Keep these points in mind when using the scanner in the upright position.
— Do not subject the scanner to vibration during operation. The correct image results may not
be obtained (for example, images may blur).
— The item type may not be detected automatically. In that case, specify the item type in IJ
Scan Utility or ScanGear (scanner driver) and scan.
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I Adjusting Cropping Frames (ScanGear)

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

On the Basic Mode tab and Advanced Mode tab, you can specify cropping frames (scan areas) on the
image(s) displayed in the Preview area of the screen.

When you perform a scan, each area specified with a cropping frame will be scanned as a separate image.

»>» Note

* In whole image view, you can specify multiple cropping frames on the preview image.
* For how to adjust cropping frames with IJ Scan Utility, see Adjusting Cropping Frames in the Image
Stitch Window.

I Initial Cropping Frame

In thumbnail view:

No cropping frame is specified. You can drag the mouse over a thumbnail to specify a cropping frame.

In whole image view:

An active cropping frame is automatically specified around the preview image. You can drag the cropping
frame in the Preview area to specify the area.

»>» Note

» The auto crop setting can be changed with Cropping Frame on Previewed Images on the Preview
tab of the Preferences dialog box.

I Cropping Frame Types

-

(1)

(1) Thick cropping frame (rotating or stationary)
Represents a selected cropping frame. Appears only in whole image view. You can select multiple
cropping frames by clicking them while pressing the Ctrl key. Output size, image corrections, and
other settings on the Basic Mode tab or Advanced Mode tab will be applied to all the selected
cropping frames.
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(2) Thin cropping frame

In thumbnail view:

Output size, image corrections, and other settings on the Basic Mode tab or Advanced Mode tab
will be applied.

In whole image view:

Represents an unselected cropping frame. The settings on the Basic Mode tab or Advanced Mode
tab will not be applied.

I Adjusting a Cropping Frame

The cursor will change into = jt Rﬂ '3;] (Arrow) when it is positioned over a cropping frame. If you
click and drag the mouse in the direction of the arrow, the cropping frame will expand or contract
accordingly.

The cursor will change into G%ED (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

»>» Note

» On the Advanced Mode tab, you can specify the cropping frame size by entering the values into =
(Width) and *~ (Height) in Input Settings.

* You can rotate a cropping frame 90 degrees by clicking & (Switch Aspect Ratio). However, i
(Switch Aspect Ratio) is not available when Output Size is Flexible.

I Creating Multiple Cropping Frames

In thumbnail view:

You can only create one cropping frame per image.
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In whole image view:

Click and drag the mouse in a space outside the existing cropping frame to create a new cropping frame
in the Preview area. The new cropping frame will be the active cropping frame, and the old cropping frame
will be the unselected cropping frame.

You can create multiple cropping frames and apply different scan settings to each cropping frame.
You can also select multiple cropping frames by clicking them while pressing the Ctrl key.

If you select multiple cropping frames and change the settings on a tab at the right of ScanGear, the
settings will be applied to all the selected cropping frames.

When you create a new cropping frame, it retains the settings of the latest cropping frame.

13» Note

» Create up to 12 cropping frames.
» Scanning takes longer than usual when multiple cropping frames are selected.

I Deleting Cropping Frames

In thumbnail view:

To delete a cropping frame, click an area outside the cropping frame on an image.
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In whole image view:
K

To delete a cropping frame, select it and click =~ (Remove Cropping Frame) on the Toolbar.
Alternatively, press the Delete key.

When there are multiple cropping frames, all the selected cropping frames (active cropping frame and
selected cropping frames) are deleted simultaneously.
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I Scanning Tips

» Positioning Originals (Scanning from Computer)
» Network Scan Settings
@ |J Network Scanner Selector EX2 Menu and Setting Screen
» Scanning with WIA Driver
» Resolution
» Data Formats

» Color Matching
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I Positioning Originals (Scanning from Computer)

This section describes how to load originals on the platen or ADF (Auto Document Feeder) for scanning. If

items are not placed correctly they may not be scanned correctly.

3% Important

» Be sure to observe the following when loading the original on the platen. Failure to observe the

following may cause the scanner to malfunction or the platen glass to break.

— Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.
— Do not put any pressure of 4.4 |b (2.0 kg) or more on the platen glass, such as pressing down the

original.

* Close the document cover when scanning.

Do not touch the operation panel buttons or LCD (Liquid Crystal Display) when opening/closing the

document cover. May result in unintended operation.

= Placing Items (Platen)
= Placing Documents (ADF (Auto Document Feeder))

I Placing Items (Platen)

Place items as described below to scan by detecting the item type and size automatically.

3% Important

» Depending on your model, the function to scan by automatically detecting the item type and size does

not appear.

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.
» Photos that have been cut to irregular shapes and items smaller than 1.2 inches (3 cm) square

cannot be cropped accurately when scanning.
» Reflective disc labels may not be scanned as expected.

« If scanned by detecting the item type and size automatically, the response may differ. In that case,

adjust the cropping frame (scan area) manually.

Photos, Postcards, Business Cards, and BD/DVD/CD

Magazines, Newspapers,
and Documents

Single item:

Place the item face-down on the platen, with 0.4 inch (1 cm) or more space between
the edges (diagonally striped area) of the platen and the item. Portions placed on the
diagonally striped area cannot be scanned.
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* Large items (such as A4 size photos) that cannot be placed away from the
edges/arrow (alignment mark) of the platen may be saved as PDF files. To save
in a format other than PDF, scan by specifying the data format.

Multiple items:

Allow 0.4 inch (1 cm) or more space between the edges (diagonally striped area) of
the platen and items, and between items. Portions placed on the diagonally striped
area cannot be scanned.
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A : 0.4 inch (1 cm) or more

> Note

* Place up to 12 items.
+ Positions of slanted items (10 degrees or less) are corrected automatically.

I Placing Documents (ADF (Auto Document Feeder))
32 Important

» Be careful not to let anything get inside the document output slot. It may cause damage.
* Place and align documents of the same size when scanning two or more documents.
» For supported document sizes when scanning from the ADF, see Supported Originals.

»>» Note

» To scan a document at optimum quality, load it on the platen.

1. Make sure any original has been removed from platen.
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2. Open document tray (A).

»» Note

» The location and number of document guides may vary depending on your model.

4. Load document with side to scan facing up in document tray.

Insert the document until it stops.

5. Adjust document guide to match width of document.

Do not slide the document guide too hard against the document. The document may not be fed
properly.
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»>» Note

* When scanning duplex documents, place the front sides facing up. They will not be scanned correctly
if placed the other way around.

370



I Network Scan Settings

You can connect your scanner or printer to a network to share it among multiple computers or scan images
into a specified computer.

3% Important

» Multiple users cannot scan at the same time.

»» Note

» Complete the network settings of your scanner or printer beforehand by following the instructions on our
website.
+ With network connection, scanning takes longer than USB connection.

Complete the following settings to enable scanning over a network.

I Specifying Your Scanner or Printer

Use IJ Network Scanner Selector EX to specify the scanner you want to use. By specifying the scanner,
you can scan over a network from your computer or the operation panel.

32 Important

+ If the product you want to use is changed with IJ Network Scanner Selector EX, the product used for
scanning with IJ Scan Utility changes as well. The product for scanning from the operation panel also
changes.

If your scanner or printer is not selected in IJ Scan Utility, check that it is selected with IJ Network
Scanner Selector EX.

Refer to "IJ Network Scanner Selector EX2 Menu and Setting Screen" for details.

» To scan from the operation panel, specify your scanner or printer with IJ Network Scanner Selector
EX beforehand.

1. Check that IJ Network Scanner Selector EX is running.

If IJ Network Scanner Selector EX is running, =¥ (IJ Network Scanner Selector EX2) appears in the
notification area on the desktop. Click B8 to check the hidden icons as well.

»» Note

« If the icon is not displayed in the notification area on the desktop, follow the procedure below to
start.

— Windows 11/Windows 10:

From the Start menu, click (All apps >) Canon Utilities > IJ Network Scanner Selector
EX2.

— Windows 8.1:

Click IJ Network Scanner Selector EX2 on the Start screen.
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If IJ Network Scanner Selector EX2 is not displayed on the Start screen, select the
Search charm, then search for "IJ Network Scanner Selector EX2".

— Windows 7:

From the Start menu, click All Programs > Canon Utilities > IJ Network Scanner
Selector EX2 > IJ Network Scanner Selector EX2.

The icon appears in the notification area on the desktop, and the Scan-from-PC Settings screen
appears. In that case, skip ahead to Step 3.

2. In the notification area on the desktop, right-click = (IJ Network Scanner Selector EX2),
then select Settings....

The Scan-from-PC Settings screen appears.

3. Select your scanner or printer from Scanners.

Normally, the MAC address of your scanner or printer is already selected after the network setup. In
that case, you do not need to select it again.

32 Important

« If multiple scanners exist on the network, multiple model names appear. In that case, you can
select one scanner per model.

4. Click OK.
»>» Note

» The scanner selected in the Scan-from-PC Settings screen will be automatically selected in the
Scan-from-Operation-Panel Settings screen as well.

I Setting for Scanning with IJ Scan Utility

To scan from IJ Scan Utility using a scanner or printer connected to a network, specify your scanner or
printer with 1J Network Scanner Selector EX, then follow the steps below to change the connection status
between it and the computer.

1. Start IJ Scan Utility.

2. Select "Canon XXX series Network" (where "XXX" is the model name) for Scanner.

3. Click = Settings... to use another scanner connected to a network.

[

¢
4. Click i) (General Settings), then click Select in Product Name.
The Scan-from-PC Settings screen of IJ Network Scanner Selector EX appears.

Select the scanner you want to use and click OK.
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5. In the Settings (General Settings) dialog box, click OK.

The IJ Scan Utility main screen reappears. You can scan via a network connection.

I Setting for Scanning from the Operation Panel
You can make the setting for scanning from the operation panel.
2% Important

» Set IJ Scan Utility to use your scanner or printer via a network connection beforehand.

= Setting for Scanning with 1J Scan Utility

1. Check that IJ Network Scanner Selector EX is running.

If IJ Network Scanner Selector EX is running, =¥ (IJ Network Scanner Selector EX2) appears in the
notification area on the desktop. Click B8 to check the hidden icons as well.

»» Note

« If the icon is not displayed in the notification area on the desktop, follow the procedure below to
start.

— Windows 11/Windows 10:

From the Start menu, click (All apps >) Canon Utilities > IJ Network Scanner Selector
EX2.

— Windows 8.1:
Click IJ Network Scanner Selector EX2 on the Start screen.

If IJ Network Scanner Selector EX2 is not displayed on the Start screen, select the
Search charm, then search for "IJ Network Scanner Selector EX2".

— Windows 7:

From the Start menu, click All Programs > Canon Utilities > IJ Network Scanner
Selector EX2 > IJ Network Scanner Selector EX2.

The icon appears in the notification area on the desktop, and the Scan-from-PC Settings screen
appears. In that case, skip ahead to Step 3.

2. In the notification area on the desktop, right-click = (IJ Network Scanner Selector EX2),
then select Settings....

The Scan-from-PC Settings screen appears.

3. Click Scan-from-Operation-Panel Settings.

The Scan-from-Operation-Panel Settings screen appears.

4. Select your scanner or printer from Scanners and click OK.
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Select the MAC address of your scanner or printer.

> Note

+ When multiple scanners are connected via a network, you can select up to three scanners.

5. In the Scan-from-PC Settings screen, click OK.

»» Note

« If your scanner or printer does not appear, check the following, click OK to close the screen, then
reopen it and try selecting again.

— MP Drivers is installed
— Network settings of your scanner or printer is completed after installing the MP Drivers
— Network communication between your scanner or printer and computer is enabled

If the problem is still not solved, see Network Communication Problems.
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I IJ Network Scanner Selector EX2 Menu and Setting Screen

IJ Network Scanner Selector EX2 allows you to select the scanners or printers to be used for scanning or
printing over a network from your computer or the operation panel.

After installation, 1J Network Scanner Selector EX2 appears in the notification area on the desktop.

22 Important

+ If you cannot scan over a network, download and upgrade to the latest MP Drivers from our website.

» While IJ Network Scanner Selector EX2 is enabled, it periodically transmits packets to check whether it
can communicate with your scanner or printer over the network. When using the computer in a network
environment other than the one used to set up your scanner or printer, disable IJ Network Scanner
Selector EX2.

»» Note
« If the icon is not displayed in the notification area on the desktop, follow the procedure below to start.

— Windows 11/Windows 10:

From the Start menu, click (All apps >) Canon Utilities > IJ Network Scanner Selector EX2.

— Windows 8.1:
Click IJ Network Scanner Selector EX2 on the Start screen.

If IJ Network Scanner Selector EX2 is not displayed on the Start screen, select the Search
charm, then search for "IJ Network Scanner Selector EX2".

— Windows 7:

From the Start menu, click All Programs > Canon Utilities > IJ Network Scanner Selector EX2
> |J Network Scanner Selector EX2.

I Menu

Displays a menu when you right-click = (IJ Network Scanner Selector EX2) in the notification area on
the desktop.

Disable Canon IJ Network Scanner Selector EX2 /| Enable Canon IJ Network Scanner Selector EX2
Enables or disables |1J Network Scanner Selector EX2.

When you select Disable Canon IJ Network Scanner Selector EX2, you will not be able to scan
over a network from the operation panel.

Enabled: ¥, Disabled: &
32 Important

* When using a model with which you cannot scan over a network from the operation panel, you
cannot scan using the operation panel even if this setting is enabled.

Settings...
The Scan-from-PC Settings screen appears. You can select the model you want to use.
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About
Displays the version information.

In the displayed dialog box, you can change the language to be used in the application. The change
will be reflected after restarting the computer.

Exit

Exits IJ Network Scanner Selector EX2; =" (Enabled) or ®¥ (Disabled) disappears from the
notification area on the desktop.

I Scan-from-PC Settings Screen

Right-click the icon from the notification area on the desktop, then select Settings... to display the
Scan-from-PC Settings screen.

Your scanner or printer must be selected with 1J Network Scanner Selector EX2 before scanning over a
network.

Scanners
MAC addresses of the scanners or printers that can be used over the network are displayed.

You can select one scanner or printer per model. Selecting a scanner or printer automatically enables
scanning from the operation panel.

Instructions
Opens this guide.

Scan-from-Operation-Panel Settings
The Scan-from-Operation-Panel Settings screen appears. You can select up to three scanners and
printers in total for scanning from the operation panel. You can scan items using the operation panel
of the selected scanner or printer, and send the scanned images to your computer over a network.

22 Important

* When using a model with which you cannot scan over a network from the operation panel, that
model does not appear in Scanners and the setting is not available.

I Scan-from-Operation-Panel Settings Screen

Click Scan-from-Operation-Panel Settings in the Scan-from-PC Settings screen to display the Scan-
from-Operation-Panel Settings screen.

Scanners
MAC addresses of the scanners or printers that can be used over the network are displayed.

You can select up to three scanners and printers in total at the same time. Selecting a scanner or
printer automatically enables scanning from the operation panel.

Instructions
Opens this guide.
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3% Important

* When using a model with which you cannot scan over a network from the operation panel, Scan-
from-Operation-Panel Settings may appear in the Scan-from-PC Settings screen; however, the
setting is not available.

»>» Note

« If your scanner or printer does not appear, check the following, click OK to close the screen, then
reopen it and try selecting again.

— MP Drivers is installed
— Network settings of your scanner or printer is completed after installing the MP Drivers
— Network communication between your scanner or printer and computer is enabled

If the problem is still not solved, see Network Communication Problems.

* You do not need to use this software when scanning via USB. Refer to "Uninstalling IJ Network
Scanner Selector EX2" to delete it. You can scan via USB even if it is not deleted.
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I Uninstalling IJ Network Scanner Selector EX2

Follow the procedure below to uninstall IJ Network Scanner Selector EX2 from your computer

22 Important

* You cannot scan over a network after uninstalling IJ Network Scanner Selector EX2.
* Log into a user account with administrator privilege.

1. Click Control Panel > Programs > Programs and Features.

2. Select Canon IJ Network Scanner Selector EX2, then click Uninstall/Change
2> Note

« If the User Account Control screen appears, click Continue.

3. Click Yes when the confirmation message appears.

4. When uninstallation is complete, click OK.
»» Note

* When the message prompting you to restart your computer appears, click OK to restart your
computer.
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I Updating the ScanGear (Scanner Driver)

» Obtaining the Latest ScanGear (Scanner Driver)
» Deleting the Unnecessary ScanGear (Scanner Driver)
» Before Installing the ScanGear (Scanner Driver)

» Installing the ScanGear (Scanner Driver)
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I Obtaining the Latest ScanGear (Scanner Driver)

Upgrading your current ScanGear (scanner driver) to the latest ScanGear may solve some problems you
have experienced.

I Checking the Version of ScanGear

Start ScanGear and click d (Information) to display the version of ScanGear.

I Obtaining ScanGear

To obtain ScanGear, access our website, and then download the ScanGear for your model.

32 Important

» ScanGear can be downloaded for free; however, Internet connection fees apply.
+ Install the latest ScanGear after deleting the old one. Refer to "Deleting the Unnecessary ScanGear
(Scanner Driver)" for how to delete ScanGear.

I Related Topic

= Before Installing the ScanGear (Scanner Driver)
= |nstalling the ScanGear (Scanner Driver)
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I Deleting the Unnecessary ScanGear (Scanner Driver)

You can delete the ScanGear (scanner driver) you no longer use.

When deleting ScanGear, close all running applications, and then remove the USB cable connecting the
scanner and computer.

1. From Control Panel, click Programs > Programs and Features.

2. Double-click CanoScan XXX Scanner Driver (where "XXX" is model name).
3. When the Scanner Driver Uninstall dialog box appears, click Execute.

4. When a confirmation appears, click Yes.

5. When uninstallation is complete, click Complete.
ScanGear is deleted.

»>» Note

+ A confirmation or warning dialog box may appear when installing, uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task. If you are logged on
to an administrator account, click Yes (or Continue, Allow) to continue.
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I Before Installing the ScanGear (Scanner Driver)

Check the following points before installing ScanGear (scanner driver). Check these also when you cannot
install ScanGear.

I Scanner Status

« If the scanner and computer are connected with a USB cable, disconnect the USB cable from the
computer.

e Turn off the scanner.

I Computer Settings

* Close all running applications.
* Log in as the administrator of the computer.

»» Note

+ If an older version of ScanGear is already installed, delete (uninstall) it beforehand. Refer to "Deleting
the Unnecessary ScanGear (Scanner Driver)" for how to delete ScanGear.

I Related Topic

= Updating the ScanGear (Scanner Driver)
= |nstalling the ScanGear (Scanner Driver)
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I Installing the ScanGear (Scanner Driver)

To download the latest ScanGear (scanner driver), access our website via the Internet.

Follow these steps to install the downloaded ScanGear.

1. Double-click the icon of the downloaded file.

The installation program starts.

> Note

« A confirmation or warning dialog box may appear when installing, uninstalling, or starting up
software. This dialog box appears when administrative rights are required to perform a task. If you
are logged on to an administrator account, click Yes (or Continue, Allow) to continue.

Some applications require administrator account to continue. If you are logged on to a standard
account, switch to an administrator account and start over.

2. In the Welcome screen, click Next.

3. Read and understand the License Agreement, then click Yes.

ScanGear installation starts.

4. Connect scanner and computer with supplied USB cable.
The computer recognizes the scanner.

ScanGear is installed.

5. When the Installation Complete screen appears, click Complete.

A message prompting you to restart the computer may appear depending on your environment. Restart
the computer to complete the installation properly.

32 Important

» ScanGear can be downloaded for free; however, Internet connection fees apply.

I Related Topic

= Obtaining the Latest ScanGear (Scanner Driver)
= Deleting the Unnecessary ScanGear (Scanner Driver)
= Before Installing the ScanGear (Scanner Driver)
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I Scanning with WIA Driver

You can scan an item from a WIA (Windows Image Acquisition)-compliant application.

The procedure varies depending on the application. The following procedures are examples only.
Refer to the application's manual for details.
32 Important

 Available functions, the displayed items, and available settings vary depending on your model.

» Some applications do not support continuous scanning from the ADF (Auto Document Feeder). Refer to
the application's manual for details.
* Follow these steps to enable scanning over a network.

— Windows 11/Windows 10/Windows 8.1:

1. Right-click Start menu, and then select File Explorer > Network.

2. In Network menu of displayed screen, select Add devices and printers.

3. In screen for adding device, select XXX_MAC address (where "XXX" is model name), and
then click Next.

— Windows 7:

1. From Start menu, select Computer > Network.

2. Right-click XXX_MAC address (where "XXX" is model name) in the displayed screen, then
select Install.

The setting may have been completed already depending on your environment. In that case,
Uninstall appears.

| scanning with WIA Driver 2.0

The following is an example of scanning using "Windows Fax and Scan."

1. Place items on platen or ADF.

= Positioning Originals (Scanning from Computer)

2. Select New on the File menu of "Windows Fax and Scan," then click Scan....
The scan setting screen appears.

»» Note

« If you have more than one scanner or printer, a scanner selection screen may appear. Double-
click the scanner you want to use.

— For USB connection: Canon XXX series (where "XXX" is the model name)
— For network connection: XXX series_MAC address (where "XXX" is the model name)

3. Specify the settings.
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Scanner
The currently set product name is displayed. To change the scanner, click Change... and select
the product you want to use.

Profile
Select Photo (Default) or Documents according to the type of item to be scanned. To save a
new Profile, select Add profile.... You can specify the details in the Add New Profile dialog box.

Source
Select a scanner type. To scan from the platen, select Flatbed. To scan from the ADF, select
Feeder (Scan one side) or Feeder (Scan both sides).

Paper size
Select the paper size. Paper size can be set only when Source is Feeder (Scan one side) or
Feeder (Scan both sides).

Color format
Select the color mode in which to scan the item.

File type
Select a data format from BMP, JPEG, PNG, and TIFF.

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

»» Note

* When using the scanner or printer with network connection, the following resolutions can be
specified.
150 dpi / 300 dpi / 600 dpi

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-100 to 100).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-100 to 100).

Preview or scan images as separate files
Select this checkbox to preview or scan multiple images as separate files.

32 Important

* When using the scanner or printer with network connection, you cannot specify Brightness,
Contrast, and Preview or scan images as separate files.

. Click Preview to preview the image.
The preview image appears on the right.

22 Important

» With network connection, scan without preview when scanning documents from the ADF. If you
preview, place the document again and scan.

385



If there is document left in the ADF after previewing, press the OK button on the operation
panel and remove the document.

5. Click Scan.

Scanning starts, then the scanned image appears in the application.
I Scanning with WIA Driver 1.0
The following is an example of scanning using "Paint."

1. Place items on platen or ADF.

= Positioning Originals (Scanning from Computer)

2. Click From scanner or camera from the File menu of Paint. (Select the command to
scan an item in the application.)

»» Note

« If you have more than one scanner or printer, a scanner selection screen may appear. Double-
click the scanner you want to use.

— For USB connection: Canon XXX series (where "XXX" is the model name)
— For network connection: XXX series_ MAC address (where "XXX" is the model name)

3. Select the paper source and type of picture according to the item to be scanned.

To scan from the platen, select Flatbed for Paper source. To scan from the ADF, select Document
Feeder.

Select the type of picture from Color picture, Grayscale picture, Black and white picture or text,
and Custom Settings.

»» Note

* When using the scanner or printer with network connection, the options for the type of picture
may differ from those displayed with USB connection.

» To scan with the values previously set in Adjust the quality of the scanned picture, select
Custom Settings.

» Selecting Document Feeder for Paper source enables you to select Page size.

4. Click Adjust the quality of the scanned picture and set the preferences as required.

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-127 to 127).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).
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Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

»» Note

* When using the scanner or printer with network connection, the following resolutions can be
specified.

150 dpi / 300 dpi / 600 dpi

Picture type
Select the type of scan you want for your item.
Reset

Click to restore the original settings.

22 Important

» When using the scanner or printer with network connection, you cannot specify Brightness and
Contrast.

5. Click Preview to preview the image.

The preview image appears on the right. Drag [l to specify the scan area.

32 Important

» With network connection, scan without preview when scanning documents from the ADF. If you
preview, place the document again and scan.

If there is document left in the ADF after previewing, press the OK button on the operation
panel and remove the document.

6. Click Scan.

Scanning starts, then the scanned image appears in the application.
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I Resolution

The data in the image you have scanned is a collection of dots carrying information about brightness and
color. The density of these dots is called "resolution," and resolution will determine the amount of detail your
image contains. The unit of resolution is dots per inch (dpi). Dpi is the number of dots per inch (2.5 cm).

The higher the resolution (value), the more detail in your image; the lower the resolution (value), the less
detail.

I How to Set the Resolution

You can set the resolution in the following screens.

IJ Scan Utility:

Resolution on the “® (Scanning from a Computer) tab of the Settings dialog box

ScanGear (Scanner Driver):

Output Resolution in Output Settings on the Advanced Mode tab

I Appropriate Resolution Settings

Set the resolution according to the use of the scanned image.

Appropriate
Item Type Use Color Mode e .
Resolution
Copyin
_py|. 9 Color 300 dpi
(Printing)
Creating a postcard Color 300 dpi
Color photo
Saving to a computer Color 300 dpi
Using on a website or attaching to e-
"9 g Color 150 dpi
mail
Saving to a computer Grayscale 300 dpi
Black and white photo Using on a website or attaching to e-
I_ g websl n9 Grayscale 150 dpi
mail
Color, Grayscale, or .
Copying oo i’Nh_ 300 dpi
Text document (document or ack and ite
magazine) ) ] Color, Grayscale, or .
Attaching to e-mail ) 150 dpi
Black and White
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Scanning text using OCR

Color or Grayscale

300 dpi

3% Important

« If you double the resolution, the data size of the scanned image quadruples. If the file is too large, the
processing speed will slow down significantly, and you will experience inconvenience such as lack of

memory. Set the minimum required resolution according to the use of the image.

»>» Note

» When you will be printing the scanned image by enlarging it, scan by setting a higher resolution than

the recommended one above.
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I Data Formats

You can select a data format when saving scanned images. You should specify the most suitable data
format according to how you want to use the image on which application.
Available data formats vary by application and operating system (Windows or Mac OS).

See below for the characteristics of each image data format.

PNG (Standard File Extension: .png)
A data format often used on websites.

PNG is suitable for editing saved images.

JPEG (Standard File Extension: .jpg)
A data format often used on websites and for digital camera images.

JPEG features high compression rates. JPEG images slightly degrade every time they are saved, and
cannot be returned to their original state.

JPEG is not available for black and white images.

TIFF (Standard File Extension: .tif)
A data format featuring a relatively high compatibility between various computers and applications.
TIFF is suitable for editing saved images.

»» Note

+ Some TIFF files are incompatible.
* |J Scan Utility supports the following TIFF file formats.

— Uncompressed, black and white binary
— Uncompressed, RGB (8 bits per channel)
— Uncompressed, Grayscale

PDF (Standard File Extension: .pdf)
A data format for electronic documents, developed by Adobe Systems Incorporated.

It can be used on various computers and operating systems, and fonts can be embedded as well; therefore,
people in different environments can exchange the files without being aware of the differences.
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I Color Matching

"Color Matching" is the act of making adjustments so that the color tones match between the original item,
the monitor display, and the color printout. On your scanner or printer, the color tones are adjusted as
shown below.

Example: When sRGB is selected as the output profile (target):

Input Profile (Source)

Scanner ‘

ScanGear (Scanner Driver)

'

QOutput Profile (Target)

sRGB ‘
I
I I
0s/ Application/
Application Printer Driver
Monitor ‘ Printer

The image's color space is converted from the scanner's color space to sSRGB by ScanGear.

When displaying on a monitor, the image's color space is converted from sRGB to the monitor's color space
based on the operating system's monitor settings and the application's working space settings.

When printing, the image's color space is converted from sRGB to the printer's color space based on the
application's print settings and the printer driver's settings.
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I Setting Up Operation Panel with IJ Scan Utility (Windows)

IJ Scan Utility allows you to specify how to respond when scanning from the operation panel.

22 Important

» Depending on your model, you cannot scan from the operation panel.

1. Start [J Scan Utility.

2. Click = Settings...

The Settings dialog box appears.

3. Select a scan mode on the ¥ (Scanning from the Operation Panel) tab.

»» Note

* For the setting items in the Settings dialog box, see Settings (Scanning from the Operation Panel)
dialog box.

4. Set Scan Options.
5. Specify the file name and other settings in Save Settings.
6. Select the application you want to start after scanning in Application Settings.

7. Click OK.

The responses will be executed according to the specified settings when you start scanning from the
operation panel.
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I Printer Driver

» Windows Printer Driver

» macOS Printer Driver
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I Windows Printer Driver

» Overview of the Printer Driver
» Printer Driver Description

» Updating the Printer Driver
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I Overview of the Printer Driver

>

>

Canon IJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window
Updating Media Information in Printer Driver
Deleting the Undesired Print Job

Canon |J Status Monitor

Instructions for Use (Printer Driver)
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I Canon |J Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

I Installing the Printer Driver

To install the printer driver, install the driver from the Setup CD-ROM or our website.

I Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

I Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

I Related Topic

= How to Open the Printer Driver Setup Window
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I Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab

== Canon Printing Preferences x
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The Special Settings dialog box opens.
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3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.
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I Canon imagePROGRAF Preview

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

I Related Topic

= Displaying the Print Results before Printing
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I How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

I Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

I Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

32 Important

» Opening the printer driver setup window through Printer properties displays such tabs
regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.
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I Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.

When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Update media information

Click Update Media Information the Device Settings tab.

When a confirmation message appears, click Start.

If the paper information on the driver cannot be updated, click Initial Check Items and check the
displayed information.

The printer driver media information will update.

32 Important

+ It may take some time to update the media information.

4. Finish updating media information

When a confirmation message appears, click OK.
The media information will be updated.

32 Important

* Restart the printer driver after updating media information.
» Do not change media information on the printer while you are updating media information on
the driver.

2% Important

» Ensure that a user with administrative privileges carries out the media information update.
Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

* When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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I Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor

Click Status Monitor... on the Main tab.
The Canon |J Status Monitor appears.

3. Display the print jobs

Click Display Print Queue.
The print queue window opens.

4. Delete the print jobs

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

32 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.
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I Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

I Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon |J Status Monitor appears as a button on the task bar.

El -

Click the button of the status monitor displayed on the task bar. The Canon |J Status Monitor appears.
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»» Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click Status Monitor... on the Main tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

I When Errors Occur

If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor

displays an error information dialog box.
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In such cases, take the appropriate action as described.
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I Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Main tab, click Status Monitor....
The Canon IJ Status Monitor opens.

3. Display Estimated ink levels

Ink status is displayed as an illustration.
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»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.
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I Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

I Restrictions on the Printer Driver

Before installing, log on to Windows as user with administrator rights.
Always check the following before installing the software.
1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.
Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.

This may cause incorrect layout.

When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
Depending on the application software, lines drawn at almost horizontal angles may not print
correctly.

If that should happen, re-draw the line horizontally and print one more time.

Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.

In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties.

After the Properties dialog box has opened, immediately close it by clicking OK.

If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.

In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

Printing at high resolution requires a large amount of memory on your computer.

When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.

In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.

When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.

If you are you are using your printer with a USB connection, refrain from using standby mode. You
can set standby mode through the Power Options on the Control Panel.
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* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so
program finishes printing faster and place a check mark next to Start printing after last page is
spooled.
 Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of the application, and after opening from there the
property dialog box of the printer driver, follow the procedure below and then run printing.
1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.

* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.

In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
operation panel.

» Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

* If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.

In such cases, try printing after following the procedure indicated below.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase your computer memory.
o Increase the virtual memory of your operating system.

* Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use some of the features correctly, such as the Page
Layout feature in the Layout tab.
* In the cases described below, you will not be able to use the Edit Using PosterArtist feature of Page
Layout in the Layout tab, as well as the Canon imagePROGRAF Preview feature.
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline
o When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties
o When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties
o When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties
o When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:
o When printing after choosing Output to file in the Print dialog box in the application software
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* If you perform a point-and-print installation, you will not be able to use the Edit Using PosterArtist
features of Page Layout in the Layout tab.

* If you print after setting Edit Using PosterArtist, refrain from printing from other drivers.

« If you combine specific Print Quality with large paper sizes, you may not be able to correctly print
stamps and borders.

« In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may
look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

I Points to Note About Applications with Restrictions

« If, in Microsoft Excel, you place a checkmark next to the Collate and then you print more than one
copy, or if you do Entire workbook after configuring different settings in each tab, you may not be
able to perform layout printing nor to get the intended printing results.

* If you try to print data on a very large-size paper through applications like Adobe lllustrator, you may
not be able to print.

In such cases, try printing after following the procedure indicated below.
o Open the Main tab and uncheck Preview before printing.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase the virtual memory of your operating system.
o If you are using Adobe lllustrator, turn off/on Bitmap printing in the Print dialog box.

* When printing from application software that does not allow EMF spooling, you will not be able to use
the Edit Using PosterArtist feature of Page Layout in the Layout tab.

» When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.
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I Printer Driver Description

» Main Tab Description

» Page Setup Tab Description

» Layout Tab Description

» Favorites Tab Description

» Utility Tab Description

» Device Settings Tab Description

» Canon |J Status Monitor Description
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I Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview

The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

The printer illustration shows how to load paper to match the printer driver settings.

Check whether the printer is set up correctly by looking at the illustration before you start printing.
Media Type

Selects a type of printing paper.

Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...

Opens the Paper Information on Printer dialog box.

You can check the settings on the printer and apply the checked settings to the printer driver.
Specify...

Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu

Switches the Easy Settings and Advanced Settings.
Easy Settings

This mode allows you to print by using pre-registered print settings.
Print Target

Print settings that are generally used frequently are pre-registered as print purposes. By using

a print purpose to print, you can print by using settings that match the document.
Default Settings

Select this when printing general documents such as business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

22 Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Priority
Select elements to prioritize for print results.
Image
Prioritize image results when printing.

Line Drawing/Text
Prioritize detailed lines and text when printing.

Auto (Use Printer Settings)
Use printer settings when printing.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

410



3% Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.
Color
Prints with the number of colors in the document.

Monochrome
Select this setting to print a line drawing using black ink.

Monochrome Bitmap
Print all non-white parts in black.

Color Settings
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness,
and Contrast on the Color Adjustment tab, and select the Color Correction method on
the Matching tab.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be
before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

I Paper Detailed Settings dialog box

Drying Time
Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.
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Between Pages
The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so the page may be dropped into the basket with dried
ink.
Printer Default
Settings in printer unit operation panel are applied.

None
Page will be output immediately after printing

30 sec. /1 min./ 3 min.
Page will be output after set amount of time has passed after printing.

Between Scans

The wait time until printing the next scan can be set after printing one scan in the page. Set to
avoid smudging or unevenness in the page.
Printer Default

Settings in printer unit operation panel are applied.

None
Next scan will be print immediately after first scan is print.

0.5 sec./1 sec.

Next scan will be print after the set amount of time has passed after printing one scan.
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin

The margin length on the edge of the paper can be selected.
Top/Bottom Margins

Set how images are printed relative to the margin amount on the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Prioritize Image Size
This setting adds margins to the outside of the print data. Larger margins make the printed
material vertically longer, and more of the roll paper will be used.

Prioritize Paper Size
This setting adds margins to the inside of the print data. Larger margins increase the
unprinted area at the top and bottom of the printed material.

22 Important

* When using Prioritize Paper Size, the top and bottom of the image may be cut off
depending on the margin amount you set. It is recommended that you consider the
margins beforehand when creating the print data.

Leading Edge/Far End Margin
Set the margin length on each end of the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Auto
Automatically set the margin amount.
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Leading Edge 5 mm / Far End 5 mm / Leading Edge 15 mm / Far End 15 mm / Leading
Edge 30 mm / Far End 30 mm
Select a larger margin when rubbing of the print heads occurs, such as when heavily curling
paper is being used.

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.
Printer Default
Settings in printer unit operation panel are applied.

Fast
Select when cut is not smooth with Standard settings.

Standard
Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and it will
slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Mirror
Select whether to print reflected image or not. When you select this check box, text and images will
be printed as if reflected in a mirror.

I Custom dialog box

Set the quality level, and select the desired print quality.
Quality

You can use the slider bar to adjust the print quality level.

32 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

»» Note

» The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when
the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding quality is selected for Print Quality on the Main tab.

I View Settings dialog box

Print Target
Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.
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Details
Displays the settings of the print purpose that was selected for Print Target.

I Color Settings dialog box

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

32 Important

* When Monochrome is selected for Color Mode, the color balance (Cyan, Magenta, and
Yellow) can't be set.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black.
However, the brightness of the colors between white and black can be changed. Colors become
brighter as you drag the slider toward the right and darker as you drag the slider toward the left.
You can also directly enter brightness values that are linked to the slider bar. Enter a value in the
range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

I Matching Tab

This is displayed when Color is selected for Color Mode.
Allows you to select the method for adjusting colors to match the type of document to be printed.
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Color Correction
Allows you to select Driver Matching, ICC Profile Matching, ICM, or Off to match the purpose of the
print operation.
Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or scanner
ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing using a profile creation tool or
color chart.

3» Important

* When setting not to use ICM in the application software, ICC Profile Matching and ICM of
Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile

Specifies the printer profile to be used when ICC Profile Matching is selected for Color Correction.
Normally Auto Settings is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICC Profile Matching,
or ICM, for Color Correction.
Perceptual (Photo) / Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD) / Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors
suitable for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric

This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
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Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.

22 Important

» Depending on the media type, you may obtain the same print results even when you change the
Rendering Intent setting.
+ If Driver Matching is selected for Color Correction, then Relative Colorimetric and Absolute

Colorimetric are not displayed.
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Page Setup Tab Description

The Page Setup tab allows you to specify the scaling for enlarging or reducing, set the paper feeding
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Settings Preview

The paper illustration shows how the original will be laid out on a sheet of paper.

You can check an overall image of the layout.

The printer illustration shows how to load paper to match the printer driver settings.

Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size

Selects a page size.

Ensure that you select the same page size as you selected within the application.

When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Enlarged/Reduced Printing

You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Fit Roll Paper Width,
or Scaling.
Fit Paper Size
Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.

When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Scaling
Enlarge or reduce the document to a specified scale before printing.

417



Printer Paper Size
When you select Fit Paper Size, or Scaling, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.

Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper
Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

3» Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Paper Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.

Roll Paper Options...
Displays the Roll Paper Options dialog box.
You can specify banner printing, and other settings for printing on roll paper.

Size Options...
Displays the Paper Size Options dialog box.
The Paper Size Options dialog box allows you to create and register any user-defined paper.

I Custom Size Settings dialog box (Paper Size)

This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the

units specified in Units.
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Units
Select the unit for entering a user-defined paper size.

I Roll Paper Options dialog box

You can specify settings for printing on roll paper.

Banner Printing
Select this check box to print documents with several pages as one continuous document. When you
do this, the spaces between the pages will be removed.

I Paper Size Options dialog box

You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

»» Note

» Paper deletion is not possible in the following case:
— When a standard paper size of the printer driver is selected
— When an oversized paper size is selected
— When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.

Page Size
You can specify the Width and Height settings of the paper.
Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width

Specify the paper width.
Height

Specify the paper height.

Register with the OS
Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined
paper.
Add
You can register a user-defined paper that was set and overwrite the existing user-defined paper.
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Display Series
You can narrow down the paper sizes to be displayed in Paper Size List.
Oversize

When you select this check box, add appropriate margins so that the document contents will not get
cut off, and then print the document.
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I Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.
Poster (1 x 2)/Poster (2 x 2)
Printing is performed with poster settings.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number
of divisions increases, the number of sheets used for printing increases. If you are pasting pages
together to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...
Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages.

2 Pages/Sheet / 4 Pages/Sheet /| 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number
of pages assigned to one sheet.

Set...
Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Edit Using PosterArtist
Word processing and spreadsheet software documents and web browser screens, etc. can be
edited a print from PosterArtist.
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You must install PosterArtist to use this function. Go to the Canon website, download PosterArtist,
and then install it.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...
Opens the Define Stamp dialog box.

You can specify detailed stamp settings or register any stamp.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check the check box when you are printing two or more copies, and want to print them in groups.
Uncheck the check box when you want to print them as a group on the same page.

Page Options...
Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.
32 Important

» Depending on your usage environment, you may not be able to use the Page Options function. In
this case, set Spooling at Printer Driver in the Special Settings dialog box to Yes.

Special Settings...
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

I Pages to Print dialog box

When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.
Invert

Switches the pages to be displayed or hidden.
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»» Note

» The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected
for Page Layout.

I Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Select something other than None from the list to print the page border line.

»» Note

» The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6
Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

I Define Stamp dialog box

The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Stamps
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name
Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.
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Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps, and click this button.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center
Moves the stamp to the center of the paper.

Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

I Page Options dialog box

Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

»» Note

« It will be displayed if you select Yes in Spooling at Printer Driver in the Special Settings dialog
box.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box

Set the format to be used when printing the contents set in the Page Options dialog box.
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Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

I Special Settings dialog box

The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summary
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
Spooling at Printer Driver
Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting No (Use RAW Spooling) or Yes may improve the print results or the printing speed.
Also, depending on the setting, you may not be able to use some of the driver functions.
FineZoom Settings
Use this function to print on long paper.
Yes
The print problem may be corrected.
Select this in usual cases.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print results
you want by setting this function to off.
This is only displayed when using a 32-bit driver.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver, the
printing results may include an unexpected tint. You can resolve the problem in this case by
setting Disable the color profile setting of the application software to On.
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3» Important

» Even if this is set to On, it will only disable some of the color profile information, and it is still
possible to print using the color profile.
This should normally be set to Off when using.

Adjust Faint Lines
This function prevents thin lines from fading when printing by darkening light colored lines.

Specify Pattern Resolution
This function is for switching the rendering resolution for drawings using the hatch brush or
pattern brush.

Cleaner Lines/Text
Set to Off if the thickness and density of lines and text are not printed uniformly.

426



I Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.
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Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Settings Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites
list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file (.cfg).
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Export...
You can save the settings of a favorite to a file (.cfg).

| Edit dialog box

You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

| Add dialog box

You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
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| utility Tab Description

The Utility tab allows you to perform printer maintenance or check the settings of the printer.
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Print Nozzle Check Pattern

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source

Displayed using the Media Type, Page Size and Roll Paper Width for each currently set paper

feed position.

»

Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.
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About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Settings Summaries...
The Settings Summaries dialog box is displayed.
You can confirm the list of items set in the printer driver.
If you click the tab of each sheet, you can confirm the setting details of each item.

I Related Topics

= Cleaning the Print Heads
= Printing a Nozzle Check Pattern
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I Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.

The Device Settings tab allows you to specify settings related to the printer unit, as well as administrator
settings.
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Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer
driver.

Preferences...
Configure administrator settings for the printer driver.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

I Preferences dialog box

Use System Language
Set this to On to change the display language of the printer driver according to the OS language
settings.
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I Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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I Canon |J Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

I Canon |J Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.

You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.

! : A warning is being displayed.
@ : An operation error has occurred.
0 : You are being informed of remaining ink levels, etc.

0 : There has been an error which requires a service.
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Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click \» (the disclosure triangle) to display a pictorial representation of the estimated ink level in the
ink tank.
Ink Model Number

You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the cartridge is
full.

Click '» (the disclosure triangle) to display a pictorial representation of the estimated usage amount
in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder.

Click \.» (the disclosure triangle) to check the remaining amount of paper.
Purchase information is displayed in Purchase Paper....

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon 1J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the other
windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon IJ status
monitor starts automatically and appears in front of all other windows.

433



Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically and be
displayed in front of other windows.

Start when Windows is Started
Starts the Canon |J Status Monitor automatically when you start Windows.

Remote Ul menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

»» Note

* When the printer is being used via USB connection Remote Ul will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and disable
warning displays.
Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and you
can check the version and copyright information.
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I Updating the Printer Driver

» Obtaining the Latest Printer Driver
» Deleting the Unnecessary Printer Driver
» Before Installing the Printer Driver

» Installing the Printer Driver
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I Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Utility tab.

You can access our website and download the latest printer driver for your model.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= Before Installing the Printer Driver
= |nstalling the Printer Driver
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I Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

Select the Control Panel -> Programs -> Uninstall a program (Programs and Features).
From the program list, select "XXX Driver" (where "XXX" is your model name) and then click Uninstall.

The confirmation window for uninstalling the model appears.

2% Important

+ A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Start. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.

437



I Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

I Checking the Printer Status

* Turn on the printer.

I Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

I Related Topics

= Obtaining the Latest Printer Driver
= |nstalling the Printer Driver
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I Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:
1. Turn on the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

2» Important

* A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation
Click Exit.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= QObtaining the Latest Printer Driver
= Deleting the Unnecessary Printer Driver
= Before Installing the Printer Driver
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I Application Software

>

>

PosterArtist on the Web
PosterArtist Guide (Windows)
Direct Print Plus Guide

Preview Guide (Windows)

Preview Guide (macOS)

Free Layout plus Guide (Windows)
Free Layout Guide (macOS)

Quick Utility Toolbox Guide

Wi-Fi Connection Assistant Guide

Media Configuration Tool Guide
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I Handling Paper

» Loading Rolls in the Printer
& Moving the Roll Holder Support

» Removing the Roll from the Printer

¥

Loading Sheets in the Printer
» Paper Settings

« Changing the Type of Paper

Specifying the Ink Drying Time

Specifying the Cutting Method for Rolls

Making Margin Settings for Rolls

Cutting the Leading Edge of Roll Paper Automatically
@ Reducing Dust from Cutting Rolls
» Remove Jammed Roll Paper
» Remove a Jammed Sheet
» Information about Paper
« Paper Sizes
« Paper Information List
@« Updating paper information
a Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a
Media Type

» Managing Paper Information on Printer Using Media Configuration Tool
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I Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

/% Caution

+ Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and
dropping a roll may cause injury.

32 Important

» Before loading a roll, make sure that the inside of the printer and the output guide are clean. If these
areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Printer

* When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

+ Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality.

»» Note

* For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".
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1. Select paper settings display area on the Home Screen.

H Plain Paper

B There is no paper,

j. Replace P Set cut
i+ paper *1 length

T @ & O

2. Select the roll paper area.

Paper information

@ Plain Paper
49ft. A3 Roll

1) There is no paper.

3. Select Load roll paper or Replace paper.

2% Important

« If paper that will not be used is fed, a message confirming paper replacement is displayed. Follow
the instructions on the screen, and then go to the next step.

= Removing the Roll from the Printer

* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not
open the cover before these instructions are displayed.

4. When a message confirming the change of roll paper width is displayed, confirm the
contents and select OK.

5. Open the cut sheet feed cover.

6. Unlock with the lever and open the roll paper feed cover.
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7. Load rolls on the roll holder.

1. Make sure that the lock levers on the left and right roll holders are toward d-\ and unlocked.

2. Align the roll paper winding direction as shown in the figure, insert the roll holder marked with [R]
from the right, and press it firmly until the side of the roll paper (A) sits flush against the roll holder
without any gap.

Insert the roll holder marked with [R] so that it is on the right side.

/I Caution

* Do not touch the metal part inside the roll holder when setting the roll holder. The sharp
edges of the metal may cause injury.
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32 Important

* When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage
the roll holder.

3. Turn the lock lever (B) of the inserted roll holder toward ﬁ to lock it.
B

4. Insert the roll holder marked with [L] from the left and press it firmly until the side of the paper roll
(C) sits flush against the roll holder with no gap.
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8. If necessary, move the roll holder support to match the width of the roll paper to be loaded.

= Moving the Roll Holder Support

9. Before setting the roll holder, make sure that the roll holder support is firmly fixed.

Depending on your printer, there may be one or two knurled screws.
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2% Important
» Make sure that the knurled screws on the roll holder support are tightened until they do not turn.

10. Hold the left and right roll holders (E) and place the roll paper on the slide guide (H) so that
the roll holder shafts (F) are in front of the roll holder slots (G).
Place the paper roll so that the roll holder marked with [R] is on the right side and the roll holder marked
with [L] is on the left side.
G

2% Important

* Do not allow roll paper or other materials to come in strong contact with the feed cover rollers
located inside the roll paper feed cover. Doing so may result in problems with paper feeding.
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11. Set the shafts (F) of the left and right roll holders in the roll holder slots (G) by sliding them
on the slide guides (H).

G

A\ Caution

» Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

* Do not release the roll holder until the holder is loaded in the roll holder slot.

 Be careful not to pinch your fingers between the roll holder shafts (F) and the roll holder slots (G)
when loading rolls.

2% Important

« |If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

Load the roll paper so that it is not loaded in the opposite direction.
« If the roll paper has become unwound, remove the slack before loading the roll paper.

« If the paper is wrinkled or warped, straighten it out before loading it.

Load the roll so that there is no gap between the sides of the roll and the roll holder.
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I
-

12. Insert the leading edge of the roll into the feed slot (I) and feed it until you hear a sound.

2 Important

« If the leading edge of the paper is stuck to the roll and difficult to insert into the feed slot, pull out
the roll slightly before inserting the edge into the feed slot.

» Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

13. Close the roll paper feed cover completely.

a8 ' B

14. Select OK.
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15. Select the type of paper to use.

After selecting the paper type, paper feeding starts.

Select the media type.

Plain Paper
PremPlainPpr 80
Plain ShortGrain

Coated Paper
3% Important

* Do not open the roll paper feed cover after the paper feeding has started. It may cause paper
feeding to fail.

 Cut the edge of the roll using the Set cut length function if the edge is creased or soiled.

= Set cut length (feeds and cuts paper rolls by a specified length)

* Depending on the type of paper, the paper width may not be detected automatically. Follow the
instructions on the screen to manually select the paper size.

»» Note
 For details on media types that you can select, see "Paper Information List."

* When selecting Enable in Keep roll paper type, there is no need to specify the type of the paper.
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I Moving the Roll Holder Support

To load roll paper of different widths, move the roll holder support as described below.

1. Loosen the knurled screws (A) securing the roll holder support by turning them
counterclockwise.

Depending on your printer, there may be one or two knurled screws.

3% Important

» There are holes for the knurling screws at the positions of each support roll paper size. Move the
holder to the required position and make sure that the screws are aligned with the holes.

3. Turn the knurled screws (A) clockwise to secure the roll holder support to the printer.
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3% Important

* Tighten knurled screws finger-tight until they stop turning. Do not use a screwdriver or similar tool
to tighten the screws too tightly.

> Note
 After moving the roll holder support, continue loading the roll paper.

= [ oading Rolls in the Printer
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I Removing the Roll from the Printer

Remove rolls from the printer as follows.
1. Select paper settings display area on the Home Screen.

Plain Paper

B There is no paper,

j. Replace Set cut
* paper length

T @ & 0

2. Select the roll paper area.

Paper information

© Plain Paper
49ft. A3 Roll

1) There is no paper.

3. Select Remove paper.

4. Select Yes.

The roll is rewound.

2» Important
* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not

open the cover before these instructions are displayed.

5. Open the cut sheet feed cover.
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6. Unlock with the lever and open the roll paper feed cover.

8. Hold the left and right roll holders (A) and remove the roll paper from the printer.
A

9. Remove the roll from the roll holder.

1. Turn the lock lever (B) on the left roll holder toward d-\ to unlock.
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2. Remove the unlocked roll holder from the roll paper.

/1 Caution

» Do not touch the metal part inside the roll holder when removing the roll holder. The sharp
edges of the metal may cause injury.
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3. Turn the lock lever (C) on the right roll holder toward d\ to unlock.

4. Remove the unlocked roll holder from the roll paper.

32 Important

« Store the roll in the original bag or box, away from high temperature, humidity, and direct
sunlight. If paper is not stored properly, the printing surface may become scratched, which
may affect the printing quality when you use it again.

10. Close the roll paper feed cover completely.
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12> Note

* To load new roll paper in the printer at this point, see "Loading Rolls in the Printer."
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I Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

22 Important

* Do not load any sheet smaller than A4 size. Doing so may cause a paper jam.

»» Note

* For the page size and paper weight you can use for this printer, see Paper Sizes or Paper Information
List.

1. Prepare sheets.

Align the edges of paper. If paper is curled, flatten it.

2% Important

« Align the edges of paper neatly before loading. Loading paper without aligning the edges may
cause paper jams.

« |If paper is curled, hold the curled corners and gently bend them in the opposite direction until the
paper becomes completely flat.

2. Open the cut sheet feed cover.

3. Open the top feed and then pull it upwards.
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5. Load the sheets in portrait orientation with the print side facing up.

After loading the paper, the paper setting confirmation screen for the top feed appears on the touch
screen.
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6. Slide the left and right paper guides to align with both sides of the sheets.

T N

3% Important

» Do not slide the paper guides too hard against the paper. The paper may not be fed properly.

» Always load sheets in portrait orientation. Loading paper in landscape orientation can cause paper
jams.

» Do not load sheets of paper higher than the load limit mark (B).
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7. If the page size and type displayed on the touch screen match size and type of the sheets
loaded in the top feed, select Yes.

If not, select Change to change the settings in accordance with the size and type of the loaded paper.

Current top feed setting.
Please confirm.

Ad
Plain Paper

Change [ | Yes

32 Important

» There are many types of paper available, each best suited to a particular printing use. Each media
type has specific preset settings (how ink is used and sprayed, distance from nozzles, etc.), that
allow you to print to that type with optimal image quality. The wrong paper settings may cause
poor printout color quality or scratches on the printed surface.

» For details on media types that you can select, see "Paper Information List".
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I Paper Settings

» Changing the Type of Paper
» Specifying the Ink Drying Time
» Specifying the Cutting Method for Rolls

» Making Margin Settings for Rolls

¥

Cutting the Leading Edge of Roll Paper Automatically

» Reducing Dust from Cutting Rolls
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I Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

»>» Note

* If you want to continue using the same type of roll paper, set Keep roll paper type to Enable. The

previously selected paper type is automatically selected, saving you the trouble of selecting the paper
type when loading the roll paper.

= Keep roll paper type

22 Important

» For best printing results, the printer fine-tunes the print head height and the feed amount for each type
of paper. Be sure to select the type of paper to use correctly before printing.

» Because the printer fine-tunes the paper feed rate and print head height, the margins and the size of

printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the image quality.

= Adjustments for Better Print Quality

I Changing the Type of Paper

1. Select paper settings display area on the Home Screen.

E Plain Paper

B There is no paper,

D Replace D Set cut
=+ paper 19 length

T @ | & O

2. Select the roll paper area or sheet area.

Paper information

© Flain Paper
49ft. A3 Roll

D There is no paper.

3. Select Paper settings.
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4. Select Type.

5. Select media type of roll paper loaded in printer.

Select the media type.

Plain Paper
PremPlainPpr 80
Plain ShortGrain

Coated Paper

32 Important

» Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.

> Note

 For details on media types, see "Paper Information List."

6. Select Register.
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I Specifying the Ink Drying Time

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

22 Important

* Printer settings are applied when the ink drying time is not set in the printer driver. If the ink drying time
is set in the printer driver, that setting has priority.

»>» Note

« If the cutter touches the print surface on which the ink is not dry, the paper surface may become
scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without dropping the printed documents into the basket immediately after
printing, set Cutting mode to Eject cut.

= Specifying the Cutting Method for Rolls

I Set on the Printer

1. Select Q (Setup) on the HOME screen.

o
=i

2. Select Printer settings.

3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper
PremPlainPpr 80
Plain ShortGrain

Coated Paper

6. Select Pause between scans or Pause between pages.
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Advanced paper settings
Roll paper tension {printing)

Roll paper tension {feeding)

Pause between scans

Pause between pages

Pause between scans
Specify the waiting time between printing one scan and printing the next one. You can set the
drying waiting time and the target area where the waiting time occurs.

Pause between pages
Specify the waiting time between printing one page and ejecting the paper. If there is a next page,
it will be printed after the ink drying time has passed.

I Set on your Computer

Refer to the followings for how to set from your computer.

= Main Tab Description (Windows)

= Advanced Paper Settings (macOS)
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I Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

* Automatic cut
The roll is automatically cut by the cutter blade.
o Printer Setting

Cutting mode > Automatic cut

» Eject cut (when the paper surface is being scratched / to wait for ink to dry)

Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the
paper drops and may rub against the basket, resulting in damage to the print surface, but you can cut
using this method and supporting the paper so that it does not drop to avoid damage to the paper. Also,
you can prevent paper that has not dried from dropping by visually checking the ink has dried, and then
cutting the paper.

After printing is finished, select Cut paper to cut the roll.
o Printer Setting

Cutting mode > Eject cut

» Set cut length (feeds and cuts paper rolls by a specified length)

The roll paper is fed by the amount specified from the operational panel. The roll paper is always cut
after being fed.

Use this function when you want to cut the leading edge of the paper after the roll paper is loaded.

»>» Note

» For some paper types, the default Cutting mode may be set to something other Automatic cut. For
this paper, we recommend keeping the preset cutting mode.

* If documents printed using Automatic cut or Eject cut are short, rolls are advanced a specific amount
before cutting to prevent problems with cutting and paper ejection. This may create a wider bottom
margin, in some cases.

Eject cut (when the paper surface is being scratched / to wait for ink to
dry)
32 Important

» When cutting wide printed documents after Eject cut, have two people support the documents. If the
paper drops, printed documents may be damaged.

» Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

« After printing is completed, Eject cut is possible after the set ink drying time has passed. If 5 minutes
have passed without Eject cut, the printed document will be cut automatically to protect the printer
mechanism.
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> Note

» With Eject cut, printing does not resume after a series of jobs have been printed continuously until

the roll is cut.

1. Select Eject cut in Cutting mode.

1. Select Q (Setup) on the HOME screen.

2. Select

o -
=i ®

Printer settings.

3. Select Paper-related settings.

4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80

Plain ShortGrain

Coated Paper

6. Select Cutting mode.

7. Select Eject cut.

2. Print the job.

When printing is finished, the printer will stop without cutting.

3. While holding the printed document from the bottom edge to prevent it from dropping,
select Cut paper to cut the roll paper.

I Set cut length (feeds and cuts paper rolls by a specified length)

1. Select paper settings display area on the Home Screen.
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E Plain Paper

B There is no paper.

j. Replace P Set cut
™ paper +7¥ |ength

T @ | & 0
2. Select the roll paper area.
3. Select Set cut length.

4. Select the input field and enter the length by which you want to feed the roll paper.

Set cut length

inch

[ 11.9

(4.0-39.4)

Cut paper

5. Select Cut paper.

6. Select Yes.

The roll paper is cut after the specified length is fed.
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I Making Margin Settings for Rolls

Make settings related to margins when printing on roll paper. Setting a large margin may improve the image
quality of the printed document.

32 Important

* In the printer driver, you can set the margins from Roll Paper Safety Margin in the Paper Detailed
Settings dialog box on the Main sheet. If you set from the printer driver, the setting from the printer
driver takes priority.

= Main Tab Description (Windows)

I Set the Margin Area of the Roll Paper

When printing on roll paper, set the size of margins to add to the top and bottom of the print data.

* Prioritize image size

This setting adds margins to the outside of the print data. Larger margins make the printout longer in
the vertical direction and use more paper.

5 mm 30 mm

* Prioritize paper size

This setting adds margins to the inside of the print data. Larger margins may cause part of the print
data not to be printed.

5 mm 15 mm 30 mm
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3% Important

* When using Prioritize paper size, Roll paper lead edge/end margin may result in part of the image
being lost. Prepare your print data to match the printable area.

. Select Q (Setup) on the HOME screen.

-_—

o

. Select . Printer settings.

N

w

. Select Paper-related settings.

N

. Select Advanced paper settings.

a

. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper
PremPlainPpr 80
Plain ShortGrain

Coated Paper

6. Select Roll paper top/bottom margins.

7. Select Prioritize image size or Prioritize paper size.

I Set the Margins for the Leading Edge and Far End of the Roll Paper

When printing on roll paper, set the length of the vertical margin in the printing direction. When Auto is
selected, the margin amount is set according to the paper type and other factors.

32 Important

* Reducing the amount of space may result in the paper becoming dirty.

1. Select Q (Setup) on the HOME screen.

o

2. Select . Printer settings.

3. Select Paper-related settings.
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4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper
PremPlainPpr 80
Plain ShortGrain

Coated Paper

o

6. Select Roll paper lead edge/end margin.

7. Select the margin length you want to set or Auto.
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I Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the operation panel menu.

* Auto

If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

* On(Preset Length)

The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

* On(Input Length)

The amount to cut from the leading edge of paper is specified in the operation panel. The amount to
cut from the leading edge can be specified in the range of lengths displayed in the operation panel. The
range of lengths differs according to the media type.

»» Note

» The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in
the operation panel.

+ Off

The edge is not cut and scraps are not removed.

1. Select Q (Setup) on the HOME screen.

o
- -

2. Select Printer settings.

3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.
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Select the media type.

Plain Paper

PremPlainPpr 80

Plain ShortGrain

Coated Paper

6. Select Trim edge first.

7. Select desired Trim edge first settings.

This setting takes effect the next time you load a roll.
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I Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the operation panel menu, which will coat the leading and trailing edges

of the printed document with ink. As a result, you can reduce problems with the print head. You can set
Cut-dust reduction according to the media type.

=

v Vv
i

it
I AnIvC

A: The ink is coated.

B: Cut Position
3% Important

* Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight
paper. If not cut properly, the paper may jam.

1. Select Q (Setup) on the HOME screen.

o

2. Select =0 Printer settings.

3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper J

PremPlainPpr 80

Plain ShortGrain

Coated Paper

6. Select Cut-dust reduction.
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7. Select ON.
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I Information about Paper

» Paper Sizes

» Paper Information List

» Updating paper information

» Using Paper Other Than Genuine Paper and feed confirmed Paper

@ Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

& Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding
a Media Type
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I Paper Sizes

| Rolis

Rolls that meet the following conditions are supported.
 Outer diameter: within 4.4 in. (110 mm)
* Inner diameter of paper core: 2 inches

* Printing side out

Roll Paper Width 24 in Roll : 24.00 in. (609.6 mm)
A1 Roll : 23.39 in. (594.0 mm)
B2 Roll : 20.28 in. (515.0 mm)
18 in Roll : 18.00 in. (457.2 mm)
17 in Roll : 17.00 in. (431.8 mm)
A2 Roll : 16.54 in. (420.0 mm)
B3 Roll : 14.33 in. (364.0 mm)
A3 Roll : 11.69 in. (297.0 mm)

Minimum Paper Length 8.00 in. (203.2 mm)
Maximum Printable Length 13 feet (4 m)
Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)
I Sheets
Sheets of the following sizes are supported.
Sheet Width 8.27 in. (210.0 mm) to 11.69 in. (297.0 mm)
Minimum Paper Length 8.00 in. (203.2 mm)
Maximum Printable Length 17.01 in. (432.0 mm)
Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)
»>» Note

 For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or
"Setting Paper Dimensions (Custom Size)" (macOS).
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I Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

= Media Configuration Tool Guide

22 Important

* If you are using the Media Configuration Tool, the new Media Information File is downloaded
automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.

» Even if you are not using the printer driver, you should install the Media Configuration Tool in order to
register the media types for your region in the printer.
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Using Paper Other Than Genuine Paper and feed confirmed
Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

» Paper where the size is described in "Paper Sizes"

» Paper where bleeding and ink overflow does not occur when printing

» Paper that does not warp severely when loading the paper or printing

»» Note

* For Canon genuine paper/feed confirmed paper, see "Paper Information List."

22 Important

* If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely
no guarantees regarding print quality or paper feed properties.

After loading the paper in the printer, select the media type in the operation panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

I Printing Using Existing Settings
You can print easily by selecting from existing settings provided in the operation panel and printer driver.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

| Printing Using Additional Settings

You can use the function to add custom paper in the Media Configuration Tool to create settings suitable
for paper other than genuine paper/output confirmation paper you are using. You can add the created
settings to the printer operation panel and printer driver as a new paper type for printing.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the operation panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

3% Important

+ The Canon genuine paper settings provided in the operation panel and printer driver are optimized for
Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

2> Note
» For the available paper types, see "Paper Information List."

» For instructions on selecting the media type with the operation panel, see "Changing the Type of
Paper". For instructions on selecting the media type with the printer driver, see "Main Tab Description"
(Windows) or "Quality & Media" (macOS).

I Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

»>» Note

* If you cannot obtain the desired results by selecting the general-purpose paper settings, use the
custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

= Media Configuration Tool Guide

22 Important
* For details on how to select the added media type in the operation panel, see "Changing the Type of
Paper."

* You can select the media type to be used in printing from Media Type in the Main sheet (Windows) or
Quality & Media (macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or
"Quality & Media" (macOS).

* We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool. See "Adding Custom Paper" in Media Configuration Tool Guide.
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I Changing Printer's Setting

» Changing Settings from Operation Panel

Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Checking the Total Number of Uses of Printer

» Changing Printer's Setting Using Web Browser

Start up Remote Ul

Changeable Setting Items Using Remote Ul

Setting Passwords Using Remote Ul

Registering Printer's Root Certificate to Web Browser for SSL Communication
Registering Printer's Root Certificate to Local Computer for SSL Communication
Generating Server Certificate

Setting Mail Server

Specifying Mail Setting for Sending Scanned Data

Receiving Printer Status by E-mail
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I Changing Settings from Operation Panel

» Home Screen Menu Composition

» Menu Structure

» Setting Items on Operation Panel

» Setting Administrator Password on Operation Panel

» Checking the Total Number of Uses of Printer
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I Home Screen Menu Composition

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations,
settings, and other menus.

= Basic Touch Screen Operations

TC-20M
Plain Paper
— A
B There is no paper.
% Copy Others —B
= @lb | T | tl'
C D E F
TC-20
"_;' Plain Paper
— A
E There is no paper.
D Replace Set cut
LS paper 78 length 2
SR
C D E F

A: Paper Setting Display Area
Displays information on loaded paper. Selecting this option displays the menu for making paper
settings.

B: Basic Menu
e For TC-20M

Selects this option when copying or scanning using the printer's operation panel.
* For TC-20
The frequently used Load paper / Replace paper and Set cut length are displayed here.
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C: Network
Display